Copyright
This material may not include some last-minute technical changes and/or revisions to the software. Changes are periodically made to the information provided here. Future versions of this material will incorporate these changes.

Nuance Communications, Inc. has patents or pending patent applications covering the subject matter contained in this document. The furnishing of this document does not give you any license to such patents. This software is protected under the following patents, among others: 5,202,952; 5,526,463; 5,231,670; 5,388,183; 5,428,707; 5,680,511; 5,715,367; 5,754,972; 5,765,132; 5,794,189; 5,799,279; 5,818,423; 5,822,730; 5,850,627; 5,890,181; 5,915,236; 5,920,836; 5,949,886; 5,960,394; 5,970,448; 5,970,460; 5,983,179; 6,029,124; 6,064,959; 6,073,097; 6,088,671; 6,092,043; 6,092,044; 6,101,468; 6,125,342; 6,125,347; 6,138,098; 6,151,575; 6,163,768; 6,167,377; 6,212,498; 6,260,013; 6,292,779; 6,349,282; 6,360,237; 6,393,399; 6,424,943; 6,456,972; 6,490,555; 6,535,849; 6,601,027; 6,912,498; 7,315,818.

No part of this manual or software may be reproduced in any form or by any means, including, without limitation, electronic or mechanical, such as photocopying or recording, or by any information storage and retrieval systems, without the express written consent of Nuance Communications, Inc. Specifications are subject to change without notice.

Copyright © 2008-2009 Nuance Communications, Inc. All rights reserved.

Disclaimer
Nuance makes no warranty, express or implied, with respect to the quality, reliability, currentness, accuracy, or freedom from error of this document or the product or products referred to herein and specifically disclaims any implied warranties, including, without limitation, any implied warranty of merchantability, fitness for any particular purpose, or non-infringement. Nuance disclaims all liability for any direct, indirect, incidental, consequential, special, or exemplary damages resulting from the use of the information in this document. Mention of any product not manufactured by Nuance does not constitute an endorsement by Nuance of that product.

Notice
Nuance Communications, Inc. is strongly committed to creating high quality voice and data management products that, when used in conjunction with your own company’s security policies and practices, deliver an efficient and secure means of managing confidential information.

Nuance believes that data security is best maintained by limiting access to various types of information to authorized users only. Although no software product can completely guarantee against security failure, the Enterprise Express software contains configurable password features that, when used properly, provide a high degree of protection.

Legal Notice Italic. We strongly urge current owners of Nuance products that include optional system password features to verify that these features are enabled! You can call our support line if you need assistance in setting up passwords correctly or in verifying your existing security settings.

Publication Line. Published by Nuance Communications, Inc.
Burlington, Massachusetts, USA

Overview of the Installation and Administration Guide for Dragon® Medical, Version 10.1 ........................................ 1

Chapter 1: Installing Dragon® Medical ............................. 3
Installing, Modifying, and Upgrading Dragon Medical ............... 4
Preparing for an Installation or Upgrade ............................ 5
Installation restrictions .................................................. 5
File Structure ............................................................ 5
Installation checklists ................................................... 6
Recommended System Requirements ................................. 8
Storage space required for user files ................................. 9
Installing on or Upgrading to Windows Vista ........................ 10
Coexistence with other Dragon products ............................ 10
Installing Dragon on a Single Machine ......................... 11
Installing Dragon on a single machine ........................... 11
Activating Dragon ...................................................... 13
Sample custom installation of Dragon Medical .................... 14
Post Installation Tasks .................................................. 30
Cleaning up after uninstalling Dragon .............................. 30
Version 10 File Structure .............................................. 31
Turning off Dragon’s use of Microsoft Active Accessibility Service .... 33
Choosing Medical Vocabulary to Support Your Specialty ........... 34
Enhancing the privacy of patient data ............................... 39

Chapter 2: Upgrading Dragon® Medical .......................... 41
Upgrading Dragon Medical ........................................... 42
What you should know before upgrading from a previous version .. 42
Installing on or Upgrading to Windows Vista ...................... 43
Upgrading multiple users .............................................. 43
Upgrading roaming user files: Overview ........................... 45
Upgrading multiple users .............................................. 53
Upgrading Users with Vocabularies Created by Third Parties ....... 56
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer ............................................. 59

Overview of Installing Dragon Using the Windows Installer (MSI) .......................... 60
Before You Begin ........................................................................................................... 60
Finding the MSI Installer on the DVD .............................................................. 61
Entering Command Lines ......................................................................................... 61
Windows Vista Notes ............................................................................................... 61
Overview of the Network Installation of Dragon from a Server .................. 62
Modifying Roaming User, Miscellaneous, Schedule Settings in the INI File . 63
Carrying Out an Administrative Installation with .bat File ............................. 71
Installation using the Dragon command line ..................................................... 87
Upgrading Your Dragon Installation from the Command Line .................. 97
Step-by-Step Command Line Installation with msiexec.exe ....................... 105
MSI Options Specific to Dragon ........................................................................... 113
MSI Options for Installing Dragon Features/Advanced Options ............... 115
MSI Options for Roaming User, Tuning, and Data Collection Setup ........... 118
Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties .................................................. 121
Installing Visual C++ Runtime for Dragon ....................................................... 125

Chapter 4: Setting Up and Dictating with Roaming Users ............. 127

Setting Up and Dictating with Roaming Users ............................................. 128
Overview of the Roaming User feature .............................................................. 129
Setting up the Roaming User feature ................................................................. 133
Enabling the Roaming User on each machine where a user will dictate ... 142
Creating a Roaming User on the local machine ............................................. 160
Dictating with a Roaming User ......................................................................... 161

Chapter 5: Using Dragon® in a Citrix Presentation Server Environment ........................................... 165

Using Dragon in a Citrix Presentation Server Environment ....................... 166
Sizing and performance information .............................................................. 166
Installing and publishing Dragon on the Citrix server .................................. 171
Creating Policies for Dragon on the Citrix server ......................................... 173
Making Published Applications Work together ........................................... 175
Setting Up the Program Neighborhood on Citrix clients ......................... 176
Running Dragon on a Winterm device ............................................................ 179
Disabling or redirecting Citrix Logging ............................................................ 180
Chapter 6: Customizing Vocabularies with the Dragon® Vocabulary Tool ............................................ 181
  Customizing Vocabularies with the Vocabulary Tool .......................................................... 182
    Starting Voctool ........................................................................................................... 182
    Overview: The Vocabulary Tool .................................................................................. 183
    The Vocabulary Tool: Choosing Documents ............................................................. 184
    The Vocabulary Tool: Choosing Word Lists .............................................................. 185
    The Vocabulary Tool: Analyzing Settings .................................................................. 186
    The Vocabulary Tool: Analyzing Files ...................................................................... 187
    The Vocabulary Tool: Previewing New Words .......................................................... 188
    The Vocabulary Tool: Training Added Words ........................................................... 189
    The Vocabulary Tool: Language Model Build Settings ........................................... 190
    The Vocabulary Tool: Summary Page ....................................................................... 191
  Voctool command line switches ..................................................................................... 192
  Voctool command line examples .................................................................................... 194

Chapter 7: Adding Words, Commands, and Vocabularies to User Files .................................................. 199
  Adding Words, Commands, or Vocabularies ................................................................ 200
    Using the Data Distribution Tool .............................................................................. 200
    Nsadmin utility for new words, vocabularies, and commands .................................. 207

Chapter 8: Maintaining Dragon® Installations .................................................................................. 215
  Maintaining Installations ............................................................................................... 216
    Using Acoustic and Language Model Optimizer and Scheduler Tools .................. 216
    Removing One or More Optimization Schedules .................................................... 219
    Exporting and Importing User Files ......................................................................... 220
    Handling Dragon Error Messages ............................................................................ 221
    Working with the Usability Log .................................................................................. 221
    Accessing Dragon Knowledge Database .............................................................. 222
    Hardware Compatibility List ..................................................................................... 222
    Managing Who Has Administrative Privileges ....................................................... 223

Chapter 9: Managing and Securing Custom Commands ..................................................................... 225
  Managing and Securing Custom Commands ............................................................... 226
    Using the Convert XML to DAT tool ........................................................................ 226
    Using the MyCommands Protection Utility ............................................................. 227
# Overview of the Installation and Administration Guide for Dragon® Medical, Version 10.1

<table>
<thead>
<tr>
<th>For information on:</th>
<th>See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing, modifying and upgrading Dragon Medical.</td>
<td>Installing, Modifying, and Upgrading Dragon Medical and Installation checklists</td>
</tr>
<tr>
<td>Setting up and using <strong>Roaming Users</strong></td>
<td>Setting up and using Roaming Users</td>
</tr>
<tr>
<td>The <em>Roaming User</em> feature lets users dictate with <em>Dragon</em> from different network locations and different machines without having to create and train individual user files at each location.</td>
<td></td>
</tr>
<tr>
<td>Deploying <em>Dragon</em> Version 10 in a Citrix Presentation Server environment.</td>
<td>Using Dragon in a Citrix Presentation Server environment</td>
</tr>
<tr>
<td><em>Dragon</em> supports installation on a Citrix Presentation Server, enabling users to dictate from workstations that do not have <em>Dragon</em> installed.</td>
<td></td>
</tr>
<tr>
<td>Customizing Vocabularies with the <strong>Dragon Vocabulary Tool</strong> (Voctool)</td>
<td>Customizing Vocabularies with the Vocabulary Tool</td>
</tr>
<tr>
<td>You use the <em>Dragon Vocabulary Tool</em> to customize a vocabulary by adding new words and by optimizing the language model.</td>
<td></td>
</tr>
</tbody>
</table>
Adding new words, customized vocabularies or commands and make them available to all user profiles on a particular Dragon installation.

You use the `nsadmin` command line utility and the *Dragon Data Distribution Tool* when you want to make new words, customized vocabularies or new commands available to all user profiles on a particular Dragon installation.

<table>
<thead>
<tr>
<th>For information on:</th>
<th>See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding new words, customized vocabularies or commands and make them available to all user profiles on a particular Dragon installation.</td>
<td><a href="#">Adding words, commands, or vocabularies to user profiles</a></td>
</tr>
<tr>
<td>Managing and Securing Custom Commands</td>
<td><a href="#">Using the Convert XML to DAT tool</a></td>
</tr>
<tr>
<td>You can make your custom commands more secure in two ways:</td>
<td><a href="#">Using the MyCommands Protection Utility</a></td>
</tr>
<tr>
<td>▪ Use the <em>Convert XML to DAT tool</em> to make the tool available only in Dragon, convert any XML files of commands to DAT format.</td>
<td></td>
</tr>
<tr>
<td>▪ Use the <em>MyCommands Protection Utility</em> to prevent any Dragon users from editing the commands, you can lock access to the file.</td>
<td></td>
</tr>
<tr>
<td>Using Structured Commands</td>
<td><a href="#">About Structured Commands</a></td>
</tr>
<tr>
<td><em>Dragon Medical</em> includes an extension to text and graphics commands that let you to set the values of variables in text blocks based on voice input.</td>
<td></td>
</tr>
</tbody>
</table>

**Important Notes:**

- *This Installation and Administration Guide is intended for use with Dragon Medical, Version 10.1, and subsequent 10.x versions. Even though there are many references to Version 10 throughout this guide, the information does pertain to Version 10.1.*

- *The procedures in this guide use the terms Dragon Medical, Dragon, and, in some cases, Dragon NaturallySpeaking. In most cases, all of these references mean Dragon Medical.*

- *Finally, in many of the paths, command lines, and folder and file names, you will see reference to “Dragon NaturallySpeaking.” All of these paths, command lines, and folder and file names are for use with your Dragon Medical system.*
Chapter 1

Installing Dragon® Medical
# Installing, Modifying, and Upgrading Dragon Medical

To install *Dragon Medical*:

1. Be sure your systems meet the system requirements.

2. Prepare for the installation or upgrade.

3. Install or upgrade the software by choosing the type of installation in the table and linking to the corresponding instructions.

4. View the Version 10 file structure and carry out other post installation tasks.

<table>
<thead>
<tr>
<th>For information on:</th>
<th>See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation checklists</td>
<td>Installation checklists</td>
</tr>
<tr>
<td>System requirements</td>
<td>System requirements</td>
</tr>
<tr>
<td>Preparing for an installation or upgrade</td>
<td>Preparing for an installation or upgrade</td>
</tr>
</tbody>
</table>

**Installing on a single machine**

This topic describes the basics steps for installing *Dragon Medical* on a single machine.

It covers both a *Typical/Complete* installation and in a *Custom* installation, sometimes linking you to further detail in another topic.

**Installing using the Windows Installer (MSI)**

*Dragon Medical* includes a native Windows Installer (MSI) that lets you customize your installations as well as install across a network to multiple client machines. In addition, you use this service to modify, repair, or remove an existing *Dragon Medical* installations.

**Upgrading from a previous version**

You can upgrade to Version 10 from *Dragon Medical* Versions 9.x.

View Version 10 file structure and carry out post installation tasks
Preparing for an Installation or Upgrade

Before installing, modifying, or upgrading Dragon Medical:

- Close all open applications.
- Turn off or disable any antivirus software; installation can sometimes trigger a false virus report.
- Look at the supplied Installation Checklists.

Installation restrictions

- Be sure your system meets the hardware requirements before attempting to install Dragon Medical. See Recommended System Requirements
- Administrator rights are not required to create a user or use the software after installation.
- On Windows 2000 and Windows XP Professional systems, if as administrator you want to create a Dragon user for a Windows limited user (with restricted privileges), you must log on to Windows using that limited user account, then create the Dragon user. If you create a Dragon user account for a Windows limited user while logged in as a Windows administrator, the limited user will not be able to access that user account. These restrictions also apply to an upgrade installation.

Dragon Medical is licensed on a “per individual” basis. You are permitted to install the software on more than one computer (for example, on a desktop and a laptop computer, or on a work and a home computer), but you cannot use the software concurrently on more than one computer.

You are permitted to create multiple voice profiles, so long as each voice profile is for a single individual. If someone else wants to create or use another voice profile, however, that person must purchase a separate license for Dragon Medical.

Volume license agreements are available.

File Structure

Upgrading from Dragon Medical Version 9.x automatically relocates some NaturallySpeaking directories and files.

For information, see Version 10 File Structure.
Installation checklists

Installation checklist

☐ Do all of your workstations meet the recommended system requirements for Dragon? (Not applicable if you are running Dragon on a Citrix server; see Citrix Checklist below.)

☐ Will you install the Dragon Medical software manually at each computer or will installation be unattended? (If the latter, read Installing, Modifying, and Upgrading Dragon Medical for information on setup or MSI command-line parameters. Your answers to all of the installation questions are implemented through setup parameters.)

☐ Which features will you install on each computer?

☐ Which vocabularies do you need to install on each computer?

Note: Installing only selected vocabularies makes a significant improvement in disk space consumption and setup time. A full installation with all vocabularies uses about 2500 MB and takes about 20 minutes, while an installation with only one vocabulary uses less than 500 MB and takes about 5-10 minutes.

☐ Will you install the tutorial (recommended)?

☐ Will you install the text-to-speech component?

☐ Will you set up roaming users? (Read Setting up and dictating with Roaming Users)

☐ If so, where will you place the user files?

☐ In a shared network directory?

☐ In multiple shared network directories? (for example, one per department or clinic)

☐ In each user’s home directory?

Note: Placing each user’s file in his or her home directory is not highly recommended, because this makes it more difficult for the administrator to perform operations on multiple users, such as running the Acoustic and Language Model Optimizer or upgrading user files to a new version.

☐ On an Internet server running WebDAV (HTTP roaming)?

☐ If not, what location will you designate as the backup directory for each user?

☐ Where will you place the data distribution directory for distributing word lists and command sets?
Will you be collecting data for the acoustic optimizer?

Will you restrict users from modifying commands and vocabularies?

Which default user-specific options will you set at installation time? (See the Dragon Help on the Options dialog.)

> Note: Here are some additional considerations in user file placement. Each user file uses at least 25-30 MB. With default settings, acoustic optimizer data can take up to an additional 100 MB per workstation, to a total of 500 MB in the master roaming user file (more precisely, 100 MB per dictation source per workstation, 500 MB per dictation source per master roaming user). Acoustic optimizer data contains text and audio data that can be read or heard by anyone with access to the user files.

Upgrade checklist

☐ Are there user files that need to be upgraded from a previous version?

☐ If so, will an administrator upgrade them or will each end user upgrade his/her own?

Citrix checklist

☐ Will you be running Dragon on a client or a server system?

☐ If you will be running Dragon on a Citrix client, do you fully understand the impact this will have on functionality? (See tech note 5543 in the Nuance knowledge base at http://knowledgebase.nuance.com/view.asp?60VQ=JKKG&5d7r4B=Pv64vA)

☐ If you will be running Dragon on a Citrix server:

☐ Are all of your Citrix client systems running Windows 2000 or XP as required?

☐ Have you or your Citrix administrator read Using Dragon in a Citrix Presentation Server environment?

Support Checklist

☐ Who will be responsible for running the Acoustic and Language Model Optimizer?

☐ Who is responsible for collecting word lists and commands?

☐ Who is responsible for distributing word lists and commands?

☐ Will words and commands be distributed through the data distribution directory or by some other means (such as email)?
Who will *Dragon* users contact if they need help?

### Recommended System Requirements

To run *Dragon*, your system must meet the following requirements:

- Intel Pentium 4 (or equivalent AMD process) with CPU speed 2.4 GHz (1.6 GHz dual core processor) or equivalent AMD processor. If you have a minimum CPU speed of 1 GHz, you can run the software, but the performance is reduced. Faster processors produce faster performance.

  *Note:* During the installation process the software checks to make sure your system meets the minimum requirements. If your system does not meet the requirements, the software will not be installed.

- 512 MB RAM minimum. Recommended: 1 GB recommended. On Windows Vista, 1 GB RAM is required.

- 512 KB minimum L2 Cache. Recommended: 1 GB L2 Cache.

- Minimum of 1 GB of free hard disk space. Minimum 2.5 GB free hard disk space for *Dragon Medical*.

- Windows 2000 with Service Pack 4 or higher, Windows Server 2000 with Service Pack 4 or higher, Windows Server 2003, Windows XP Home or XP Professional with 32-bit with Service Pack 2 or higher, Windows Vista Home or Professional with or without Service Pack 1 (32-bit only). [Windows Vista considerations](#) for more on Vista restrictions.

- Sound card supporting 16-bit 11 KHz recording.

- Microsoft® Internet Explorer 6 or higher (free download available at [http://www.microsoft.com](http://www.microsoft.com)).

- An internet connection for product activation.

- DVD drive (required for installation).

- Nuance-approved noise-canceling headset/microphone (provided with the full product, but not with upgrades).

- Speakers (optional for playback of recorded speech and text-to-speech features).

- For Bluetooth wireless microphone support, visit [http://support.nuance.com/compatibility](http://support.nuance.com/compatibility).

- Additional software—Additional operating system Support for Medical Editions: Citrix MetaFrame Presentation Server 4.0 or 4.5 for Citrix support.
Storage space required for user files

Adequate storage space must be available for user files that store information about each particular user’s speech patterns. The space needs to exist on:

- Stand-alone installations where users work on dedicated machines.
- (Only if you have roaming users) Central machines (sometimes servers) where Master Roaming User files are stored.

Having Roaming User files lets providers run Dragon on more than one machine or device by accessing centrally stored provider-specific voice and speech information, rather than requiring that the voice information be on each machine.

These are guidelines only and not definitive specifications—actual size will vary from site to site.

For each Master Roaming User (user files stored on the central machine), you should plan to have this much space:

- 25 MB for each set of roaming user files
- 8 MB for each additional vocabulary you add for this user
- 18 MB for each additional dictation source you add for this user
- 500 MB for acoustic optimizer data associated with each dictation source of each user

To set how much data is stored:

1. On the **DragonBar**, select **Tools > Administrative Settings**.
2. When the **Administrative Settings** dialog box opens, check the **Disk space reserved for network archive** option.

In addition, for the Local Roaming User, you should plan to have the following space on each PC where the roaming user dictates:

- 25 MB for each set of roaming user files
- 8 MB for each additional vocabulary you add for this user
- 18 MB for each additional dictation source you add for this user
- 240 MB for acoustic optimizer data associated with each dictation source of each user.

How much acoustic optimizer data is retained locally is controlled by settings on the **Data** tab of the **Options** dialog box:

1. To set the number of minutes of audio to retain locally, click the **Archive size...** button and position the slider.
2. To turn off retaining this data locally, check the **Conserve disk space required by user files (for portability)** option.

These are guidelines only and not definitive specifications—actual size will vary from site to site.
For each non-roaming user, you should plan on approximately twice as much space as a Local Roaming User, because Dragon periodic makes a backup copy of the files and stores it on the same machine. The product does not back up Roaming User files this way as they are located on a central machine that your Information Technology department should back up regularly.

**Installing on or Upgrading to Windows Vista**

*Dragon Medical* Versions 9.5 and higher are compatible with all editions of Windows Vista.

**Upgrade considerations**

All your user profiles from these previous versions remain intact and can be upgraded when you install *Dragon Medical* Version 9.5 or Version 10.

**Roaming Users in an MSI Installation on Vista**

For more on carrying out an MSI installation on Windows Vista, see [Enabling Roaming User in an MSI installation](#).

**Coexistence with other Dragon products**

**Coexistence with previous versions of Dragon**

You can have only one version of *Dragon* installed on your system.

*Note:* Running Version 9.x concurrently with Version 10 is not supported.

**Coexistence with Dragon SDK Client Edition**

You can install *Dragon SDK Client* Edition 10 on the same machine where *Dragon* 10 is installed. In addition, *Dragon* and *Dragon SDK Client* Edition can share vocabularies and users.

You can run only one product at the same time. For example, if you are running *Dragon*, you cannot run any of the *Dragon SDK Client* tools or samples.

*Note:* Coexistence with *Dragon SDK Client Edition* Version 9.x is not supported.
Chapter 1: Installing Dragon® Medical

Installing Dragon on a Single Machine

This topic presents the basic steps for installing Dragon Medical on a single machine.


Note: You must have Windows Administrator rights to install or uninstall Dragon or Dragon Medical on Windows 2000, Windows XP, or Windows Vista. For more on how Administrator rights impact creating Dragon users, refer to Preparing for an installation or upgrade.

Installing on Windows Vista

For information about installing the product on Windows Vista, refer to Installing or Upgrading to Windows Vista.

Installing Dragon on a single machine

To install Dragon Medical:

1. Insert the first Dragon DVD into your DVD drive.

   If the installation does not start automatically, use the Windows Explorer to find and double-click setup.exe on the DVD.

   When you start the installation on Windows Vista, you might see a message saying A program needs your permission to continue. Click Continue to start the installation.

2. After the Windows Installer begins, it installs two software packages (if they are not already installed):

   Visual C++ Version 8.0
   PowerMic Microphone Drivers (if you are installing Dragon Medical)

3. After the installation Wizard begins, click Next to proceed to the License Agreement. Read the text of the agreement and select I accept..., then click Next again.

4. Enter your customer information—User Name and Organization—then the Serial Number supplied to your Dragon installation.

5. Choose your installation directory. If there are no previous versions of Dragon on your system, the default directory is:

   C:\Program Files\Nuance\NaturallySpeaking10
   For a list of directories created by the installation, see Version 10 File Structure.
6. Choose your **Setup Type**:

- **Note:** If you decide not to install some Dragon components by selecting **Custom** installation, you can install them later by running the **Setup** program again and choosing **Modify**.

- **Typical/Complete**: Installs all options and speech files and requires the most disk space.

- **Custom**: Lets you select options and speech files to install. Customizing your installation options can greatly reduce the disk space required.

In the Dragon Medical editions, you can modify the following settings during a custom installation. These settings are applied to all users created with this installation of Dragon, including users created from Windows XP limited accounts:

- **Modify the application’s settings for all users** displays the **Options** dialog box at the end of the installation. The Options dialog box lets you change the product’s standard behavior:
  - Change hot key settings
  - Customize how text is formatted
  - Choose initial microphone settings
  - Set how often your user files are backed up
  - Set where you can dictate commands, such as in web pages or other windows
  - **Modify the administrative settings** displays the **Administrative settings** dialog box at the end of the installation. The Administrative settings dialog box lets you:
    - Set up the Roaming User feature
    - Set the backup location of your user files
    - Restrict users from modifying commands and vocabularies
  - **Formatting options** displays the **Formatting** dialog box at the end of the installation. In this dialog box, you can choose ways that text should be automatically formatted (such as the date in US or European format) and the number of spaces after a period.

7. Click **Next** and on the **Ready to Install the Program** page you can choose to take two optional actions:

- **Enable QuickStart option for the current user**—Launches the product on system startup and places the **QuickStart** icon in the Windows task bar.
Chapter 1: Installing Dragon® Medical

- Upgrade existing speech files to work with the installation—Immediately after you reboot, the user upgrade process begins. You can make this choice to upgrade users from Version 9.x.

8. Continue following the on-screen instructions. The setup program will install the files for Dragon on your computer.

9. If you are upgrading and chose to upgrade speech files, when the message about upgrading your user speech files pops up, click OK.

10. After you click Finish and the installation is complete, if you did a Custom installation one or more of the following windows opens immediately:

   - If you checked off Modify the application settings for all users, the Options dialog box opens. For more information on the Options dialog box, see the main Dragon Help file.

   - If you checked Modify the administrative settings, the Administrative Settings dialog box opens. For more information on setting administrative settings under the Roaming, Miscellaneous, and Scheduled Tasks tabs:

     - See Administrative Settings: Roaming tab

     - See Administrative Settings: Miscellaneous

     - See Administrative Settings: Scheduled Tasks

   - If you checked Formatting options on the Custom Setup page, the Formatting dialog box opens. For more information on the Formatting dialog box, see the Main Dragon Help file.

11. After you click Finish, if you are prompted to restart your computer, restart it now. Otherwise, skip to the next step.

12. Start the product by selecting Start > All Programs > Dragon NaturallySpeaking 10 > Dragon NaturallySpeaking 10. The DragonBar appears on your desktop.

13. If you have users from Version 9.x and you chose the Upgrade existing speech files to work with the installation check box earlier, the User Upgrade Wizard opens automatically. Otherwise, if you do not have any users to upgrade, the New User Wizard opens automatically so that you can create the first user.

Activating Dragon

The first time you start Dragon, you will be prompted to activate your copy of Dragon. If you do not activate the software, Dragon will stop working after you start the product fives times. For more information on activation, please see the Dragon Version 10.1 User Guide.
Sample custom installation of Dragon Medical

This topic shows an example of a typical custom installation of Dragon Medical for the Roaming User environment.

Note: This is an example only and is provided to give administrators an overview of a typical installation and the kind of decisions you have to make. Though the example provides recommendations, it is not meant as a substitute for your own planning.

Preparing for the Roaming User feature

1. Create network storage location for Master Roaming User files. For example, you can create a shared drive that all Dragon users will have read/write access to. In this example, we’ll name this shared folder Dragon.

2. In the shared Dragon folder, you can create 2 sub-folders; Dragon Profiles and Data Directory.
   - Dragon Profiles is the location for the master copies of the user profiles. (For planning purposes allow for 500 MB per user profile.)
   - Data Directory is the location for macros and word lists that automatically update the user profiles by use of the Data Directory Tool.

For more information, see Setting up the Roaming User feature.

Install Dragon Medical

To install Dragon Medical:

1. Insert the first Dragon DVD into your DVD drive or, if installing from network drive, click on setup.exe.

2. When you have the option, choose Custom installation. For example:

   Custom lets you select options and speech files to install. Customizing your installation options can greatly reduce the disk space required. See Choosing Medical Vocabulary to Support Your Specialty for more information.

   Click Next to continue.

3. On the Additional Options screen, select all three options. For example:
Chapter 1: Installing Dragon® Medical

Click Next to continue.

Setting the Dragon Options

When the installation is complete, the three customization dialog boxes will open. The first to open is the Options dialog box.

Corrections tab:

You use this tab to control how the correction feature and spelling features work.

In this example:

- Check Enable double-click to correct. Selecting this check box gives the user a way to correct with the mouse.

- Maximize the number of choices that can appear in the Correction menu by setting it to 9.
The Commands tab:

You use this tab to set options that control how Dragon interprets commands. Unless otherwise indicated, changing these options only affects the current user; any other users keep their existing settings.

The following example shows the default settings:
The View tab:

You use the View tab to control the behavior and appearance of the DragonBar and the Results Box.

In this example, change Auto-hide delay from Never Hide to 5 seconds.
The Hot Keys tab:

You use the Hot keys tab to specify hot key assignments.

If your users will be using Dragon on a Notebook, then click Microphone on/off and hit the F10 key to change the hot key.

The PowerMic I and II tabs:

If you are using Dragon and you are using a Dictaphone® PowerMic for dictation, the Options dialog box displays the PowerMic I and II tabs. Dragon has built-in support for PowerMic or PowerMic II microphones. You can use the PowerMic II microphone buttons to perform predefined actions (described in the table below) or program the buttons to take custom actions.

The following example shows the default settings for the PowerMic II:
The Text-to-Speech tab:

You use the Text-to-speech tab to adjust the attributes of text-to-speech playback.

In this example, increase the Speed slider slightly. The default value is a little too slow. For example:
The Miscellaneous tab:

You use this tab to set miscellaneous options.

In this example

Leave the Microphone on (asleep) option unchecked unless the user cannot or does not want to use their hands to turn the microphone on and off.

Check Automatically save user files to automatically save the user’s files when Dragon is closed.

For example:
The Dictation Box tab:

On the Dictation tab of the Options dialog box, you can define how the Dictation Box operates. For more information on the Dictation Box, see the Using the Dictation Box topic in Dragon help file.

The following example shows the default settings for the Dictation Box:
The Data tab:

You use the Data tab to instruct Dragon to store corrections in an archive, conserve disk pace for better portability of user files, and control how Dragon adapts training, saves recorded dictation, and backs up user files.

In this example:

- Set the **Save recorded dictation with document** option to **Never**. You may want to set this option in most cases when using Dragon Medical and definitely when working in AP or EMR applications that only use a text editor to populate a database.

- Set the **Automatically back up user files every "n" saves** to nothing if your users are using the Roaming User option. When you have a Roaming User, the Master Roaming User profile most likely resides on a server that should be backed up every night.

For example:
Chapter 1: Installing Dragon® Medical

Setting the Administrative Options: Roaming Users

The second dialog to open at the end of the installation is the Administrative Settings dialog box. This section describes the **Roaming** tab of the Administrative options dialog box.

You use the **Roaming** tab of the **Administrative Settings** dialog box to set up the Roaming User feature. You must set up the Roaming User feature on each computer where you want users to dictate with a Roaming User. For more information, see [Administrative Settings: Roaming tab](#).

In this example:

- Select **Enable** to activate the Roaming User feature and the Roaming User options.

- Click the **Add** button. You use the **Roaming User Network Location** dialog box to define the network location of the master roaming users. The location you pick must be accessible to all computers on the network that you want available for dictation with Dragon. In this example, we’ll use the network storage location we initially created. For example:

  - **Display Name**: Roaming Profiles
  - **Network Location**: Dragon Profiles

![Administrative Settings Dialogue Box](image-url)
The **Administrative Settings** dialog box also contains several options that you can choose from to indicate how you want a Roaming User to function at each Roaming User location:

In addition to the default settings, also enable the *Access network at user open/close only* and *Always copy acoustic information to network* options. For example:
Click **OK** to continue.

- You will be prompted to create the default directory if it does not already exists, when you see the following message, always click **Yes**:
Setting the Administrative Options: Miscellaneous options

When the installation is complete, the three customization dialog boxes will open. The second to open is the Administrative Settings dialog box. This section describes the **Miscellaneous** tab of the Administrative options dialog box.

In this example, click **Change...** to set the location of the **Data Distribution Location** to the network directory that you created at the beginning.

Also make sure to deselect the **Check for product updates at startup** option to disable Dragon from automatically checking the Nuance web site for product updates if you want to control which updates your users can get.
Setting the Administrative Options: Scheduled Tasks

When the installation is complete, the three customization dialog boxes will open. The second to open is the Administrative Settings dialog box. This section describes the **Scheduled Tasks** tab of the Administrative options dialog box.

The following example shows the default settings for the **Scheduled Tasks** tab:

![Scheduled Tasks Tab](image)

For more information, see the *Dragon* help file.
Setting Formatting Options

The third dialog to open at the end of the installation is the **Formatting** dialog box. For example:

- **General Tab**—Controls general settings like how number, dates and times, and common number related abbreviations are formatted. Also on this tab is the option to spell out (expand) English contractions.
- **Capitalization Tab**—Controls how Dragon capitalizes dictated words, including medical terms.
- **Numbers, Units, and Dates Tab**—Contains rules for formatting numbers and units of measure, including rules specific to medical topics.
- **Abbreviations Tab**—Controls how medical-specific abbreviations are formatted.
- **Miscellaneous Tab**—Contains miscellaneous formatting rules.
1. Set the formatting options.

2. Click **Apply** to save your changes and leave the **Formatting** dialog box open.

3. Click **OK** to save your changes in the current tab, close the **Formatting** dialog box, and have the changes take effect. Your changes do not take effect until after you close the dialog box.

Nuance recommends that you review these tabs to make appropriate choices for your site.
Post Installation Tasks

Once you have installed or upgraded Dragon, you might want to carry out some of these tasks before you proceed:

- Cleaning up after uninstalling Dragon
- Viewing the Version 10 File Structure
- Turning off Dragon’s use of Microsoft Active Accessibility Service
- Choosing Medical Vocabulary to Support Your Specialty (Dragon Medical only)

Cleaning up after uninstalling Dragon

The following files will remain on your machine after you uninstall Dragon Medical:

C:\Windows\Speech

- VText.dll
- Vdict.dll
- WrapSAPI.dll
- XTel.Dll
- Xcommand.dll
- Xlisten.dll
- Xvoice.dll
- spchtel.dll
- speech.cnt
- speech.dll
- speech.hlp
- vcauto.tlb
- vcmd.exe
- vcmshl.dll
- vtxtauto.tlb

Dragon installed these files for Microsoft SAPI4 support. If you do not have other speech applications that require SAPI4, you can safely remove these files manually. If you have installed other speech applications that require SAPI4 support, you may need to re-install those applications if you remove the files.
Chapter 1: Installing Dragon® Medical

Version 10 File Structure

Upgrading from Dragon Medical version 9.x to version 10 will automatically relocate some NaturallySpeaking directories and files.

Note: The following directory structures and file locations assume an installation to a default location.


The V9.0/V9.1 directory structure before upgrading to V10:

C:\Program Files\Nuance\NaturallySpeaking9
\Help
\Program
\Tutorial (optional)
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking9\Custom
\Data
\Data\Training
\Users
C:\Documents and Settings\<username>\Application Data\Nuance\NaturallySpeaking9\Results


The V9.5 directory structure on Windows 2000/XP Pro/XP Home/Windows 2000 Advanced Server/Windows Server 2003 before upgrading to V10:

C:\Program Files\Nuance\NaturallySpeaking9
\Ereg
\Help
\Program
\Tutorial (optional)
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking9\Custom
\Data
\Data\Training
\Users
C:\Documents and Settings\<username>\Application Data\Nuance\NaturallySpeaking9\Results

V9.5 Windows Vista directory structure

The V9.5 directory structure on Windows Vista before upgrading to V10:

C:\Program Files\Nuance\NaturallySpeaking9


C:\Program Files\Nuance\NaturallySpeaking10
  \Ereg
  \Help
  \Program
  \Tutorial (optional)
C:\ProgramData\Nuance\NaturallySpeaking9\ 
  \Custom
  \Data
  \Data\Training
  \Users
C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking9\ 
  \Results

V10 Windows Vista directory structure

The directory structure after installing V10 on Windows Vista:

C:\Program Files\Nuance\NaturallySpeaking10
  \Ereg
  \Help
  \Program
  \Tutorial (optional)
C:\ProgramData\Nuance\NaturallySpeaking10\ 
  \Custom
  \Data
  \Data\Training
  \Users
C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking10\ 
  \Results
Turning off Dragon’s use of Microsoft Active Accessibility Service

Dragon Medical uses Microsoft Active Accessibility Service to let you control certain menus and dialog boxes by voice. Without Microsoft Active Accessibility Service, you would be unable to use Dragon to select menu commands and dialog box controls with your voice.

If you don’t need to control the menus and dialog boxes by voice, you can speed up Dragon performance by turning off Microsoft Active Accessibility Services.

To turn off Active Accessibility Services in Dragon for all applications

4. Open the Options dialog box by selecting Tools > Options on the DragonBar.
5. Click the Miscellaneous tab.
6. Clear the Use Active Accessibility for menu and dialog control box if it is selected.
7. Click OK. You will need to exit and re-start Dragon for this change to take effect.

To turn off Active Accessibility in Dragon for specific applications

1. Exit Dragon.
2. Open nssystem.ini in a text editor. By default, nssystem.ini is located in:
   
   C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10

3. Under [MSAA Modules Disabled], add a line similar to the following for each application where you want to disable the use of Active Accessibility Services:
   
   <executable_name>=1

4. Save and close nssystem.ini.
5. Re-start Dragon.

For example, to disable Dragon use of Active Accessibility Services in Microsoft Word and Microsoft Excel, you would add the following lines to nssystem.ini:

[MSAA Modules Disabled]
winword.exe=1
excel.exe=1

Note: If you do not know the name of an application’s executable file, you can start the application from the Windows Start menu and then use the Windows Task Manager to view the list of current Windows applications. The executable names are listed under Image Name on the Processes tab. You can also right-click the application’s icon and select the shortcut tab—the Target field will provide the name of the executable.
Choosing Medical Vocabulary to Support Your Specialty

If you are using *Dragon Medical*, you should know which medical vocabulary supports your specialty, so that you can readily select the correct vocabulary from the list provided.

The following table correlates Medical specialties with US English and UK English *Dragon Medical* vocabularies.

### US and UK English Dragon Medical

#### Specialties and the Vocabularies That Support Them

*Notes:*

- Specialities and Medical Vocabularies marked with a (1) are not available in the *Dragon Medical Small Practice Edition*.
- The Physical Medicine and Rehabilitation and the Speech and Language Pathology vocabularies not available in UK English are marked with a (2).

<table>
<thead>
<tr>
<th>Specialty</th>
<th>Medical Vocabulary to Choose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addiction Psychiatry</td>
<td>Addiction Psychiatry</td>
</tr>
<tr>
<td>Adolescent Medicine</td>
<td>Family Medicine, Internal Medicine, or Pediatrics</td>
</tr>
<tr>
<td>Allergy and Immunology</td>
<td>Allergy and Immunology</td>
</tr>
<tr>
<td>Anesthesiology</td>
<td>Anesthesiology</td>
</tr>
<tr>
<td>Bariatric Surgery</td>
<td>Surgery</td>
</tr>
<tr>
<td>Behavioral Health</td>
<td>Psychiatry</td>
</tr>
<tr>
<td>Blood Banking/Transfusion Medicine</td>
<td>Pathology 1</td>
</tr>
<tr>
<td>Breast Surgery</td>
<td>Surgery</td>
</tr>
<tr>
<td>Cardiac Surgery</td>
<td>Cardiac Surgery</td>
</tr>
<tr>
<td>Cardiology</td>
<td>Cardiology</td>
</tr>
<tr>
<td>Cardiothoracic Surgery</td>
<td>Surgery</td>
</tr>
<tr>
<td>Cardiovascular Disease</td>
<td>Internal Medicine</td>
</tr>
<tr>
<td>Chemical Pathology</td>
<td>Pathology 1</td>
</tr>
<tr>
<td>Child and Adolescent Psychiatry</td>
<td>Psychiatry</td>
</tr>
<tr>
<td>Specialty</td>
<td>Medical Vocabulary to Choose</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Child Abuse Pediatrics</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Clinical Cardiac Electrophysiology</td>
<td>Cardiology</td>
</tr>
<tr>
<td>Critical Care Medicine</td>
<td>Anesthesiology or Internal Medicine</td>
</tr>
<tr>
<td>Dentistry</td>
<td>Dentistry</td>
</tr>
<tr>
<td>Dermatology</td>
<td>Dermatology</td>
</tr>
<tr>
<td>Dermatopathology</td>
<td>Pathology ¹</td>
</tr>
<tr>
<td>Developmental-Behavioral Pediatrics</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Diagnostic Radiology</td>
<td>Radiology ¹</td>
</tr>
<tr>
<td>ENT</td>
<td>ENT</td>
</tr>
<tr>
<td>Ear, Nose, and Throat</td>
<td>Psychiatry</td>
</tr>
<tr>
<td>EEG</td>
<td>Emergency Medicine</td>
</tr>
<tr>
<td>EMG Examinations</td>
<td>Neurology</td>
</tr>
<tr>
<td>Endocrinology</td>
<td>Endocrinology Diabetes and Metabolism</td>
</tr>
<tr>
<td>Epidemiology</td>
<td>Epidemiology</td>
</tr>
<tr>
<td>Family Medicine</td>
<td>Family Medicine</td>
</tr>
<tr>
<td>Fetal Medicine</td>
<td>Fetal Medicine</td>
</tr>
<tr>
<td>Forensic Pathology</td>
<td>Pathology ¹</td>
</tr>
<tr>
<td>Forensic Psychiatry</td>
<td>Psychiatry</td>
</tr>
<tr>
<td>Gastroenterology</td>
<td>Gastroenterology</td>
</tr>
<tr>
<td>General Medicine</td>
<td>General Medicine</td>
</tr>
<tr>
<td>Geriatric Medicine</td>
<td>Geriatric Medicine or Family Medicine</td>
</tr>
<tr>
<td>Geriatric Psychiatry</td>
<td>Psychiatry</td>
</tr>
<tr>
<td>Hand Surgery</td>
<td>Hand Surgery or Plastic Surgery</td>
</tr>
<tr>
<td>Hematology</td>
<td>Hematology</td>
</tr>
<tr>
<td>Specialty</td>
<td>Medical Vocabulary to Choose</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hospice and Palliative Medicine</td>
<td>Pain Medicine, Emergency Medicine, Family Medicine, Internal Medicine, Pediatrics, or Physical Medicine and Rehabilitation ²</td>
</tr>
<tr>
<td>Infectious Disease</td>
<td>Infectious Disease</td>
</tr>
<tr>
<td>Internal Medicine</td>
<td>Internal Medicine</td>
</tr>
<tr>
<td>Interventional Cardiology</td>
<td>Internal Medicine</td>
</tr>
<tr>
<td>Medical Education and Writing</td>
<td>Medical Education and Writing</td>
</tr>
<tr>
<td>Medical Microbiology</td>
<td>Pathology ¹</td>
</tr>
<tr>
<td>Medical Oncology</td>
<td>Internal Medicine</td>
</tr>
<tr>
<td>Medical Toxicology</td>
<td>Emergency Medicine, Pediatrics</td>
</tr>
<tr>
<td>Mental Health</td>
<td>Addiction Psychiatry, Endocrinology Diabetes and Metabolism, Psychiatry, or Psychology</td>
</tr>
<tr>
<td>Midwifery</td>
<td>Midwifery</td>
</tr>
<tr>
<td>Neonatal and Perinatal Medicine</td>
<td>Neonatal and Perinatal Medicine</td>
</tr>
<tr>
<td>Nephrology</td>
<td>Nephrology</td>
</tr>
<tr>
<td>Neurodevelopmental Disabilities</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Neurology</td>
<td>Neurology</td>
</tr>
<tr>
<td>Neuromuscular Medicine</td>
<td>Physical Medicine and Rehabilitation ²</td>
</tr>
<tr>
<td>Neuropathology</td>
<td>Pathology ¹</td>
</tr>
<tr>
<td>Neuropsychology</td>
<td>Psychiatry, Neurology</td>
</tr>
<tr>
<td>Neurosurgery</td>
<td>Neurosurgery</td>
</tr>
<tr>
<td>Neurotology</td>
<td>ENT</td>
</tr>
<tr>
<td>Nuclear Medicine</td>
<td>Nuclear Medicine</td>
</tr>
<tr>
<td>Nuclear Radiology</td>
<td>Radiology ¹</td>
</tr>
<tr>
<td>Nursing</td>
<td>Nursing</td>
</tr>
<tr>
<td>Obstetrics and Gynecology</td>
<td>Obstetrics and Gynecology</td>
</tr>
<tr>
<td>Oncology</td>
<td>Oncology</td>
</tr>
<tr>
<td>Specialty</td>
<td>Medical Vocabulary to Choose</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Ophthalmology</td>
<td>Ophthalmology</td>
</tr>
<tr>
<td>Oral and Facial Surgery</td>
<td>Oral and Facial Surgery</td>
</tr>
<tr>
<td>Orthopaedic Surgery</td>
<td>Orthopaedic Surgery</td>
</tr>
<tr>
<td>Osteopathy</td>
<td>Osteopathy</td>
</tr>
<tr>
<td>Otolaryngology</td>
<td>ENT</td>
</tr>
<tr>
<td>Pain Medicine</td>
<td>Pain Medicine</td>
</tr>
<tr>
<td>Pathology</td>
<td>Pathology ^1</td>
</tr>
<tr>
<td>Pediatric Cardiology</td>
<td>Pediatric Cardiology</td>
</tr>
<tr>
<td>Pediatric Critical Care Medicine</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Pediatric Dentistry</td>
<td>Pediatric Dentistry</td>
</tr>
<tr>
<td>Pediatric Dermatology</td>
<td>Dermatology</td>
</tr>
<tr>
<td>Pediatric Emergency Medicine</td>
<td>Emergency Medicine or Pediatrics</td>
</tr>
<tr>
<td>Pediatric Endocrinology</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Pediatric ENT</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Pediatric Gastroenterology</td>
<td>Pediatric Gastroenterology</td>
</tr>
<tr>
<td>Pediatric Hematology-Oncology</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Pediatric Infectious Diseases</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Pediatric Nephrology</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Pediatric Otolaryngology</td>
<td>ENT</td>
</tr>
<tr>
<td>Pediatric Pathology</td>
<td>Pathology ^1</td>
</tr>
<tr>
<td>Pediatric Pulmonology</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Pediatric Rehabilitation Medicine</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Pediatric Rheumatology</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Pediatric Surgery</td>
<td>Surgery</td>
</tr>
<tr>
<td>Pediatric Transplant Hepatology</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Specialty</td>
<td>Medical Vocabulary to Choose</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------</td>
</tr>
<tr>
<td>Pediatric Urology</td>
<td>Urology</td>
</tr>
<tr>
<td>Pediatrics</td>
<td>Pediatrics</td>
</tr>
<tr>
<td>Physical Medicine and Rehabilitation</td>
<td>Physical Medicine and Rehabilitation</td>
</tr>
<tr>
<td>Plastic Surgery</td>
<td>Plastic Surgery</td>
</tr>
<tr>
<td>Plastic Surgery within Head and Neck</td>
<td>ENT</td>
</tr>
<tr>
<td>Podiatry</td>
<td>Podiatry</td>
</tr>
<tr>
<td>Proctology</td>
<td>Colon and Rectal Surgery</td>
</tr>
<tr>
<td>Psychiatry</td>
<td>Psychiatry or Addiction Psychiatry</td>
</tr>
<tr>
<td>Psychology</td>
<td>Psychology</td>
</tr>
<tr>
<td>Pulmonary Disease</td>
<td>Pulmonary Disease</td>
</tr>
<tr>
<td>Radiation Oncology</td>
<td>Radiation Therapy</td>
</tr>
<tr>
<td>Radiation Therapy</td>
<td></td>
</tr>
<tr>
<td>Radiologic Physics</td>
<td>Radiology</td>
</tr>
<tr>
<td>Radiology</td>
<td>Radiology 1 or Nuclear Medicine</td>
</tr>
<tr>
<td>Rheumatology</td>
<td>Rheumatology</td>
</tr>
<tr>
<td>Sleep Lab</td>
<td>Sleep Lab</td>
</tr>
<tr>
<td>Sleep Medicine</td>
<td>Family Medicine or ENT</td>
</tr>
<tr>
<td>Speech and Language Pathology</td>
<td>Speech and Language Pathology 1, 2</td>
</tr>
<tr>
<td>Spinal Cord Injury Medicine</td>
<td>Physical Medicine and Rehabilitation 2</td>
</tr>
<tr>
<td>Sports Medicine</td>
<td>Emergency Medicine, Family Medicine, or Physical Medicine and Rehabilitation</td>
</tr>
<tr>
<td>Surgery</td>
<td>Surgery</td>
</tr>
<tr>
<td>Thoracic Surgery</td>
<td>Thoracic Surgery</td>
</tr>
<tr>
<td>Transplant Hepatology</td>
<td>Internal Medicine</td>
</tr>
<tr>
<td>Trauma Surgery</td>
<td>Surgery</td>
</tr>
<tr>
<td>Undersea and Hyperbaric Medicine</td>
<td>Emergency Medicine</td>
</tr>
</tbody>
</table>
Chapter 1: Installing Dragon® Medical

Enhancing the privacy of patient data

When a user dictates using Dragon Medical, Dragon automatically saves all audio and transcribed text in Dragon Recorded Audio (.DRA) files. If the user corrects any of the dictated text, Dragon automatically stores these corrections in .enwv files. Both these files are saved in the background.

These automatically created .DRA and .enwv files are used by Dragon to optimize the user profile. For example, Dragon uses these files when a user runs the Acoustic and Language Model Optimizer.

Dragon encrypts these automatically created .DRA and .enwv files before storing them in the local or roaming user directories to ensure they do not become a back door into patient data and violate the patient’s privacy. These files are also encrypted when a user dictates into a supported application like Microsoft Word or an Electronic Medical Record (EMR) application.

Due to the restrictions mandated by the HIPAA regulations, these encrypted .DRA and .enwv files can only be opened by Dragon Medical for its internal use. For example, they cannot be accessed by the non-Medical versions of Dragon, the Dragon NaturallySpeaking SDK Client Edition (DSC), or the Dragon NaturallySpeaking SDK Server Edition (DSS). In addition, any encrypted .DRA and .enwv files automatically created by Dragon, cannot be opened in DragonPad.

Notes:

- Dragon Medical does not encrypt .DRA files explicitly saved by a user. For example, if a user saves recorded dictation when saving a document (for example, in Word, WordPerfect, or DragonPad), these saved .DRA files are unencrypted. The user who created these files has the responsibility of saving these files in a secure location.

- Nuance does not guarantee that the file encryption provided in Dragon will ensure total HIPAA compliance. Other security measures are required for full compliance.

Security Considerations

As long as other adequate security protections are in place to protect patient data, you can avoid saving excess patient data by choosing to:

- Turn off encryption of patient data (not recommended)

- Turn off creation of .DRA files and set options to conserve disk space, resulting in fewer saved files

- Turn off creation of unencrypted .nwv files

<table>
<thead>
<tr>
<th>Specialty</th>
<th>Medical Vocabulary to Choose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Urology</td>
<td>Urology</td>
</tr>
<tr>
<td>Vascular Surgery</td>
<td>Vascular Surgery</td>
</tr>
<tr>
<td>Vascular and Interventional Radiology</td>
<td>Vascular and Interventional Radiology</td>
</tr>
</tbody>
</table>
**Turning on/off encryption of patient data**

It is possible to turn off the encryption of these background speech recognition files by un-checking the *Encrypt Patient Health Information* check box in the Miscellaneous tab of the Administrative Settings Dialogue.

Nuance can not guarantee HIPAA compliance when this feature is turned off.

For more information, see the **Miscellaneous tab** of the **Administrative Settings** dialog box.

**Turning on/off creation of .dra patient data files**

You can choose to turn off creation of the .DRA files containing patient data to further protect the patient’s privacy when other security measure are in place, by:

- Turning off data collection, which sends data to Nuance for future product improvements. The check box to enable/disable data collection is on the **Scheduled Tasks** tab of the **Administrative Settings** dialog box. For more information, see:
  - **About Data Collection and Other Scheduled Tasks**

  and

- Checking settings to conserve disk space, which automatically stops creating files that require large amounts of storage space:

  1. On the **DragonBar**, select **Tools** > **Options** and click the **Data** tab.

  2. Check the *Conserve disk space required by user files (for portability)* option. For more information on the **Data** tab of the **Options** dialog box, refer to the main **Dragon** Help file’s topic on the **Data** tab in the **Options** dialog box.

**Turning on/off creation of unencrypted text correction .nwv archive files**

To further ensure privacy, any user can turn off creation of archive files that might contain patient data:

1. On the **DragonBar**, select **Tools** > **Options** and click the **Data** tab.

2. Uncheck the *Store correction in archive* option. For more information on the **Data** tab of the **Options** dialog box, refer to the main **Dragon** Help file’s topic on the **Data** tab in the **Options** dialog box.
Chapter 2

Upgrading Dragon® Medical
Upgrading Dragon Medical

You take the following steps to upgrade from Version 9.x to Version 10 of Dragon:

- Prepare to upgrade:
  - Based on the version you are upgrading from (9.x), determine how you will proceed (see What you should know before upgrading from a previous version)
  - If you are upgrading to Windows Vista, see Installing on or Upgrading to Windows Vista
- Carry out one of these procedures:
  - Upgrade multiple users (see Upgrading multiple users)
  - Upgrade roaming users (see Upgrading roaming user files)
  - Upgrade users with custom or customized vocabularies (see Upgrading Users with Custom and Customized Vocabularies)

You can work with the User Upgrade Wizard (see Upgrading multiple users)

What you should know before upgrading from a previous version

You can upgrade to Version 10 from Dragon Medical Versions 9.x. You upgrade to Version 10 by following the installation instructions for Version 10, but you should first be sure to:

- Uninstall the previous version, when it is required for the version you are upgrading from.
- Retain your existing user files, to be updated after the installation completes.
- Check that it is possible to upgrade from your existing edition to the edition you are installing.

Upgrading from Version 9.x

The Version 10 installation will install in the Version 9.x directories and overwrite the files in those directories.

Edition considerations

You must upgrade to the same edition or higher and to the same language.

For example, if you started with Version 9.1 German/English and you upgrade to Version 10 English only, your Version 9.1 German users will not be upgraded. Upgrading to Version 10 German/English will upgrade both your German and English users. After upgrading, you can install other Version 10 languages.
Installing on or Upgrading to Windows Vista

*Dragon Medical* Versions 9.5 and higher are compatible with all editions of Windows Vista.

**Upgrade considerations**

If you upgrade a machine from a previous version of Windows to Windows Vista and that machine has Version 9.0, or 9.1 of *Dragon* installed, that version of *Dragon* will not work after upgrading to Windows Vista.

All your user profiles from these previous versions remain intact and can be upgraded when you install *Dragon* Version 9.5 or Version 10.

**Roaming Users in an MSI Installation on Vista**

For more on carrying out an MSI installation on Windows Vista, see [Enabling Roaming User in an MSI installation](#).

**Upgrading multiple users**

If you choose not to upgrade your user files and vocabularies during the upgrade, you can do so at a later time by running the Version 10 *Upgrade User* Tool by selecting **Start > Programs > Dragon NaturallySpeaking 10 > Dragon NaturallySpeaking Tools > Upgrade Users**.

The *User Upgrade Wizard* opens.

The *User Upgrade Wizard* guides you through the process of upgrading user files created in *Dragon* Version 9.x.

**User Upgrade Wizard: Select Users to Upgrade page**

On the *Select Users to Upgrade* page, you see these elements:

**User files to upgrade**

Lists the location and name of all the users that the wizard will upgrade. Modify the list of users to include all users that you want to upgrade. The wizard starts by including all the users in the current folder as candidates to upgrade. You add users to the list by clicking the **Add** button and browsing for additional users in other locations. You remove users from the list by selecting them and clicking the **Remove** button. Once you have adjusted the list of user files to show only the ones you want to upgrade, click **Next**.

*Note: If you have roaming users in your network, see [Upgrading roaming user files: Overview](#).*

**Old Location**

The current location of the user files is called *Old Location* on this page of the wizard.

**User name**

This column lists the users to upgrade by name.
Number of users to upgrade
Displays the total number of users the wizard will upgrade.

Add button
Opens a Browse for Folder window that you can browse in to locate additional users for the wizard to upgrade.

Remove button
Deletes a selected user from the User Upgrade wizard.
Once you have made a selection, click Next.

User Upgrade Wizard: Choose Destination page
At the same time that the User Upgrade Wizard modifies your user files to work with Dragon Version 10, it can move a copy of the upgraded user to another location while keeping the old files untouched. This allows you to return to the old user files in case you need them again, and it makes the files compatible with operating systems, like Windows XP, that store all user data in the Documents and Settings folder.

Destination for upgraded user files
Click the Browse button or select a new destination from the list if you want to choose a destination other than the suggested destination.

Advanced
Click the Advanced button to open the Advanced Options dialog box where you can alter the way that the wizard upgrades the user.

User Upgrade Wizard: Advanced Options dialog box
The Advanced Options dialog box lets you make finer adjustments to how the wizard upgrades the user. This page contains the following information and allows you to make the following changes:

Users to upgrade
This list box contains the following information about each user at the current location:

User
Name of the user.

Old Location
Location of the current (not yet upgraded) user files.

Vocabulary
The original vocabulary of the user.
Acoustic Model

The audio input device and associated language/voice model assigned to the user.

New Location

When you click on the Location line in the Users to upgrade list box, this text box becomes available. Initially it displays the location that the wizard recommends or that you chose on the Choose Destination page. You can click Browse and choose a new location.

New Base Vocabulary

When you click on the Vocabulary line in the Users to upgrade list box, this text box becomes available. Initially it displays the current vocabulary of the user or the one that the User Upgrade Wizard will assign to the upgraded user if the old vocabulary is no longer supported by Dragon. If the current vocabulary is supported, the message <Unable to upgrade> appears. You can select a new base vocabulary from the drop-down list if it contains other vocabularies.

New Acoustic Model

When you click on an Acoustic model line in the Users to upgrade list box, this text box becomes available. Initially, it displays the current language (such as US English), language model, and accent of the user. You can choose a new acoustic model from the drop-down list.

After you have modified the user information for each user in the list box, click OK to return to the wizard, and click Next to proceed.

User Upgrade Wizard: Upgrade Users page

On the Upgrade Users page, click Begin to start the upgrade process. Expect to wait approximately 5 minutes for each user being upgraded.

When the process is complete, click Finish.

If the Upgrade User wizard ran automatically in response to you starting the product after installing an upgrade, the Open User window opens and displays a list of users you can choose from to begin dictation.

Upgrading roaming user files: Overview

This section describes how to upgrade Roaming User files from Dragon Medical Version 9.x to Version 10.

When you use the Roaming User feature, each Dragon user has a master roaming user file that can be opened from multiple networked computers where Dragon is installed. These master roaming user files are stored on a network location made accessible to your Dragon users.

When a master roaming user file is opened from that central network location, Dragon transfers a copy of that user to the Local Roaming User file on the local computer.

Since the Local Roaming user file is a copy of the user data taken from the master roaming user file, you cannot directly upgrade the Local Roaming User when you upgrade the local Dragon installation from Version 9.x to Version 10.
Notes:

- Upgrading a set of Version 9.x master roaming user files to Version 10 leaves the Version 9.x master roaming user files unchanged. Leaving the Version 9.x files intact allows the users in your network to run Dragon Version 9.x while you plan your upgrade.

- Plan to upgrade the master roaming user files at a time when they are not being opened by end users, for example during the night or on a weekend.

- Even though the Dragon 10 User Upgrade Wizard supports both mapped drives and UNC paths, Nuance strongly recommends that you upgrade your Master Roaming User files on a drive on a machine where Dragon 10 is locally installed. Nuance does not recommend that you upgrade your Master Roaming user files across a network to either a mapped drive or UNC path; upgrading over a network will take an undetermined length of time. In addition, the User Upgrade Wizard does not support upgrading users over an HTTP connection.

Step 1: Preparing to upgrade roaming user files

To upgrade your Master Roaming user files from a previous version of Dragon, Nuance recommends that you install Dragon 10 directly on the network machine where the version 9.x Master Roaming user files are located and upgrade those Master Roaming user files directly to Dragon 10 Master Roaming user files.

If you are unable to install Dragon where your version 9.x Master Roaming user files are located, Nuance recommends that you:

- Install Dragon 10 on a separate machine where you will perform the upgrades.
- Copy the version 9.x Master Roaming user files from their network location to the machine where Dragon 10 is installed.
- Upgrade the version 9.x Master Roaming user files on the machine where Dragon 10 is installed.
- Copy the upgraded version 10 Master Roaming user files to a network accessible directory on the original network location.

For more information, see Preparing to upgrade roaming user files.

Step 2: Upgrading the user files

As administrator you must separately upgrade the master roaming user files to Version 10 using the Version 10 User Upgrade Wizard.

After you upgrade the version 9.x Master Roaming user files, you can then proceed to upgrade end-user systems that deploy the Roaming User feature.

For more information, see Upgrading master roaming user files.

Step 3: Upgrade the end-user systems

After you have upgraded the master roaming user files, you can then proceed to upgrade end-
user systems that deploy the Roaming User feature. For more information, see Upgrading end-user systems.

Preparing to upgrade roaming user files

**Step 1: Install Dragon 10 the machine where you will perform the upgrades of your version 9.x Master Roaming user files**

Nuance recommends that you install Dragon 10 on the machine where the version 9.x Master Roaming user files are located. If that is not possible, Nuance recommends that you install Dragon 10 on a separate machine where you will perform the upgrades. For more information on installing, see Installing on a single machine.

*Notes:*

- *If during the installation or upgrade you are prompted to Upgrade existing speech files to work with this installation*, be sure to leave this option unchecked. You will be manually running the User Upgrade Wizard in a later step.

- *If you are unable to install Dragon where your version 9.x Master Roaming user files are located, see Upgrading roaming user files, Nuance recommends that you install Dragon 10 on a separate machine where you will perform the upgrades. For more information, see Upgrading roaming user files: Overview.*

**Step 2: On the version 9.x end-user systems that use the Roaming User feature**

On the end-user systems where the users dictate using the version 9.x Roaming User feature, save and close any open user on each Dragon Version 9.x system that uses the Roaming User feature.

*Note: If there is no time when all of your roaming user files are unused (for example, if you are supporting a hospital where some physicians use Dragon during a night shift), you can upgrade different groups of roaming user files at different times.*
Step 3: On the central network location that stores the version 9.x Master Roaming User files:

1. (Optional) Back up the master roaming user files to a separate location, either by using any system backup utility that is implemented at your facility or by using the Dragon The Manage Users dialog.

   **Note:** You are not required to back up the roaming user files because when you upgrade, your Version 9.x user files are retained in a directory separate from your Version 10 user files.

2. Create a new directory on the shared network drive that should store the upgraded Dragon 10 Master Roaming User files. Although you can store the upgraded Version 10 users in the same location as the current users — this would make two versions of each user file visible to the end user and lead to confusion — Nuance recommend that you create a location that differs from the location that stores the current user files.

Step 4: Copy the version 9.x Master Roaming user files from the previous network location to the machine where Dragon 10 is installed.

If you installed Dragon 10 on the machine where the version 9.x Master Roaming user files are located, then proceed to Step 5 below.

If you installed Dragon 10 on a machine other than where the version 9.x Master Roaming user files are located, then do the following on the machine where Dragon 10 is installed:

1. Create a directory on the local machine that will hold all the Master Roaming user files you plan to upgrade.

2. Copy the version 9.x Master Roaming User files from the network location to the directory you just created.

Step 5: On the administrator system from where you will upgrade the version 9.x Master Roaming User files to version 10:

1. Start Dragon Version 10 and make sure the Roaming User feature is turned off.

   To turn off the Roaming User feature:
   a. Close any open users.
   b. Click **Administrative Settings** on the **DragonBar Tools** menu. This action displays the **Administrative Settings** dialog box.
   c. On the **Roaming** tab, make sure **Enable** is not selected.

2. Close Dragon.

3. Follow the instructions in the next section, **Upgrading master roaming user files**.

Upgrading master roaming user files

As administrator you must separately upgrade the master roaming user files to Version 10.
using the Version 10 User Upgrade Wizard on the version 9.x Master Roaming user files. Before proceeding with this section, make sure you have followed the procedure described in Preparing to upgrade roaming user files.

After you have upgraded the version 9.x Master Roaming user files and optionally copied them back to their network location, you can then proceed to upgrade your end-user systems that use the Roaming User feature. For more information, see Upgrading end-user systems.

**Step 1: Upgrade the version 9.x Master Roaming user files using the User Upgrade Wizard**

On the machine where both your version 9.x Master Roaming files and Dragon 10 are installed:

1. Select **Start > Programs > Dragon NaturallySpeaking 10 > Dragon NaturallySpeaking Tools > Upgrade Users.**

This opens the **User Upgrade Wizard**. For example:

![User Upgrade Wizard](image)

**Note:** If you did not turn off the Roaming User feature in the Administrative Settings dialog box before attempting to start the User Upgrade Wizard, you receive an error message stating that you cannot upgrade a Roaming User. If you receive the message, go back to the Administrative Settings dialog and be sure the Enabled check box is not checked.

2. On the Select Users to Upgrade page, click **Add...** to select the location of the version 9.x Master Roaming user files. The the Select Users to Upgrade page now displays a list of...
users in the selected directory. For example:

You can continue to use the Add... button to add users from other local locations or use the Remove button to remove specific users. Click Next to continue.

3. On the Choose Destination page, in the Destination for upgraded user files text box, choose the local location you previously created that will contain the upgrade Version 10 master roaming user files. If you do not see the location you want, you can click the Browse button, find the correct location, and click Next. For example:
4. The **Upgrade Users** page displays the number of users that the wizard is prepared to upgrade.

5. Click **Begin** to start the upgrade process. The upgrade process can take 2-3 minutes or more per user, depending on the speed of your system and your network. You can click **Stop** at any time to interrupt this process.

   The upgrade process creates new master roaming user files in the destination you selected.

6. Click **Finish** to complete the upgrading process and exit the **User Upgrade Wizard**.

   **Note:** The User Upgrade Wizard renames each Version 10 master roaming user file as follows: `<name> (v10)`. For example, a Version 9.x Master Roaming user file named roaminguser1 will be copied and named roaminguser1 (v10) when upgraded to Version 10. The Version 9.x Master Roaming user file named roaminguser1 remains unchanged.

   Having the files renamed like this could cause some confusion for the users in your network who are dictating with Roaming User accounts. If, for example, you chose to locate your Version 9.x and your upgraded Version 10 Roaming User files in the same network directory, the Open User dialog box would display both the old and the Version 10 master roaming user files.
Step 2: Clean up network locations of Version 9.x master roaming user files (optional)

When the **User Upgrade Wizard** modifies the Version 9.x master roaming user files to work with **Dragon** Version 10, it makes a copy of the upgraded user first, keeping the original Version 9.x files unchanged. This allows you to return to the old user files in case you need them again.

As administrator, you can optionally rename or remove the Version 9.x master roaming user files through the **Manage Users** dialog box.

**Step 3: Copy the upgraded version 10 Master Roaming user files back to their network location (Optional)**

If you were unable to install **Dragon** where your version 9.x Master Roaming user files were located and you copied your version 9.x Master Roaming user files to a another machine where **Dragon** 10 was installed, you must now copy the upgraded version 10 Master Roaming user files back to the new network accessible directory that you created on their original network location.

You can skip this step if you installed **Dragon** 10 on the machine where the version 9.x Master Roaming user files are located and upgraded those Master Roaming user files directly to **Dragon** 10 Master Roaming user files.

**Step 4: Upgrade your end-user systems from Dragon V9 to Version 10**

After you have upgraded the master roaming user files, you can then proceed to upgrade your end-user systems where users dictate deploying the Roaming User feature. For more information, see [Upgrading end-user systems](#).

**Upgrading end-user systems to Dragon 10**

After you have upgraded the master roaming user files, you can then proceed to upgrade the end-user systems that use the Roaming User feature.

Before proceeding with this section, make sure you have followed the procedure described in [Upgrading master roaming user files](#).

**Step 1: Upgrade Version 9.x systems where users will dictate with the Version 10 Roaming feature**

Since the **User Upgrade Wizard** leaves your Version 9.x master roaming user files unchanged and in their original network location, your Version 9.x systems can continue to use the Roaming User feature until you upgrade those installations to Version 10.

To upgrade a Version 9.x system where Roaming Users dictate to Version 10, follow the installation instructions under [Installing Dragon on a single machine](#).

---

**Note:** When prompted, choose to remove the Version 9.x Dragon installation. If you choose not to remove the previous installation, you cannot continue to upgrade.

**Step 2: Enable Roaming User feature on upgraded end user systems and try opening a Roaming User**

When you upgrade a **Dragon** to Version 10, the Roaming User feature is turned off by default. To turn on the Roaming User feature on the upgrade machines:
1. Start **Dragon**.

2. If a user opens, close it.

3. Click **Administrative Settings** on the **DragonBar Tools** menu. This displays the **Administrative Settings** dialog box.

4. On the **Roaming** tab, select **Enable**.

5. The **Network Directories** list will display the network location of the Version 9.x master roaming user files.

   If you created a new network directory for your Version 10 master roaming user files, you can either click the **Add** button to add the new network location or select a listed directory and then click **Edit** to change the path to the new location. When you have finished, click **OK** to close the **Administrative Settings** dialog box. You should also remove any unused Version 9.x master roaming user directory to avoid confusion.

6. Select **Dragon > Open Users** on the **DragonBar**. This action displays the **Open User** dialog box. If you allow users to select both non-roaming local and Roaming Users, make sure they select the correct location (the Version 10 Roaming User location) from the **Location of user files** field.

7. Select a user and click **Open**.

   **Note:** If the Roaming Users have not already been upgraded and stored in the new master roaming user directory, when you click **Open**, the **User files need to be upgraded** dialog box appears. Since you cannot upgrade roaming users locally, you should click **Cancel** here and return to **Upgrading master roaming user files**. If you click **OK** instead of **Cancel**, you receive a message stating **You cannot upgrade a roaming user** because you cannot upgrade Roaming Users on a workstation that has roaming enabled.

---

**Upgrading multiple users**

If you choose not to upgrade your user files and vocabularies during the upgrade, you can do so at a later time by running the Version 10 **Upgrade User** Tool by selecting **Start > Programs > Dragon NaturallySpeaking 10 > Dragon NaturallySpeaking Tools > Upgrade Users**.

The **User Upgrade Wizard** opens.

The **User Upgrade Wizard** guides you through the process of upgrading user files created in **Dragon** Versions 9.x.

**User Upgrade Wizard: Select Users to Upgrade page**

On the **Select Users to Upgrade** page, you see these elements:

**User files to upgrade**

Lists the location and name of all the users that the wizard will upgrade. Modify the list of users
to include all users that you want to upgrade. The wizard starts by including all the users in the current folder as candidates to upgrade. You add users to the list by clicking the Add button and browsing for additional users in other locations. You remove users from the list by selecting them and clicking the Remove button. Once you have adjusted the list of user files to show only the ones you want to upgrade, click Next.

⚠️ Note: If you have roaming users in your network, see Upgrading roaming user files: Overview

Old Location

The current location of the user files is called Old Location on this page of the wizard.

User name

This column lists the users to upgrade by name.

Number of users to upgrade

Displays the total number of users the wizard will upgrade.

Add button

Opens a Browse for Folder window that you can browse in to locate additional users for the wizard to upgrade.

Remove button

Deletes a selected user from the User Upgrade wizard.

Once you have made a selection, click Next.

User Upgrade Wizard: Choose Destination page

At the same time that the User Upgrade Wizard modifies your user files to work with Dragon Version 10, it can move a copy of the upgraded user to another location while keeping the old files untouched. This allows you to return to the old user files in case you need them again, and it makes the files compatible with operating systems, like Windows XP, that store all user data in the Documents and Settings folder.

Destination for upgraded user files

Click the Browse button or select a new destination from the list if you want to choose a destination other than the suggested destination.

Advanced

Click the Advanced button to open the Advanced Options dialog box where you can alter the way that the wizard upgrades the user.

User Upgrade Wizard: Advanced Options dialog box

The Advanced Options dialog box lets you make finer adjustments to how the wizard upgrades the user. This page contains the following information and allows you to make the following changes:
Chapter 2: Upgrading Dragon® Medical

**Users to upgrade**
This list box contains the following information about each user at the current location:

**User**
Name of the user.

**Old Location**
Location of the current (not yet upgraded) user files.

**Vocabulary**
The original vocabulary of the user.

**Acoustic Model**
The audio input device and associated language/voice model assigned to the user.

**New Location**
When you click on the *Location* line in the *Users to upgrade* list box, this text box becomes available. Initially it displays the location that the wizard recommends or that you chose on the *Choose Destination* page. You can click **Browse** and choose a new location.

**New Base Vocabulary**
When you click on the *Vocabulary* line in the *Users to upgrade* list box, this text box becomes available. Initially it displays the current vocabulary of the user or the one that the *User Upgrade Wizard* will assign to the upgraded user if the old vocabulary is no longer supported by Dragon. If the current vocabulary is supported, the message *<Unable to upgrade>* appears. You can select a new base vocabulary from the drop-down list if it contains other vocabularies.

**New Acoustic Model**
When you click on an *Acoustic model* line in the *Users to upgrade* list box, this text box becomes available. Initially, it displays the current language (such as US English), language model, and accent of the user. You can choose a new acoustic model from the drop-down list.

After you have modified the user information for each user in the list box, click **OK** to return to the wizard, and click **Next** to proceed.

**User Upgrade Wizard: Upgrade Users page**

On the *Upgrade Users* page, click **Begin** to start the upgrade process. Expect to wait approximately 5 minutes for each user being upgraded.

When the process is complete, click **Finish**.

If the *Upgrade User* wizard ran automatically in response to you starting the product after installing an upgrade, the *Open User* window opens and displays a list of users you can choose from to begin dictation.
Upgrading Users with Vocabularies Created by Third Parties

Note: Any installation can use vocabularies that are not provided by Nuance, but created by a third party specifically for a particular installation.

Upgrading Users with Vocabularies Created by Third Parties

When you upgrade a user whose base vocabulary was created by a third party, all custom words and other changes to that vocabulary will be maintained but the vocabulary’s base type will be changed. For example, Version 9.x users who used US English | Large | Nuance vocabulary with a topic ID of 9005 are upgraded to use the General—Large vocabulary; that upgraded user’s vocabulary also contains all customizations in the Version 9.x vocabulary.

Once the user is upgraded, you can continue to modify the vocabulary using the Voctool.

To further modify and re-distribute customizations to vocabularies created by third parties, you can follow the steps outlined below on your Version 10 users.

Step 1: Export any custom words added to the custom vocabulary

If you added any additional custom words to the vocabulary created by a third party, you must first export those words. To export custom words:

1. On the DragonBar menu, select Words > Export... This action displays the Export Custom Words dialog box.

2. Enter the path and name of the file containing the custom words to add to the vocabulary that you want to create, or use Save in list to find a location for the file you want to create.

Step 2: Upgrade a user with a customized vocabulary

To upgrade Version 9.x users with a vocabulary created by a third party:

1. Run the User Upgrade Wizard. To run the wizard, select Dragon NaturallySpeaking 10> Dragon NaturallySpeaking Tools > Upgrade Users.

2. In the User Upgrade Wizard, select a Version 9.x user that uses a vocabulary created by a third party.

3. Click Next and follow the on-screen prompts.

The User Upgrade Wizard displays the original vocabulary deployed to create the user and lets you choose a Version 10 base vocabulary that the User Upgrade Wizard should assign to the upgraded user.

Step 3: Import custom words to the upgraded user

If you exported words in Step 1, you now must import those words. To import a word list:
1. On the **DragonBar**, click **Words > Import...**. This displays the **Add Words** from **Word Lists** wizard.

2. Click **Next** to add the file you created in Step 1.

### Step 4: Export the customized vocabulary

You can share vocabularies among different users by first exporting a vocabulary from one user and then importing it to a new user. Use the following procedure to export a vocabulary. To export a vocabulary:

1. Create a folder in which to save the exported vocabulary files.

2. Open the upgraded Version 9.x user that uses the customized vocabulary.

3. On the **DragonBar**, select **NaturallySpeaking** or say “**Manage Vocabularies.**”

4. In the **Manage Vocabularies** dialog box, select the vocabulary you want to export and then export it.

5. Locate and open the target folder, enter a name for the exported vocabulary in the **File Name** box, and then save it.

6. In the **Manage Vocabularies** dialog box, click or say “**Close**” to save and close it.

*Note:* Exporting a vocabulary creates a copy of the four files that make up the vocabulary in the new location. You can access these files via the **Data Distribution Tool** or the **nsadmin** tool to create new custom base vocabularies.

### Step 5: Use nsadmin or the Data Distribution tool to copy the exported vocabulary

Using the **nsadmin** command line or the **Data Distribution Tool**, you can import the vocabulary you created in Step 2 as a base vocabulary on any **Dragon** installation.

Once you add a base vocabulary to a **Dragon** installation, you can then use the new vocabulary to create new users or add the new a new vocabulary to the an existing user.

When you run **nsadmin** or the **Data Distribution Tool** to import the exported vocabulary to your **Dragon** installation, be sure to give the new vocabulary the same name and topic ID that the Version 9.x customized vocabulary had.

For example, if your Version 9.x customized vocabulary was named **US English | Large | Nuance** topic ID **9005**, you would use **nsadmin** or the **Data Distribution Tool** to create a new base vocabulary with that same name and topic ID number.
Chapter 3

Installing Dragon® Medical Using the Windows MSI Installer
Overview of Installing Dragon Using the Windows Installer (MSI)

Dragon Medical includes a native Windows Installer (MSI) that lets you customize your installations as well as install across a network to multiple client machines. In addition, you use this service to modify, repair, or remove any existing installations. Although you have several choices when deciding how you want to install Dragon Medical on the command line, Nuance recommends that you follow the approach presented initially in this document.

Note: MSI installations are not supported for Dragon Medical Small Practice Edition.

You can use this procedure to install the software on one machine at a time or combine it with Systems Management Server (SMS) or Windows Active Directory Service to install the software across a network to multiple client machines. Also, if you have already installed the product, you use this process to upgrade, modify, repair, or remove any existing installations.

Before You Begin

To ensure a smooth installation, before you proceed, you should gather the following information regarding your network and Dragon settings.

- Preferred settings for Dragon options, including any PowerMic or PowerMic II button actions to be programmed. Usually set in the Options dialog box of Dragon.

- Preferred settings for Dragon formatting options to be applied to the recognized text. Usually set in the Formatting dialog box of Dragon.

- Path to and/or mapped drive of the location where Roaming Users are stored or are going to be stored, normally set in the Network Settings subdialog of the Roaming tab in the Administrative Settings dialog box.

- Information about your http or https connection to the Roaming Users storage location, if applicable, normally set in the Http Settings or Https Settings subdialog of the Administrative Settings dialog box.

- Preferred settings for collecting dictation data to be sent back to Nuance Communications for improving the future accuracy of Dragon, normally set under the Scheduled Tasks tab of the Administrative Settings dialog.

- Install a third-party indexing/search software before you install Dragon; if no third-party indexing/search is installed, when you try to set Dragon options, the Enable Desktop Search commands check box will not be available for selection. Dragon supports Google Desktop and Microsoft Vista Search.
Finding the MSI Installer on the DVD

The compiled *MSI* file is located on your installation DVD. The files for each edition are named:

- *Dragon Medical*: Dragon NaturallySpeaking 10.msi

You can double click on one of these *.msi* files to start the InstallShield Wizard; however, to instead take advantage of available command line options, you can pass the file name as the application to install to the `msiexec.exe` command using the `/i` option:

```cmd
msiexec.exe /i "Dragon NaturallySpeaking10.msi"
```

**Entering Command Lines**

Unless otherwise noted:

- All command line options are case-insensitive (unless otherwise noted) and can be combined.
- No options require special values based on the values of other options.
- In the examples, user-supplied information is displayed between angle brackets. Do not use angle brackets (`<,>`) as part of the command line.
- Do not use quotation marks unless you are explicitly instructed to.
- Strings of path names with spaces in them must be in quotation marks that are escaped by a backslash before each quotation mark (`"`).
- Whenever you set an option to an .ini file, you must give the full path to that .ini file.
- All msiexec.exe command-line options you pass with `/v` must be prefaced with a forward slash (`/`) only.

**Windows Vista Notes**

*Dragon* setup is designed so that `msiexec.exe` can be run from an elevated command prompt in Windows Vista.

To launch an elevated command prompt in Windows Vista:

1. Click the Windows *Start* key
2. Type `cmd` in the search field
3. Press Ctrl+Shift+Enter. This action displays a *User Account Control* dialog box stating that *Windows needs your permission to continue*. 
4. Click Continue or hit Alt+C to confirm the elevation prompt. This displays an elevated command prompt.

Alternatively, to run the command window as an administrator, you can select Start > All Programs > Accessories > Command Prompt (without releasing the mouse), then right click Command Prompt and select Run As. Choose an Administrator user and enter the authentication information requested.

Overview of the Network Installation of Dragon from a Server

Overview of Pushing Client Installation from a Server

You can install the Dragon runtime in a network environment, in other words, push the software application out to client computers without having to install it separately on each client system. Dragon includes a native Windows Installer (MSI) that lets you both install across a network to multiple client machines and customize your installations. Several servers support this type of network installation:

- Microsoft Windows 2000 Advanced Server
- Windows Server 2003
- Windows Server 2008
- System Management Server (SMS)
- Active Directory Services

The administrator carrying out the installation creates an image of the installation program on the server and then configures the server to automatically push the application onto the client systems. You can also configure network installations to modify, repair, or remove an existing installation.

Support for SMS and Windows 2000/2003 Server with Active Directory

Systems Management Server (SMS) provides a mechanism for pushing application installations out from the server to client systems. SMS supports using the Windows Installer (MSI) to push client installations on clients using all versions of Windows, from Windows 2000 to Windows Vista. SMS requires that a client application be installed on all client machines.


Administrators can use this feature to install software to Windows 2000, Windows XP, and Windows Vista clients.

*Dragon* supports the Active Directory Services Assign to Computers installation option. This option successfully installs the software when the computer is rebooted. You (as administrator) can delay installation on Windows XP or Vista clients by enabling logon optimization for group policy; for this type of installation, an entry for the installation can be viewed in the event log after the first reboot. The installation is then performed on the second reboot. The installation takes place silently, and the software is installed for all users on the computer.

**Overview of Alternative Ways to Carry Out Administrative Installation**

*Dragon Medical* includes a native Windows Installer (MSI) that lets you install across a network to multiple client machines and customize your installation in the process. In addition, you can use this service to modify, repair, or remove any existing installations. You can use any of the following command line approaches to installing *Dragon* over a network:

- **Carrying Out an Administrative Installation with .bat File**
- **Configuring Installation of Product Updates**
- **Citrix Overview**
- **Creating Custom Installation Using Microsoft Custom Install Wizard**

Once you have installed the server image, you can configure your installation, then use SMS or a similar product to install *Dragon*. If the product you use to push the installation out to a server requires it, you can install *Dragon* with msiexec (see **Step-by-Step Command Line Installation with msiexec.exe**) instead of setup.exe.

**Modifying Roaming User, Miscellaneous, Schedule Settings in the INI File**

Suppose you have a large installation that involves several departments. Three departments require one group of configure settings and two others require modifications. After you complete the installation on the three departments requiring the same configuration, you might want to edit your configuration files before using them on the additional two departments.

To edit the settings, you can use the natspeak command again. You can either return to the machine where you carried out the initial installation to use natspeak or install the configuration from the first three departments on the first machine in the two departments with different settings. Modify the settings using:

- natspeak /setdefaultoptions
- natspeak /setdefaultformattingoptions
- natspeak /setdefaultadministrativeoptions
Then copy the new nsdefaults.ini file and roamingdef.ini files to a location accessible from all the client machines to have the alternative configuration. For example, if you want these files to be accessible to the MSI installer from a mapped network drive, copy the files to that location before installing to the client PCs.

Or, if the Roaming User network settings are not changing, you can edit any of the other Roaming User, Miscellaneous, and Scheduled Tasks settings of your configuration by rerunning Dragon with any command listed above. (You cannot make changes to the roamingdef.ini file, where the network settings reside.) Lists of the options in the nsdefaults.ini and roamingdef.ini files are provided in the tables that follow:

**Caution:** Be sure to use the full path to the file if you set an option to an .ini file name.

## Editing Roaming User Options in nsdefaults.ini File

Several roaming user options are listed in the nsdefaults.ini file. These are the same options you can set from the Roaming tab of the Administrative Settings dialog box. You can either find and modify these options in the nsdefaults.ini file that Dragon created during an initial installation or copy the file from an existing installation.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
<th>UI equivalent (in Roaming tab)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roaming User On=0 (or 1)</td>
<td>Turns on the <strong>Roaming User</strong> feature. Default 0 = Off</td>
<td>Enable</td>
</tr>
<tr>
<td>Roaming User Local Cache Directory=&quot;&lt;existing directory&gt;&quot;</td>
<td>Sets the location of the local copy of the roaming user. The default location is: **Documents and Settings\All Users\Application Data\Nuance\Dragon NaturallySpeaking10\RoamingUsers**.</td>
<td>Local directory (for cache)</td>
</tr>
<tr>
<td>Roaming User Restrict Local User Access=1 (or 0)</td>
<td>Permits non-roaming user to be opened when the roaming user feature is active. Default of 1 restricts access to roaming users only, preventing non-roaming (local) users from dictating by accident.</td>
<td>Allow non-Roaming Users to be opened</td>
</tr>
<tr>
<td>Roaming User Copy Dragon Log=0 (or 1)</td>
<td>Copies the <strong>dragon.log</strong> file from the local roaming user location to the <strong>master</strong> roaming user location at the same time that the program synchronizes the local and the master roaming user. Default 0 = Off</td>
<td>Copy Dragon Log to Network</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
<td>UI equivalent (in Roaming tab)</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Roaming User Limited Network Traffic=0 (or 1)</td>
<td>Transfers <strong>local roaming user</strong> changes to the <strong>master</strong> roaming user to synchronize the <strong>local</strong> and <strong>the master</strong> roaming user only when you open or close the user. This includes the changes a user makes locally from the Options dialog box. For more information, see the <em>Dragon Administrator Guide</em> Help file topic on Synchronizing Master and Local Roaming Users. Excessive network slowdowns can be alleviated by checking this option because it limits multiple interim synchronizations of local and master roaming users. Default 0 = Off.</td>
<td>Access network at user open/close only</td>
</tr>
<tr>
<td>Roaming User Always Break Lock=0 (or 1)</td>
<td>Ask before breaking the locks on network users (recommended). A network lock prevents opening a roaming user that is already open. Network problems can cause a lock to become &quot;stuck&quot; and not release even after opening the user is complete. Default of 0 produces a prompt that states the user is locked and asks you to override the lock. A setting of 1 does not produce the prompt, but breaks the lock automatically.</td>
<td>Ask before breaking locks on network users (recommended for UNC and mapped drives)</td>
</tr>
<tr>
<td>Roaming User Max Container Size=500MB</td>
<td>Controls the maximum size for each container directory in the <strong>master</strong> roaming user directory. Defaults to 500 MB, max of 10000 MB.</td>
<td>Disk space reserved for network archive</td>
</tr>
<tr>
<td>ASW Override=0 (or 1)</td>
<td>(ASW is short for Audio Setup Wizard.) Runs a <strong>Volume</strong> and <strong>Quality Check</strong> on the microphone each time you open a roaming user. This setting affects all users. Turn this option on if your users experience reduced accuracy because of differences in the microphone, sound card, and ambient sound levels at different locations. Default 0 = off. Nuance recommends you set this option to 1.</td>
<td>Set audio levels on each machine</td>
</tr>
<tr>
<td>Roaming ASW Override=0 (or 1)</td>
<td>Runs a <strong>Volume</strong> and <strong>Quality Check</strong> on the microphone each time you open a roaming user. Set to 1 if the Roaming User feature is enabled and <strong>ASW Override</strong> is 1. <strong>ASW Override</strong> and <strong>Roaming ASW Override</strong> should always have the same setting.</td>
<td>Set audio levels on each machine</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
<td>UI equivalent (in Roaming tab)</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>Roaming User Do Not Copy Dra Files=0 (or 1)</td>
<td>Prevents making files that contain acoustic data from the latest dictation session available to the Acoustic Optimizer when the program synchronizes the local and master roaming users. You use this option to prevent the transfer of acoustic optimization data to local users.</td>
<td>Conserve archive size on network</td>
</tr>
<tr>
<td>Roaming User Incorporate Voc Delta=0 (or 1)</td>
<td>When the vocdelta.dat file reaches 90% of its maximum size (500KB), incorporates the contents of the local vocdelta.dat file into the master roaming user files (acoustic model for the user), without running the Acoustic and Language Model Optimizer. After it incorporates the contents of the file into the master roaming user, it clears that data from the local user, where new data is culled from subsequent dictation. If the data is being incorporated when you open a roaming user, the process can be time consuming. Default 0 = off.</td>
<td>Merge contents of vocdelta.dat into network user when file is full</td>
</tr>
<tr>
<td>Roaming User Copy Acoustic Always=0 (or 1)</td>
<td>Copies the user’s acoustic information to the master roaming user location when you don’t want to run the Acoustic and Language Model Optimizer on the master roaming users. The local roaming user acoustic information is stored in: Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\Roaming Users&lt;display name&gt;&lt;username&gt;\current\voice The &lt;display name&gt; is the name you defined for the master roaming user location. You can have multiple network storage locations. The &lt;username&gt; contains the names of an individual master roaming user. Default 0 = off.</td>
<td>Always copy acoustic information to network</td>
</tr>
</tbody>
</table>
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer

If you chose not to copy the user’s acoustic information to the network, corrections you make on one machine are not available on other machines used by that particular roaming user until you run the Acoustic and Language Model Optimizer on the master roaming user location and the local and master roaming user synchronize. When this option is set to 1 (on), the latest acoustic information is always available and automatically synchronized when the master roaming user is opened from another location. The transfer of acoustic information is not limited by setting the Disk space reserved for network archive option.

### Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
<th>UI equivalent (in Roaming tab)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AO Archive Time Limit</td>
<td>Maximum audio archive size in minutes. The same option in the options.ini file for a particular user contains the size of the current audio archive for that user. Default max is 3600000 minutes.</td>
<td>Archive Size dialog box, displaying the range of audio archive sizes</td>
</tr>
<tr>
<td>Disable command changes</td>
<td>Turns on or off the option that lets non-administrative users add or modify commands.</td>
<td>Do not allow restricted users to add or modify commands</td>
</tr>
<tr>
<td>for restricted users=0 (or 1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disable vocabulary changes</td>
<td>Turns on or off the option that lets non-administrative users modify vocabularies.</td>
<td>Do not allow restricted users to modify vocabularies</td>
</tr>
<tr>
<td>for restricted users=0 (or 1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Global Enable Pause Results</td>
<td>Turns on or off recognition when the speaker pauses.</td>
<td>Record wave data between utterances</td>
</tr>
<tr>
<td>=0 (or 1)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Editing Miscellaneous and Scheduled Task Settings in nsdefaults.ini File

Of the settings in the nsdefaults.ini file retrieved from the Administrative Settings dialog box, several settings are from the Miscellaneous and Scheduled Tasks tabs of the dialog box. You can modify the following settings in the nsdefaults.ini file:
<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Directory=&lt;full path&gt;</td>
<td>Sets the location of the Data Distribution directory used by the Data Distribution Tool or the nsadmin command.</td>
<td>Data Distribution location</td>
</tr>
<tr>
<td>Current Status Ctfmngr=0 (or 1)</td>
<td>Turns on or off Windows advanced text services. Turning off these services prevents conflict between them and Dragon.</td>
<td>Disable Windows advanced text services</td>
</tr>
<tr>
<td>No Dictation=0 or 1</td>
<td>When No Dictation is on (set to 1) the user cannot dictate, but can only correct dictation; used to designate a user as a transcriptionist.</td>
<td>Correction Only Mode</td>
</tr>
<tr>
<td>Global MyCommands MacroRecorder=0 or 1</td>
<td>Allows or does not allow the user to modify Macro Recorder commands. The user should still be able to dictate with those commands, even when not allowed to modify them.</td>
<td>Disable use of Macro Recorder commands</td>
</tr>
<tr>
<td>Global MyCommands StepByStep Scripting=0 or 1</td>
<td>Allows or does not allow the user to modify Step-by-Step commands. The user should still be able to dictate with those commands, even when not allowed to modify them.</td>
<td>Disable use of Step-by-Step commands</td>
</tr>
<tr>
<td>Global MyCommands VBA Scripting=0 or 1</td>
<td>Allows or does not allow the user to modify Advanced Scripting commands. The user should still be able to dictate with those commands, even when not allowed to modify them.</td>
<td>Disable use of Advanced Scripting commands</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
<td>Options</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>enx ACO uses Auto Accent AM selection=0 or 1</td>
<td>When set to 1, the Acoustic Optimizer engine can automatically select an acoustic model that it believes is more suited to your speech. To avoid having this switch occur, set the option to 0.</td>
<td>Disable automatic acoustic model selection in Acoustic Optimizer</td>
</tr>
<tr>
<td>Encrypt Patient Health Information=0 or 1</td>
<td>When set to 1, <em>Dragon</em> automatically encrypts interim files it automatically creates, to avoid the possibility of those files being inadvertently accessed by unauthorized personnel.</td>
<td>Encrypt patient health information</td>
</tr>
<tr>
<td>Data Collector Batch Mode=0 or 1</td>
<td>When set to 1, turns on a process that automatically collects data to help improve speech recognition in the future. The process sends the data to Nuance over the Internet, but does not send any personal information - it collects recorded dictation and the corresponding text. Collecting data for Nuance is optional.</td>
<td>Enable scheduled Data Collection</td>
</tr>
<tr>
<td>Allow Users to Optimize=0 or 1</td>
<td>When set to 1, turns on a process that automatically runs an optimization process on speech recognition for the currently open user.</td>
<td>Enable scheduled Accuracy Tuning</td>
</tr>
<tr>
<td>Allow Users to Configure Tasks=0 or 1</td>
<td>Turning this option on lets users set the schedule for accuracy tuning and data collection tasks. Otherwise, these tasks take place on a default schedule.</td>
<td>Let the user choose when to run Accuracy Tuning and Data Collection</td>
</tr>
</tbody>
</table>
Understanding Network and Connection Settings in roamingdef.ini File

Although you cannot edit the roamingdef.ini file because it is encrypted, you should know that the following information is in the file. You can modify these settings through the Administrative Settings dialog only. For more information on values for each option, refer to the Dragon Administrator Guide Help file available through the product menu:

<table>
<thead>
<tr>
<th>Options</th>
<th>UI Element/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[&lt;Network Settings&gt;]</td>
<td><em>Display Name</em> assigned to the network directory where Roaming Users are stored, in the <em>Network Directories</em> box.</td>
</tr>
<tr>
<td>location</td>
<td><em>Address</em>. Path to a network directory, web server, or secure web server where Roaming Users are stored.</td>
</tr>
<tr>
<td><strong>HTTP Settings</strong></td>
<td></td>
</tr>
<tr>
<td>type</td>
<td><em>Authentication Type</em>.</td>
</tr>
<tr>
<td>authtype=1</td>
<td>Indicates authentication is required.</td>
</tr>
<tr>
<td>queryforuserpassword</td>
<td><em>Prompt for user and password</em> check box.</td>
</tr>
<tr>
<td>authuser</td>
<td><em>&lt;domain&gt;&lt;username&gt;</em> required to log in.</td>
</tr>
<tr>
<td>authpassword</td>
<td>Actual password required to log in.</td>
</tr>
<tr>
<td>followredirects</td>
<td><em>Follow Redirects</em>. Never, Always, or Same Scheme Only.</td>
</tr>
<tr>
<td>keepalive</td>
<td><em>Keep Connection Alive</em> check box.</td>
</tr>
<tr>
<td>locktimeout</td>
<td><em>Lock under Timeouts</em>. Number of seconds after timeout expires to lock the connection.</td>
</tr>
<tr>
<td>connectiontimeout</td>
<td><em>Connection under Timeouts</em>. Number of seconds after timeout expires to close the connection.</td>
</tr>
<tr>
<td>connectiontimeoutinactivity</td>
<td><em>Type under Timeouts</em>. Set if you selected Inactivity option.</td>
</tr>
<tr>
<td>connectiontimeoutabsolute</td>
<td><em>Type under Timeouts</em>. Set if you selected Absolute option.</td>
</tr>
<tr>
<td>firewall</td>
<td><em>Firewall and Proxy Servers</em>. Set if a firewall is configured.</td>
</tr>
<tr>
<td>proxy</td>
<td><em>Use Proxy Server</em> check box. Set if checked.</td>
</tr>
<tr>
<td>proxyserver</td>
<td><em>Network Location</em>. URL to the web server.</td>
</tr>
<tr>
<td>firewalltype</td>
<td><em>Type</em>. Type of firewall represented by a number.</td>
</tr>
</tbody>
</table>
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer

Carrying Out an Administrative Installation with .bat File

A straightforward way to install Dragon from the command line to a server is to carry out an administrative installation using a .bat file.

Caution: Only advanced users should attempt any type of administrative Installation.

Note: A script for carrying out a full administrative installation, including installation of Visual C++ Runtime for Dragon, is provided in the admininstall.bat file at the top of the directory structure on the DVD. The script provided includes a bare minimum of the options

<table>
<thead>
<tr>
<th>Options</th>
<th>UI Element/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>firewallhost</td>
<td><em>Server</em>. Name of server for the firewall.</td>
</tr>
<tr>
<td>firewallport=1080</td>
<td><em>Port</em>. Port used by the proxy server or firewall. <strong>1080</strong> is the default.</td>
</tr>
<tr>
<td>firewalluser</td>
<td><em>Username</em>. Login name of the admin user who can access the firewall.</td>
</tr>
<tr>
<td>firewallpassword</td>
<td><em>Password</em>. Password to log in to the firewall.</td>
</tr>
<tr>
<td>firewalldata</td>
<td><em>Firewall Data or Proxy Authorization</em>. Special authentication string for firewall or proxy server, if applicable.</td>
</tr>
</tbody>
</table>

**SSL Settings (HTTPS)**

<table>
<thead>
<tr>
<th>Options</th>
<th>UI Element/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sslcertstore</td>
<td>Certificate store text box with no label. Name of the certificate.</td>
</tr>
<tr>
<td>sslcertstorepassword</td>
<td><em>Certificate Store Password</em>.</td>
</tr>
<tr>
<td>sslcertstoretype</td>
<td><em>Certificate Store Type</em>, indicated by numeric designation.</td>
</tr>
<tr>
<td>useopenssl</td>
<td><em>Using OpenSSL</em> check box.</td>
</tr>
<tr>
<td>opensslcipherlist</td>
<td><em>Cipher List</em>.</td>
</tr>
<tr>
<td>opensslcafile</td>
<td><em>Certificate Authority File</em>.</td>
</tr>
<tr>
<td>opensslcadir</td>
<td><em>CA Directory</em>.</td>
</tr>
<tr>
<td>tls1</td>
<td><strong>SSL Enabled Protocols</strong></td>
</tr>
<tr>
<td>ssl3</td>
<td></td>
</tr>
<tr>
<td>ssl2</td>
<td></td>
</tr>
<tr>
<td>pct1</td>
<td></td>
</tr>
</tbody>
</table>
available, so you might want to read through the Installation using the Dragon command line to find out about other options you might use.

Understanding the script in admininstall.bat

Below are some of the lines from the script in the admininstall.bat file, a batch file that uncompresses setup files into a network location for installation using SMS or another service. Since any system to be installed might be a 32-bit system or a 64-bit system, the batch file places a different vcruntime on the server for each type of system.

To run the batch file, you enter admininstall.bat and follow it with three arguments: the locations of the vcruntime source file for 32-bit systems, the vruntime source file for 64-bit systems, and the Dragon .msi file, in that order. Both 32-bit and 64-bit vcruntime files must be available for the .bat file to run.

Near the top of the batch file, you see the lines that check the parameters entered and if the parameters passed are not acceptable, execute a routine that handles that situation:

:rem //Check and analyze input parameters
if .%1.==.. goto bad_args
if .%2.==.. goto bad_args
if .%3.==.. goto bad_args

If the arguments you pass when you enter the command are acceptable, the batch file sets the NETWORK_VCRUNTIME_DIR variable to the first argument, the NETWORK_VCRUNTIME_X64_DIR to the second and NETWORK_DNS_DIR to the third:

set NETWORK_VCRUNTIME_DIR=%1%
set NETWORK_VCRUNTIME_X64_DIR=%2%
set NETWORK_DNS_DIR=%3%

Notice that there are two VCRUNTIME variables. The first is for a 32-bit system and the second for a 64-bit system. The script needs both to carry out all the action.

In the next section of the batch file, you see the lines that install Visual C++ Runtime for Dragon, which must be installed before you can install Dragon. The batch file first installs 32-bit machine vcruntime and displays messages as it progresses:

To install Visual C++ Runtime for Dragon, the script uses the full path to vcruntime.exe and passes it several options:

- /a to indicate it is an administrative installation (to a server)
- /L option followed by the language ID
- /v option followed by a series of MSI installation options all enclosed in quotation marks, including:
  - /qb to display only a basic GUI
  - /L to indicate the types of messages to log and the file to log them in

`ISSetupPrerequisites\VCruntime\vcruntime.exe /a /11033 /v"TARGETDIR=%NETWORK_VCRUNTIME_DIR% /qb /L*v %TEMP%\admininstall.log"`
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer

**Note:** An administrative installation should always use the TARGETDIR option instead of the INSTALLDIR option.

The batch file then installs 64-bit vcruntime using the full path to vcruntime_x64.exe and passes it the same options:

```
echo Installing Visual C++ Runtime for Dragon NaturallySpeaking 64bit (x64)...
ISSetupPrerequisites\VCRuntime\vcruntime_x64.exe /a /11033 /v"TARGETDIR=%NETWORK_VCRUNTIME_X64_DIR% /qb /L*v %TEMP%\admininstall.log"
```

If you have Version 10, rather than Version 10.x, you have only the 32-bit version and need to use a different path:

```
ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5}\vcruntime.exe /a /11033 /v"TARGETDIR=%NETWORK_VCRUNTIME_DIR% /qb /L*v %TEMP%\admininstall.log"
```

When the installation of Visual C++ Runtime succeeds or fails, the batch file displays the appropriate message.

Finally, the log file installs Dragon, using a single line of code that calls the setup.exe command and passes it:

```
/a option — Indicates administrative install
/s option for a silent no-GUI installation
/v option to indicate msiexec options follow, enclosed in quotation marks
```

The msiexec options with /v include /qb for display of a basic GUI during the process, the TARGETDIR setting, and a /L with a series of log file options, including the name and location for the log file:

```
echo Installing Dragon NaturallySpeaking...
setup.exe /a /s /v"/qb TARGETDIR=%NETWORK_DNS_DIR% /L*v %TEMP%\admininstall.log"
```

When the installation of Dragon succeeds or fails, the batch file displays an appropriate message. The remainder of the file handles errors and cases where bad arguments are passed on the command line.

**Modifying admininstall.bat**

You can modify the admininstall.bat file by adding to and changing the options you pass for installation Visual C++ Runtime, then Dragon. You can add more options and/or modify the options shown here. For more on installation options, refer to Installation using the Dragon command line or these summaries:

- **MSI Options Specific to Dragon**
- **MSI Options for Installing Dragon Features/Advanced Options**
- **Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties**
- **MSI Options for Roaming User, Tuning, and Data Collection Setup**
Install Dragon on an initial Machine and choose the default settings

Before you proceed, you should be familiar with installing the product on a single machine from the DVD. For more information, see Installing, modifying and upgrading Dragon.

The initial installation is used to set default values for the Administrative, User and Formatting options. These options can then be used to install on other machines using the same values.

Even if you are installing from a server, you should run through the initial installation below first. For more information on installing from a server, proceed to Overview of the Network Installation of Dragon from a Server.

⚠️ Caution: If you want to set any administrative settings, be sure you have Windows administrator privileges. Administrator rights are not required to create a user profile or use the software after installation.

Before you begin:

- Install any pending Windows updates and reboot the machine when you are finished.
- Close all open applications.
- Turn off or disable antivirus software; the installation process can sometimes trigger a false virus report.

>Note: An alternative to this approach is to use msiexec.exe to install Dragon, covered under Step-by-Step Command Line Installation with msiexec.exe.

Extracting MSI/MST Files from the Dragon setup.exe

Some minor release of Dragon, Service Pack 1 of Dragon 10 for example, do not include a .MSI file, they are supplied with a setup.exe.

You can carry out an administrative installation using setup.exe, as follows:

- Create a server image of Dragon files for later installing clients. You create the image by executing setup.exe and passing it the /a option and a Dragon-specific option that extracts MST and MSI files from the Dragon setup.exe file provided.
- Use the options to extract the MSI/MST Files from the Dragon setup.exe.

Extracting MSI/MST Files from setup.exe

The following setup.exe options are designed to extract .msi/.mst files for Windows Installer-oriented distributions. These options do not install any files, but rather extract an installable set of files into the server directory you specify.
## Using .MSI/.MST Files for Custom Installations Example

Using .MST files you can tailor the MSI installation without changing the setup.exe file that Nuance provides.

### Step1: Running setup.exe to Extract .MSI and .MST Files

The following sample command line extracts the French .MSI file, Dragon NaturallySpeaking 10.msi, and the .MST file used for installing Dragon in French:

```
setup.exe /a /s /l1036 /v"EXTRACTFILES=c:\temp\MSIfiles /qn"
```

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/a</code></td>
<td>Administrative installation. Instructs <code>setup.exe</code> to perform an administrative installation to a network for use by a workgroup instead of a normal installation. This option is required when trying to extract the <code>.msi</code> files. An administrative installation installs a source image of the application onto the network. The image is similar to a source image on a CD or DVD. Users in the workgroup who have access can then install the product over the network from this source image.</td>
</tr>
<tr>
<td><code>/v&quot;&lt;msiexec options&gt;&quot;</code></td>
<td>Passes <code>msiexec</code> options to Windows Installer. See table of <code>msiexec</code> options for details. This option is required when trying to extract the <code>.msi</code> files.</td>
</tr>
<tr>
<td><code>/&lt;Windows Language Code&gt;</code></td>
<td>Specifies the language to use for installing Dragon. For example, to launch the installation in French, the command line would include <code>/L1036</code>. The language codes supported for installing Dragon NaturallySpeaking are: 1031=German 1033=English 1034=Spanish 1036=French 1040=Italian 1043=Dutch Also creates an MST file for the language you specify, such as 1036.MST.</td>
</tr>
<tr>
<td><code>EXTRACTFILES=&quot;c:\xyz&quot;</code></td>
<td>For installing Version 10 Service Pack 1 only. Indicates the directory where the extracted <code>.msi</code>/.<code>mst</code> files are to be written. Long path names containing spaces need to be in quotation marks escaped by having a backslash precede each quotation mark (<code>\</code>). This property is required to extract the <code>.msi</code> files. If the directory you specify does not exist, the installer creates it. Here is a sample command line to extract <code>.msi</code> files from a single executable: <code>setup.exe /a /s /v&quot;EXTRACTFILES=c:\temp\msifiles&quot;</code></td>
</tr>
<tr>
<td><code>TARGETDIR=&quot;C:\xyz&quot;</code></td>
<td>Use with administrative installations only. Indicates the full path to where to install the image of Dragon.</td>
</tr>
</tbody>
</table>
**Caution:** The first time you try any command line, you should not run it in Silent mode, because if you have neglected to provide required information, you then receive a GUI prompt for that information.

(The character that immediately follows the third slash is a lowercase L.) Next, you specify the extracted .MSI and .MST files in a command line to install Dragon. The next two examples show how these files are used running first setup.exe, then msiexec.exe.

**Step 2: Passing MST File to setup.exe to Install Dragon**

This sample command line launches setup in French and installs Dragon into the C:\Dragon directory:

```bash
setup /a /s /v"INSTALLDIR=\"C:\<full_path>\Dragon\" TRANSFORMS=1036.MST /qn
```

Alternative Step2: Passing MST File to msiexec.exe to Dragon

Before actually use the MST file you extracted in the previous step to install Dragon on the command line with msiexec.exe, you must install Visual C++ Runtime for Dragon, as outlined here.

1. Find the ISSetupPrerequisites/VCRuntime directory on the product DVD and open it. In the directory you find the vcruntime.exe and vcruntime_x64.exe files. (If you are installing Version 10 rather than Version 10.x, look in the ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5\} directory instead.)

2. Copy the vcruntime files to your server or to another accessible location. These .exe files install Visual C++ Runtime for Dragon. Run vcruntime.exe on each 32-bit machine where you intend to install Dragon and vcruntime_x64.exe on each 64-bit machine.

**Caution:** Do not attempt to extract the .msi file from either vcruntime.exe or vcruntime_x64.exe. Installing the Visual C++ Runtime for Dragon as part of an msiexec.exe command line installation of Dragon is not recommended and not supported.

3. After you have installed Visual C++ Runtime for Dragon, enter a command line like the following, which demonstrates how to use the .msi file you extracted earlier with setup.exe to do an administrative installation of the SDK Client Edition in German:

```bash
msiexec /a "D:\Dragon SDK Client Edition 10.msi" /i*v %TEMP%\dgnsetup.log /q
TRANSFORMS=1031.MST
```

The /q option runs the installation in Quiet mode.


**Installation using the Dragon installation process**

Perform the following steps to use the user interface of the Dragon installation process:

1. Insert the product DVD in the DVD drive. If the installation does not start, run setup.exe from the DVD.

2. Choose the Custom installation with appropriate languages and vocabularies.

3. Choose the following check boxes under Additional options to have additional dialog boxes pop up at the end of the installation, where you can make changes that affect all users dictating on this computer.
- Modify the application’s settings for all user profiles - Displays the Options dialog box at the end of the installation.

- Modify the administrative settings - Displays the Administrative Settings dialog box at the end of the installation, where you set up the Roaming User feature, where to backup your files, and who can modify commands/vocabularies.

- Formatting options - Displays Formatting dialog box at end of installation, where you apply uniform formatting to all documents dictated at this installation; for example, formats for dates, times, and phone numbers.

4. When the Options dialog box appears, select the default options that should apply to all client installations and click OK. This dialog box is where you set up all the options under the various tabs (Correction, Command, and so on). In Dragon Medical, you can also program custom actions into the buttons on the PowerMic I and PowerMic II microphones.

   **Note:** Settings under the Text-to-Speech tab are not saved. To include Text-to-Speech as a feature of your installation, work with options in Summary: MSI Options for Installing Dragon Features/Advanced Options.

   **Note:** At least one supported third-party indexing/search software should be installed on the system before you install Dragon, or the Enable Desktop Search commands check box will not only be unchecked, but will not be available to be checked. Dragon supports Google Desktop and Microsoft Vista Search.

5. When the Formatting dialog box appears, select formatting options to apply to all client installations and click OK.

6. When the Administrative Settings dialog box appears, if you want to set up Roaming users, set the options under Roaming User (to set the HTTP or HTTPS settings under the HTTP Settings or HTTPS Settings button, you must have either http:// or https:// in front of the network directory path); whether you have Roaming Users or not, set the options under Miscellaneous and Scheduled Tasks tabs and click Apply for each; then, when you have set all the settings, click OK.

7. Dragon has saved the configuration you created with running natspeak.exe in the nsdefaults.ini and roamingdef.ini files (the roamingdef.ini file is created only if you set up Roaming Users). You can find these .ini files under C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10. These .ini files are now considered customized files, because they now they contain the custom settings that will be applied to each of the DNS client installations you deploy. Retrieve the nsdefaults.ini and roamingdef.ini files and copy them to a directory where you can access them from the other client machines. (If you did not run natspeak.exe on the command line, you do not find a roamingdef.ini file; in that case, you can use a roaming.ini file from an existing installation whose settings you’d like to replicate. If you did not change the Network Settings, you do not need a roamingdef.ini or roaming.ini file at all.)
You are now ready to install the same configuration you just established here onto other machines.

**Note:** If you are installing Dragon on more than one client machine and over a network, you can use the same .ini files with the MSI Installer (msiexec). You also use SMS Server or another server-based program that pushes the installation out to several clients at once. Even if you are installing from a server, you should run through the initial installation before you carry out the administrative installation. Then, for more information on installing from a server, proceed to Overview of Pushing Client Installation from Server.

### Install the Same Configuration on Additional Machines

**Note:** If you chose Enable Desktop Search Commands on the Commands tab during the initial installation, you must install Google Desktop or Microsoft Vista Search before you install Dragon; otherwise, that option does not take effect.

1. Be sure you can access the .ini files you created in the previous procedure from the computer you will be installing on or copy the files to a local path on the client machine where you are about to install Dragon.

2. Be sure you have the Dragon serial number (or the group serial number, if you are installing Dragon to multiple computers on a network).

3. Be sure all mapped drives you plan to use are mapped on individual client machines where you are distributing the installation.

4. Install any pending Windows updates and reboot the machine.

5. Open a command line window (Start > Run cmd).

6. Insert the product DVD in the DVD drive and search the DVD for the path where the Dragon setup.exe is located.

7. On the computer where you are installing Dragon, to install the same configuration you created during the initial installation, enter the following on the command line (using the customized nsdefaults.ini file) of a single client. You pass the Dragon serial number for the SERIALNUMBER option and the full path to the nsdefaults.ini file using the DEFAULTSINI option (this line assumes no roaming users):

   ```
   setup.exe /s /v"SERIALNUMBER=#####-####-####-####-####
   INSTALLDIR="C:\<full_path>\Dragon10"
   DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
   /L*v C:\Logs\logfile.log
   ```

**Note:** The full path for the DEFAULTSINI setting uses escaped out quotation marks (preceded by a backslash) only when there are spaces in the full path.
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer

Caution: The first time you test any installation, you should pass /q rather than /qn so that if you have neglected to provide information about a setting that does not have a default, you receive a GUI prompt for that information.

8. If you entered a network address in the Network Directories box and set up HTTP or HTTPS settings in the Roaming tab of the Administrative Settings dialog during the initial installation, those settings are transferred to your client machines only if you include the ROAMINGUSERINI option, set to roamingdef.ini:

   setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR="C:\<full_path>\Dragon10"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v C:\Logs\logfile.log

You include the bolded portion of the above command lines so that if something goes wrong during the installation, you receive messages about it. You pass /L and a series of suboptions followed by a log file name to have the installation log errors and other messages related to the process. (You can send the log file to technical support should any issues arise.)

Note: You can also use the /qn option to install the product in Quiet mode, where no GUI or other messages appear. Another option, the /passive mode, runs the entire installation unattended, but displays a progress bar. However, the first time you run any installation command line, you should not use the /qn option, because turning off the GUI also turns off any messages that help you determine any problems with that command line. To use the /qn option, add it to the end of the command line:

   setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR="C:\<full_path>\Dragon10"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
/L*v C:\Logs\logfile.log /qn

Creating Custom Installation Using Microsoft Custom Install Wizard

If you are installing Dragon on a network, you can create a custom installation program using a set of tools available from Microsoft.

1. Download and install the tools
2. Run the wizard
You are then ready to use the custom installer to install the product.

**Installing the Microsoft Custom Installation Wizard**

The Microsoft Custom Installation Wizard is part of the Microsoft Office Resource Kit Tools. To install the Custom Installation Wizard:


2. After downloading OrkTools.exe, to install the tools, you either double-click the executable or select **Start > Programs > Microsoft Office Tools > Microsoft Office XP Resource Kit Tools**.

After you install the tool, you use its Custom Installation Wizard to create your custom installation. For details on using the wizard, proceed to **Modifying setup Properties for Custom Installation**.

**Modifying setup Properties for Custom Installation**

The following explains how to modify setup properties for a custom installation of *Dragon*. This example shows how to add to the installer configuration one of the many MSI options you can set for installing *Dragon*, the SERIALNUMBER property. (You can add any options available to MSI on the command line.)

1. Start the Microsoft Custom Installation Wizard by choosing **Start > Programs > Microsoft Office Tools > Microsoft Office XP Resource Kit Tools**, and then click **Custom Installation Wizard**. The **Custom Installation Wizard** screen displays:

   ![Custom Installation Wizard](image)

   **Welcome to the Custom Installation Wizard**

   - Use this wizard to create a Windows Installer transform (MST file) and customize your Microsoft Office installation when you deploy to users over the network.

   **Using this wizard, you can**:

   - Choose where to install Microsoft Office
   - Specify whether to remove previous versions
   - Set and disable feature installation states
   - Add a profile with default application settings
   - Add custom files, registry entries and shortcuts
   - Specify Office Security Settings
   - Customize default Outlook profile
   - Set other properties

   ![Custom Installation Wizard](image)
2. Click **Next**.

3. On the **Open the MSI File** page of the wizard, shown below, select the .MSI file you want to use to create a custom installation. The compiled .MSI file is located on your installation CD. The files are named:
   - *Dragon Medical*: Dragon NaturallySpeaking 10.msi

4. The following example uses Dragon NaturallySpeaking 10.msi.

![Microsoft Office Custom Installation Wizard](image)

5. Click **Next**.

6. Click **Yes** when you see the following message:

![Microsoft Office Custom Installation Wizard](image)

7. On the **Open the MST File** page of the wizard, select **Create a new MST file**.
8. Click **Next** to continue.

9. On the **Select MST File to Save** page of the wizard, select a file name and path for the MST file you are creating:

10. Click **Next**.

11. On the **Specify a Default Path and Organization** page, select the default path for the installation. By default, **Dragon** installs in:

    \Program Files\Nuance\NaturallySpeaking10.
12. Click Next.

13. On the Remove Previous Versions page, keep the default selections and click Next. This page applies only to Microsoft Office and does not affect the Dragon installation.

14. Click Next to keep all the defaults when you come to the Set Features Installation States page, where you select particular components to install. The illustration here shows some of the Medical vocabularies you might choose:
15. On the next several pages of the wizard, click **Next** on each, and proceed until you reach the **Modify Setup Properties** page. All the pages in between apply only to Microsoft Office or do not affect the *Dragon SDK Client Edition* installation.

- Customize Default Application Settings page
- Change Office User Settings page
- Add/Remove Files page
- Add/Remove Registry Entries page
- Add, Modify, or Remove Shortcuts page
- Identify Additional Servers page
- Specify Office Security Settings page
- Add Installations and Run Programs page
16. Use the **Modify Setup Properties** page, shown below, to add, modify, and set the MSI options of your custom installation.

17. Click the **Add...** button to display the **Add/Modify Property Value** dialog box, where you modify the MSI installation options. In this example, we add and set the **SERIALNUMBER** option.

18. In the following **Add/Modify Property Value** page, enter the new property name **SERIALNUMBER** and a valid serial number, then click **OK**:

19. Note that the **Modify Setup Properties** page re-displays with the updated information. For example:
20. Continue adding or modifying other MSI options that apply for your environment. Once you are done, click **Next**.

21. On the **Save Changes** page, click **Finish**.

22. When the **Custom Installation Wizard** page appears, click **Exit**. This screen displays the location of Windows Installer transform (.MST file) that you created.

After you save changes, you can use the resulting .MST file to manage an installation through a Group Policy in Active Directory Services.

You are now ready to use the custom installer you created to install the product.

**Installing the Citrix Client Update using MSI installer**

*Dragon* includes support for deploying and running *Dragon* on a Citrix server. To install with Citrix, be sure you install Visual C++ Runtime for *Dragon* and publish it as an application in Citrix before you install *Dragon*. You can use the Visual C++ Runtime for *Dragon* installation portion of the admininstall.bat file to carry out the installation and there are no special options for Citrix.

If you intend to dictate from the Citrix client, before you run *Dragon* for the first time from that client, you must run the Citrix Client Update.
You can use the native Windows Installer (MSI) included with Dragon to install the Citrix Client Update during an MSI installation. The compiled Citrix Client Update.MSI file (vddnspatch.msi) is located on your installation CD. There are no options for vddnspatch.msi. See the Dragon Administrator’s Guide Help file for more information on installing and using Dragon on a Citrix server.

### Installation using the Dragon command line

Perform the following steps to use the Dragon command line:

1. Open a command line window (Start > Run and enter cmd).

2. Insert the product DVD in the DVD drive, search the DVD for the path where the Dragon setup.exe is located, and switch directories to the path on the product DVD where the Dragon setup.exe is located.

3. Enter the following command line to install Dragon on this initial machine (ignore any errors you receive regarding the serial number, as it is not required for this in initial installation, unless you plan to dictate later):

   ```
   setup.exe /s /v"INSTALLDIR=c:\Dragon10 /L*v C:\Logs\logfile.log /qn"
   ```

   The /s option sets the silent option for the every .exe that setup.exe provides a wrapper for, including the vcruntime.exe service that setup.exe automatically installs for you, so that no GUI pops up. By contrast the /qn inside the quotation marks after /v sets the silent option for the Dragon installation.

   The /v option introduces any series of msiexec.exe options you want to pass to the Windows installer, all enclosed in quotation marks after the /v, with no space allowed between the /v and the opening quotation mark. Among the options inside the quotation marks are:

   - INSTALLDIR — Indicates the full path to where you want Dragon installed
   - /L*v — (either upper or lowercase) Indicates the log file where messages about the installation should be written
   - /qn — (Quiet mode—also called Silent mode—no GUI) Turns off the Dragon GUI

**Caution:** The first time you test any installation, you should not run it in Silent mode, because if you have neglected to provide information about a setting that does not have a default, you receive a GUI prompt for that information. You should initially pass the /L*v option because it runs the entire installation GUI. When the Welcome dialog appears, you can stop and look into the log file., where you can search for Command line to verify that all command line parameters are being incorporated. The line you find will have this format:

   ```
   MSI (c) (##:##)[##:##:##:###] Command Line: <OPTION>=<value>
   <OPTION>=<value> ...
   ```

   The above command line is to install the default language, the one that matches the operating system language. For changes required to install another language, see Silent Installation with Language Other Than US English.
Logging errors and other messages

Suboptions for /L indicate the types of messages to send to the log:

<table>
<thead>
<tr>
<th>Suboption</th>
<th>Type of Message to Log</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>Status messages</td>
</tr>
<tr>
<td>w</td>
<td>Nonfatal warnings</td>
</tr>
<tr>
<td>e</td>
<td>All error messages</td>
</tr>
<tr>
<td>a</td>
<td>Start up actions</td>
</tr>
<tr>
<td>r</td>
<td>Action-specific records</td>
</tr>
<tr>
<td>u</td>
<td>User requests</td>
</tr>
<tr>
<td>c</td>
<td>Initial UI parameters</td>
</tr>
<tr>
<td>m</td>
<td>Out-of-memory or fatal exit information</td>
</tr>
<tr>
<td>o</td>
<td>Out-of-disk-space messages</td>
</tr>
<tr>
<td>p</td>
<td>Terminal properties</td>
</tr>
<tr>
<td>v</td>
<td>Verbose output</td>
</tr>
<tr>
<td>x</td>
<td>Extra debugging info (Windows Server 2000 only)</td>
</tr>
<tr>
<td>+</td>
<td>Append to existing log file</td>
</tr>
<tr>
<td>*</td>
<td>Wildcard. Log all info except v and x options</td>
</tr>
<tr>
<td>*vx</td>
<td>Log all info including v and x options</td>
</tr>
</tbody>
</table>

Running natspeak.exe to Set Options

When the installation completes, you then set up the configuration on this initial machine by running natspeak up to three times, in the steps that follow. All steps are optional; by skipping a step, you are choosing to accept the default values for the options applicable for associated options.

1. On a workstation PC where Dragon is installed, close Dragon if it is running.

2. From the Windows Start menu, select All Programs > Accessories > Command Prompt to open the Command Prompt window. For example:
3. Switch directories to:

   \<install-directory>\Program (default is C:\Program
   Files\Nuance\Naturally Speaking10\Program)

4. Enter the following natspeak command:

   natspeak.exe /setdefaultsoptions

5. When the Options dialog box appears, select the default options that should apply to all
   client installations and click OK. This dialog box is where you set up all the options under
   the various tabs (Correction, Command, and so on). In Dragon Medical, you can also
   program custom actions into the buttons on the PowerMic I and PowerMic II
   microphones.

   Note: Settings under the Text-to-Speech tab are not saved. To include Text-to-
   Speech as a feature of your installation, work with options in Summary: MSI
   Options for Installing Dragon Features/Advanced Options.

   Note: At least one supported third-party indexing/search software should be
   installed on the system before you install Dragon, or the Enable Desktop Search
   commands check box will not only be unchecked, but will not be available to be
   checked. Dragon supports Google Desktop and Microsoft Vista Search.

6. Enter another natspeak command:

   natspeak.exe /setdefaultformattingoptions
7. When the **Formatting** dialog box appears, select formatting options to apply to all client installations and click **OK**.

For example (**Dragon Medical**):

8. Enter a final natspeak command:

   `natspeak.exe /setdefaultadministrativeoptions`

9. When the dialog box appears, if you want to set up Roaming users, set the options under Roaming User (to set the HTTP or HTTPS settings under the HTTP Settings or HTTPS Settings button, you must have either http:// or https:// in front of the network directory path); whether you have Roaming Users or not, set the options under Miscellaneous and Scheduled Tasks tabs and click Apply for each; then, when you have set all the settings,
10. Dragon has saved the configuration you created with running natspeak.exe in the nsdefaults.ini and roamingdef.ini files (the roamingdef.ini file is created only if you set up Roaming Users). You can find these .ini files under C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10. 

Note: If you do not find the nsdefaults.ini file in the subfolders under All Users, navigate to All Users.WINDOWS, or administrator, or any other Documents and Settings subfolders for other users on this workstation until you locate the nsdefaults.ini file. It's possible that the workstation was configured so that a different “user” folder is the default for application data for Nuance and other applications.

These .ini files are now considered customized files, because they now they contain the custom settings that will be applied to each of the DNS client installations you deploy. Retrieve the nsdefaults.ini and roamingdef.ini files and copy them to a directory where you can access them from the other client machines. (If you did not run natspeak.exe on the command line, you do not find a roamingdef.ini file; in that case, you can use a roaming.ini file from an existing installation whose settings you’d like to replicate. If you did not change the Network Settings, you do not need a roamingdef.ini or roaming.ini file at all.)

11. When you have located the nsdefaults.ini file, verify that your option settings have been changed. Double-click the nsdefaults.ini file to open it in a text editor. You should see values defined for the options you changed.

Example: If the Capitalize ‘allergy’ and ‘allergies’ as ‘ALLERGY’ and ‘ALLERGIES’ option has been turned on, the nsdefaults.ini file contains this statement:

```
; (ALLERGY_CAP) capitalize "allergy" and "allergies" as "ALLERGY" and "ALLERGIES"
ALLERGY_CAP=1
```

12. Include the newly created nsdefaults.ini file in your MSI package to distribute the file to all user workstations where Dragon is installed.

For more on natspeak.exe command line options, refer to natspeak Command Line Switches. You are now ready to install the same configuration you just established here onto other machines.

Note: If you are installing Dragon on more than one client machine and over a network, you can use the same .ini files with the MSI Installer (msiexec). You also use SMS Server or another server-based program that pushes the installation out to several clients at once. Even if you are installing from a server, you should run through the initial installation before you carry out the administrative installation. Then, for more information on installing from a server, proceed to Overview of Pushing Client Installation from Server.
Natspeak.exe command line reference

You can use command line options to modify the way that Dragon Medical starts up. These switches are used in the following syntax:

natspeak /switch

where /switch is one or more switches from table below (each switch is a single word without spaces or hyphens):

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>/diagnose</td>
<td>Runs Dragon in diagnostic mode to output info to Dragon.log file and exits.</td>
</tr>
<tr>
<td>/user &lt;user&gt;</td>
<td>Automatically loads the user.</td>
</tr>
<tr>
<td>/topic &lt;topic&gt;</td>
<td>Automatically loads the topic in Medical editions only).</td>
</tr>
<tr>
<td>/quick</td>
<td>Runs Dragon in QuickStart mode, a mode that starts Dragon without loading a user or any speech models on startup of your computer.</td>
</tr>
<tr>
<td>/SetDefault Options</td>
<td>Options Displays the Options dialog box at the end of the installation.</td>
</tr>
<tr>
<td>/SetDefault Administrative</td>
<td>Options Displays the Administrative settings dialog box at the end of the installation.</td>
</tr>
<tr>
<td>/SetDefault Formattings</td>
<td>Options Displays the Formatting dialog box at the end of the installation.</td>
</tr>
</tbody>
</table>

Other Actions You Can Take on Command Line

Here are other (optional) actions you can take on the command line as part of a silent installation:

Additional Options for Silent Installations

- Modifying the Default Installation Directory
- Configuring Installation of Product Updates
- Suppressing Reboot of Machine After Installation
- Setting Dragon to Run in QuickStart Mode
- Installing Same Roaming User Configuration on Additional Machine(s)
- Silent Installation with Language Other Than US English

Additional Options with Extensive Settings for Silent Installations

- Revising Day/Time of Scheduled Tasks (Optional)
- Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional)
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer

Modifying Default Installation Directory

If you want to set an installation directory other than the default, pass INSTALLDIR="<full path to install>" on the command line (note that the quotation marks are required only if you have spaces in the path):

```
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10" /L*v C:\Logs\logfile.log /qn"
```

*iNote: If the installation directory does not have spaces, note how the INSTALLDIR directory is designated in the command line:

```
setup.exe /v"INSTALLDIR=C:\Dragon10 ADDLOCAL=ALL"
```

If the installation directory has space(s), it is surrounded in quotation marks that are escaped out by having backslashes precede them (shown in bold):

```
setup.exe /v"INSTALLDIR="C:\Naturally Speaking 10" ADDLOCAL=ALL"
```

*Caution: The first time you try any installation, you should not run it in Silent mode, because if you have neglected to provide information about a setting that does not have a default, you receive a GUI prompt for that information.

Configuring Installation of Product Updates

If you want the individual client machine to download product updates to Dragon over the web, you would set the PRODUCTUPDATEFLAG option to 1 (option checks the check box). If you prefer to install the updates on the severs and later distribute them to client machines, set this option to 0 (unchecks the check box). If your enterprise does not install service packs provided by Nuance, Nuance recommends you set this flag to -1:

```
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10"
PRODUCTUPDATEFLAG=-1 /L*v C:\Logs\logfile.log /qn"
```

Suppressing Reboot of Machine After Installation

To suppress rebooting of the machine after installation of Dragon completes, you can pass Microsoft’s REBOOT option set to ReallySuppress. Using this option also suppresses the reboot sometimes required by the installation of Visual C++ Runtime for Dragon, which setup.exe installs in the background. Using this option is highly recommended if you are executing a silent installation (But if system updates are pending, rebooting is required for DNS to work normally.

REBOOT=ReallySuppress

The altered command line would look like this:

```
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10" /qn
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress /L*v C:\Logs\logfile.log /qn"
```
Setting Dragon to Run in QuickStart Mode

To set Dragon to QuickStart mode and create a shortcut for Dragon in the Windows Startup folder, set the QUICKSTART option to 1:

```
QUICKSTART=1
```

The altered command line would look like this:
```
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10\"
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress QUICKSTART=1
/L*v C:\Logs\logfile.log /qn"
```

Installing Same Roaming User Configuration on Additional Machine(s)

Use the roamingdef.ini file you created during the initial installation as the input for the ROAMINGUSERINI option in this format (be sure to use the full path to the file when you pass the option):
```
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
```

The default is empty (no .ini file will be used). Include the ROAMINGUSERINI option in the installation command line:
```
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10\"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v C:\Logs\logfile.log /qn"
```

The example above assumes that the full path has spaces in it, so it has escaped out quotation marks around the option value. After you have completed the installation, verify that all options are correctly set on the client machine.

Silent Installation with Language Other Than US English

By default Dragon installs in the language that matches the language of your operating system; to install it in another language, you must purchase that kind of license, then use the /L option followed by a numeric language ID, outside the quotation marks:
```
setup.exe /L1031 /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR="C:\<full_path>\Dragon10\"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini" /qn"
```

Revising Day/Time of Scheduled Tasks (Optional)

This section describes how to modify the schedule for Dragon tasks to later take place on each dictation client machine by passing particular options in a command line installation. This section is a continuation of Installation using the Dragon command line. When you finish this section, you might want to proceed to Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional).

Note: You take the following actions on the client machine to install Dragon on client PCs, not on the machine where you installed the initial installation and configured default option settings for users.

You can include an additional option on the command line to indicate you want on any or all
of the following tasks carried out on a particular schedule:

- **Acoustic model optimization (ACO)** — This task optimizes the acoustic files used to recognize words that the user trains and speaks. You can set a particular date and time for this optimization to occur. When a speaker is new to *Dragon*, you might want to run the optimization more often, after the speaker has worked with *Dragon* for a while.

- **Language model optimization (LMO)** — This task optimizes the language model (vocabulary files) used to help recognize words that the open user speaks. The model incorporates data from the user’s speech into the language model he or she is using, ultimately customizing the model for that user.

- **Data Collection (DC)** — This task automatically collects data that helps improve *Dragon*’s ability to recognize speech. You can choose to allow this data to be sent back to Nuance over the Internet on a particular schedule or choose not to send the data. This process does not collect your personal information.

You turn on/off the above tasks and set the schedule for those you turn on by passing an option called PERIODIC_TASK to the MSI installer. You set PERIODIC_TASK to a string containing short acronyms for the types of tasks, aco | lmo | dc, separated by vertical bars. If you do not pass the acronym for the feature, that feature is set to its default.

After the acronyms for the tasks to schedule, the string for PERIODIC_TASK should include the administrator login and password, then the schedules that correspond to the acronyms, in the order that they occur in the string. The schedules use three-letter weekday abbreviations and 24-hour time with two digits for the hour and two for the minute, separated by a colon. The two schedules are separated by vertical bars and presented in the same order as their corresponding acronyms. While the acronyms for the tasks are separated from each other by vertical bars, semicolons separate the group of tasks from the admin user name, password, and group of schedules.

For instance, to retain the default schedule for data collection and modify schedules for acoustic model optimization to Mondays at 1 AM and language model optimization to Mondays at 6 AM, you would set PERIODIC_TASK as follows:

```
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
```

An installation command line including this task setting option might look like the following:

```
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
/L*v C:\Logs\logfile.log /qn"
```

For more information on the PERIODIC_TASK option, refer to MSI Options for Roaming User, Tuning, and Data Collection Setup.

**Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional)**

This section describes how to enable Roaming Users in a command line installation and is a continuation of Installation using the Dragon command line.

**Note:** You take the following actions on the client machine where you want to install *Dragon*, not on the machine where you carry out the initial installation.
Installing only particular vocabularies locally, others on-demand

When you install *Dragon Medical* on a client machine as outlined in [Installation using the Dragon command line](#), by default you install all the available vocabularies locally.

If you do not want all of those vocabularies to be installed locally, but to instead have them installed only if/when a user attempts to deploy a particular vocabulary, you can indicate that fact on the installation command line by adding the ADDLOCAL option and setting it to the names of the vocabularies to install locally. For example, say you want to do a partial installation of *Dragon Medical* and you only want to install the General Medical vocabulary and the Radiology vocabulary, you set ADDLOCAL to natspeak,ENUMedical,ENURadiology and the command line would appear as follows (natspeak must be in the setting of ADDLOCAL, unless you set ADDLOCAL to ALL; otherwise, the installation fails):

```
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress ADDLOCAL=natspeak,ENUMedical,ENURadiology
/L*v C:\Logs\logfile.log /qn"
```

**Note:** There must not be any spaces between the arguments specified for ADDLOCAL.

If you want other vocabularies to be available, you set ADDLOCAL to ALL and set the ADVERTISE property to a list of additional vocabularies. The command line might look like the following:

```
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10"
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress ADDLOCAL=ALL
ADVERTISE=ENUCardiology,ENUEmergency,ENUGastroenterology
/L*v C:\Logs\logfile.log /qn"
```

Separate the features/vocabularies for ADDLOCAL with commas, but do not put spaces in the list. The names you must use for the vocabularies consist of a prefix for the language, then the name of the vocabulary, such as ENU for English and Cardiology to form ENUCardiology. For a list of the exact names for features/vocabularies you can assign to ADDLOCAL or ADVERTISE on the command line, refer to [MSI Options for Installing Dragon Features/Advanced Options](#).

**Installing Text-to-Speech feature**

To install Text-to-Speech locally, you would include the feature in the list of features for ADDLOCAL; for instance, you would add TTSENX for Text-to-Speech in English:

```
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10"
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress ADDLOCAL=TTSENX,natspeak,ENUMedical
/L*v C:\Logs\logfile.log /qn"
```

For more information, see these summary topics:

- [MSI Options Specific to Dragon](#)
- Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties
- [MSI Options for Roaming User, Tuning, and Data Collection Setup](#)
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer

Upgrading Your Dragon Installation from the Command Line

There are two command line upgrade scenarios:

- Major Upgrade—Upgrading from Version 9 or 9.x to Version 10 and 10.x
- Minor Upgrade—Upgrading from Version 10 and 10.x to a higher Version 10.x

All of these types of upgrades can either display the GUI or be silent (not display the GUI), except the minor upgrade, which does not support the silent option. You will not be able to upgrade users with the command line installation. For more information on upgrading roaming users, see the section below. If your users are not roaming, you run the Upgrade User Wizard after installation completes.

Upgrading Roaming Users

Before you upgrade, if you have Roaming User files, you must upgrade Roaming User files in the Roaming User directory. Then you can upgrade Dragon on the client machines and the Roaming User files become available as soon as the upgrade is complete.

Background on Roaming User Files

Before you upgrade Roaming User files from Dragon Medical Version 9.x to Version 10 or 10.x, you need to recall some basics about how the Roaming User feature works: Each Dragon user has a master roaming user file that can be opened from any networked computer where Dragon is installed. The master roaming user files are stored on a network location. When a master roaming user file is opened from that central network location, Dragon transfers a copy of that user to the Local Roaming User file on the computer where the user is dictating.

Recommended Approach

Since the Local Roaming user file is a copy of the user data taken from the master roaming user file, it does not make any sense to directly upgrade the Local Roaming User when you upgrade the local Dragon installation. Instead, you should install Dragon 10 or 10.x directly on the network machine where the Version 9.x Master Roaming user files are located and upgrade those Master Roaming user files directly. After you have upgraded the master roaming user files, you can then proceed to upgrade end-user systems that deploy the Roaming User feature.

Notes:

- Even though the Dragon 10 or 10.x User Upgrade Wizard supports both mapped drives and UNC paths, Nuance strongly recommends that you upgrade your Master Roaming User files on a drive on a machine where Dragon 10 is locally installed. Nuance does not recommend that you upgrade your Master Roaming user files across a network to either a mapped drive or UNC path; upgrading over a network will take a undetermined length of time. In addition, the User Upgrade Wizard does not support upgrading users over an HTTP connection.
- Upgrading master roaming user files to Version 10 or 10.x leaves the 9.x master roaming user files unchanged, so that the users in your network can run Dragon Version 9.x while you plan your upgrade.
Step-by-Step Process for Upgrading Roaming Users

1. Plan to upgrade the master roaming user files at a time when they are not being opened by end users, for example during the night or on a weekend. Nuance recommends that you back-up your users’ speech files before upgrading them.

2. Install *Dragon* 10 on the machine where the Version 9.x Master Roaming user files are located. If that is not possible, Nuance recommends that you install *Dragon* 10 on a separate machine where you will perform the upgrades.

   OR

If you are unable to install *Dragon* where your Version 9.x Master Roaming user files are located, Nuance recommends that you:

- Install *Dragon* 10 on a separate machine where you will perform the upgrades.
- Copy Version 9.x Master Roaming user files from their network location to the machine where *Dragon* 10 is installed.
- Upgrade the Version 9.x Master Roaming user files on the machine where *Dragon* 10 is installed.
- Copy the upgraded Version 10 Master Roaming user files to a network accessible directory on the original network location.

   **Note:** If during the upgrade installation you are prompted to Upgrade existing speech files to work with this installation, you can ignore the option, as it does not affect roaming users. You manually run the User Upgrade Wizard later.

3. On the end-user systems where the users dictate, save and close any open users on each *Dragon* Version 9.x system that uses the Roaming User feature.

   **Note:** If there is no time when all of your roaming user files are not used (for example, if you are supporting a hospital where physicians use Dragon during a night shift), you can upgrade different groups of roaming user files at different times.

4. On the central network location that stores Version 9.x master roaming user files, back up the master roaming user files to a separate location by using any system backup utility that is implemented at your facility.

5. On the central network location that stores Version 9.x master roaming user files, create a new directory to store the upgraded *Dragon* 10 or 10.x Master Roaming User files.

   **Note:** Always be sure your upgraded users are in a location different from that of current users, because if end users see two versions of each user file when they try to open a user, they will be confused. Nuance recommends that you keep users from each version in distinct locations.
6. If you did not install Dragon 10 on the machine where the Version 9.x Master Roaming user files are located, create a directory on the local machine where Dragon 10 is installed to hold all the Master Roaming user files you plan to upgrade and copy the Version 9.x Master Roaming User files from the network location to this directory.

7. On the administrator system from where you will upgrade the Master Roaming User files to Version 10, start Dragon Version 10 and make sure the Roaming User feature is turned off. To turn off the Roaming User feature:

- Close any open users.
- Click Tools > Administrative Settings on the menu to display the Administrative Settings dialog box.
- On the Roaming tab, make sure Enable is not selected.


9. On the machine where both your Version 9.x Master Roaming files and Dragon 10 are installed, select Start > Programs > Dragon NaturallySpeaking 10 > Dragon NaturallySpeaking Tools > Upgrade Users. The User Upgrade Wizard opens:

![User Upgrade Wizard](image)

Note: If you did not turn off the Roaming User feature in the Administrative Settings dialog box before attempting to start the User Upgrade Wizard, you receive an error message stating that you cannot upgrade a Roaming User. If you
10. On the Select Users to Upgrade page, click Add... to select the location of the Version 9.x Master Roaming user files. The Select Users to Upgrade page now displays a list of users in the selected directory:

![User Upgrade Wizard](image)

You can continue to use the Add... button to add users from other local locations or use the Remove button to remove specific users. Click Next to continue.

11. On the Choose Destination page, in the Destination for upgraded user files text box, choose the local location you previously created that will contain the upgrade Version 10 master roaming user files. If you do not see the location you want, you can click the Browse button, find the correct location, and click Next.
12. The Upgrade Users page displays the number of users that the wizard is prepared to upgrade.

13. Click Begin to start the upgrade process. The upgrade process can take 2-3 minutes or more per user, depending on the speed of your system and your network. You can click Stop at any time to interrupt this process. The upgrade process creates new master roaming user files in the destination you selected.

14. Click Finish to complete the upgrading process and exit the User Upgrade Wizard.

   Note: The User Upgrade Wizard renames each Version 10 master roaming user file as follows: <name> (v10). For example, a Version 9.x Master Roaming user file named roaminguser1 will be copied and named roaminguser1 (v10) when upgraded to Version 10. The Version 9.x Master Roaming user file named roaminguser1 remains unchanged.

15. (Optional) If you were unable to install Dragon where your original Master Roaming user files were located and you copied those files to another machine where Dragon 10 was installed, copy the upgraded Version 10 Master Roaming user files back to the new network-accessible directory that you created to store them.

16. Since the User Upgrade Wizard leaves your Version 9.x master roaming user files unchanged and in their original network location, your Version 9.x systems can continue to use the Roaming User feature until you upgrade those installations to Version 10 following the steps under Major and Minor Upgrades: Silent Upgrade, being sure to have the configuration include having the Roaming Users feature enabled and the correct path
to the upgraded roaming users in the Network Directories settings.

17. Run Dragon on the end-user system and open a user.

Major and Minor Upgrades: Silent Upgrade

To upgrade from Dragon Version 9 to Dragon Version 10 or 10.x, you can use either msiexec.exe or setup.exe. You can carry out this installation with a GUI or silently. The procedure presented here shows upgrading silently using msiexec.exe.

Overview of Silent Upgrade

If your environment requires that you perform a silent installation and use msiexec.exe, rather than setup.exe, take these high-level actions in this order:

- Uninstall the older version of Dragon.
- Version 10 only: Uninstall the older version of Visual C++ Runtime for Dragon.
- Install the new version of Visual C++ Runtime for Dragon. Note that there are two version of vcruntime.exe, one for 32-bit Windows and another for 64-bit Windows. Use the appropriate version for your enterprise.
- For major upgrades only: Perform an initial installation of the new version of Dragon on a single machine and establish the configuration you want to use by calling natspeak.exe on the command line and passing it these options:
  - /setdefaultoptions
  - /setdefaultformattingoptions
  - /setdefaultadministrativeoptions

  When you run the Dragon command line installation silently, the msiexec.exe installer automatically retains user speech files from the previous version. Later individual users can upgrade their local (but not Roaming User) speech files when they start Dragon. (For updating Roaming Users, see Before You Upgrade.)

GUIDs for uninstalling

The table below lists GUIDs that you pass to the /x option of msiexec for each version of Dragon and Visual C++ Runtime for Dragon:

<table>
<thead>
<tr>
<th>Prod &amp; Vers.</th>
<th>GUID to pass with /x option</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNS V10 and 10.x</td>
<td>E7712E53-7A7F-46EB-AA13-70D5987D30F2</td>
</tr>
<tr>
<td>DNS V9 and 9.x</td>
<td>DDDD90B2-80F2-413A-8A8E-38C5076A7DBA</td>
</tr>
<tr>
<td>VC-Runtime 32-bit</td>
<td>4A5A427F-BA39-4BF0-9A47-9999FBE60C9F</td>
</tr>
<tr>
<td>VC-Runtime 64-bit</td>
<td>4A5A427F-BA39-4BF0-9A47-7777FBE60C9F</td>
</tr>
</tbody>
</table>

Step-by-Step Upgrade Process

You must follow these steps to set options for your users:
1. If you are upgrading from a previous version of Dragon, copy the nsdefaults.ini and roamingdef.ini files to a central location so they can accessed later.

2. Open a command line window (Start > Run and enter cmd).

3. Uninstall Dragon Version 9 with msiexec.exe by passing the installer the /x option followed by the old version’s GUID and the /qn option to turn off any GUI.

   The correct GUID for each Version you can upgrade to Version 10 or 10.x on the command line is shown in the adjacent table and the example below uses the Version 9.x GUID:

   ```
   msiexec /x \{DDDD90B2-80F2-413A-8A8E-38C5076A7DBA\}
   /L*v "C:\updatelog.log" /qn
   ```

   msiexec automatically retains user speech profiles when you use the silent option.

   Caution: The first time you try any upgrade, you should not run it in Silent mode, because if you have neglected to provide required information, you then receive a GUI prompt for that information.

4. For upgrading from Version 9.x, skip this step. If you are upgrading from Version 10 or 10.x (minor upgrade), uninstall the old version of Visual C++ Runtime for Dragon with msiexec.exe by passing the installer the /x option followed by the old version’s GUID and the /qn option to turn off any GUI. The example below shows uninstalling the 32-bit Visual C++ Runtime for Dragon:

   ```
   msiexec /x \{4A5A427F-BA39-4BF0-9A47-9999FBE60C9F\}
   /L*v "C:\updatelog.log" /qn
   ```

   To uninstall the 64-bit version, use the alternative GUID shown in the adjacent table.

5. Be sure you have the Dragon serial number (or the group serial number, if you are upgrading Dragon on multiple networked computers).

6. Be sure all mapped drives you plan to use are mapped on individual client machines where you are distributing the upgrade.

7. Install any pending Windows updates on clients and reboot as needed before continuing.

8. Insert the product DVD in the drive and search the DVD for the path where the Dragon setup.exe is located.

9. Install the new version of Visual C++ Runtime for Dragon by entering the full path to vcruntime.exe on a 32-bit system or vcruntime_x64.exe on a 64-bit system:

   ```
   ISSetupPrerequisites\VCRuntime\vcruntime.exe /S /v"qn /l*v %TEMP%\vcruntime.log"
   ```

   OR
If you are installing Version 10 rather than Version 10.x, you have only the 32-bit version and use a slightly different path:

```
ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5}\vcruntime.exe /S
/v"qn /l*v %TEMP%\vcruntime.log"
```

10. If you are performing a minor upgrade, skip this step. If you are performing a major upgrade from Version 9.x, perform an initial installation on a single machine where you configure the settings of user options, formatting options, and administrative settings. You can follow the instructions in Install the Same Configuration on Additional Machines under Installation using the Dragon command line.

11. Be sure you can access the .ini files from the old installation (minor upgrades) or the .ini files you just created in the initial installation (major upgrades) from all computers you will be upgrading. (Or copy the files to a local path on the client machine where you are about to upgrade.)

12. For a major upgrade, install the new version of Dragon with msiexec.exe by passing the installer the /i option followed by the name of the Dragon .msi file and options like those shown in the sample below:

```
msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-## REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\Dragon10"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
REMOVEOLDPROD=1 /L*v "C:\logfile.log" /qn
```

To ensure that the entire old version of the product is removed, you pass REMOVEOLDPROD=1 (major upgrades only, not minor upgrades) so that the process removes the old version of Dragon before installing the new. In addition, you should be sure to provide the full path to each .ini file you are using.

13. For a minor upgrade, install the new version of Dragon with msiexec.exe the same way as you would the major upgrade, only passing both REINSTALL or REINSTALLMODE options, as shown in the sample below. Here REINSTALL is set to ALL and REINSTALLMODE is set to vemus, where /v indicates to reinstall from the source (reupdating cache), e indicates to install the newer file if one is available, mu means to rewrite the registry settings, and s means to reinstall all shortcuts and recache all icons. For more information on the REINSTALL and REINSTALLMODE settings, refer to MSI Options for Installing Dragon Features/Advanced Options.

Here is a typical minor upgrade installation line:
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer

msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\Dragon10"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
REINSTALL=ALL REINSTALLMODE=vemus
/L*v "C:\logfile.log" /qn

⚠️ Caution: If you do not pass the REINSTALL and REINSTALLMODE options, the minor upgrade will fail.

Using setup.exe for Upgrades

When installing both major and minor upgrades, the setup.exe installer automatically installs Visual C++ Runtime for Dragon before installing Dragon. Although the upgrade does not migrate forward the configuration and roaming user settings from the earlier version, you can reuse the nsdefaults.ini and roamingdef.ini files you used to install Version 10. You can also create new .ini files or update existing ones. When you run setup.exe with a GUI to install a minor upgrade, setup.exe can detect when a previous version of Dragon exists on a target machine. Once it detects a previous version, setup.exe runs the rest of your installation in minor upgrade mode, automatically overwriting older files with newer files and adding any missing files.

Using setup.exe for Silent Upgrades

If you are upgrading a previous version of Dragon, you must use the REINSTALL=ALL option and REINSTALLMODE set to the suboptions that indicate which files to reinstall, usually either REINSTALLMODE=vamus or REINSTALLMODE=vemus. If you did not originally install in the default location, the INSTALLDIR option is also required. Here is the command line using setup.exe:

To upgrade silently with setup.exe, you pass the /s option, then pass REINSTALL or REINSTALLMODE options:

setup.exe /s /v"/i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\\Dragon10"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
REINSTALL=ALL REINSTALLMODE=vemus
/L*v C:\logfile.log /qn"

Step-by-Step Command Line Installation with msiexec.exe

Another way to install Dragon from the command line on several dictation client machines is to use the msiexec.exe program from Microsoft. You are required to use msiexec.exe instead of setup.exe if you are installing Dragon from a server across a network to a single or multiple machines.
In the sections that follow, you carry out these two tasks:

- Install *Dragon* on Initial Machine and Establish Configuration
- Install Same Configuration on Additional Machine(s)

### Finding the MSI Installer on the Dragon DVD

The compiled *MSI* file is located on your installation DVD. The files for each edition are named:

- *Dragon Medical*: Dragon NaturallySpeaking 10.msi

You can double click on one of these .msi files to start the InstallShield Wizard; however, to instead take advantage of available command line options, you can pass the file name as the application to install to the `msiexec.exe` command using the `/i` option:

```
msiexec.exe /i "Dragon NaturallySpeaking10.msi"
```

### Install Dragon on Initial Machine and Establish Configuration

Follow the steps outlined under Step-by-Step Command Line Installation with setup.exe. Then return here and continue with the next section to install the same configuration on individual client machines using msiexec.exe instead of setup.exe.

### Install Same Configuration on Additional Machine(s)

If you chose Enable Desktop Search Commands on the Commands tab during the initial installation, you must install Google Desktop or Microsoft Vista Search before you install *Dragon*; otherwise, that option does not take effect.

1. Be sure you can access the .ini files you created in the previous procedure from the computer you will be installing on or copy the files to a local path on the client machine where you are about to install *Dragon*.

2. Be sure you have the *Dragon* serial number (or the group serial number, if you are installing *Dragon* to multiple computers on a network).

3. Be sure all mapped drives you plan to use are mapped on individual client machines where you are distributing the installation.

4. Install any pending Windows updates/reboot the machine.

5. Open a command line window by selecting Start > Run and entering cmd.

6. Insert the product DVD in the DVD drive and search the DVD for the path where the *Dragon* setup.exe is located.

7. In the command window, switch to the ISSetupPrerequisite\VCRuntime\ directory inside the directory of the executable for *Dragon*. (If you are installing Version 10, rather
than Version 10.x, the path to switch to is ISSetupPrerequisite\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5}.

8. On the command line, run the installation of Visual C++ Runtime (requires 4.08 MB of disk space to install):

    vcruntime.exe

The Choose Setup Language dialog box appears asking you to select a language for the installation. After you select the language, an initialization GUI briefly displays, then the InstallShield wizard pops up. To disable the dialog box that requests the language, pass the /S option (see more options below). To install vcruntime.exe without seeing either the Choose Language Setup dialog or the InstallShield wizard, you should execute the command line shown here for 32-bit Windows:

    vcruntime.exe /S /v"/qn /l*v %TEMP%\vcruntime.log"

Or the command line shown here for 64-bit Windows:

    vcruntime_x64.exe /S /v"/qn /l*v %TEMP%\vcruntime.log"

Caution: The first time you try any installation, you should not run it in Silent mode, because if you have neglected to provide required information, you then receive a GUI prompt for that information.

9. On your product DVD, locate the compiled .msi file for the edition of Dragon you want to install and switch to that directory.

10. Retrieve the customized nsdefaults.ini and roamingdef.ini files from the computer where carried out the initial installation.

11. To install Dragon, enter the following command line, using the /i option also using the /qn option to install the product in Quiet mode, where no GUI appears. You also pass the Dragon serial number for the SERIALNUMBER option, the full path to the nsdefaults.ini file for the DEFAULTSINI option, and the full path to the roamingdef.ini file for the ROAMINGUSERINI option:

    msiexec /i "Dragon NaturallySpeaking 10.msi"
    SERIALNUMBER=#####-###-####-####-##
    DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
    ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
    /L*v "C:\Logs\logfile.log" /qn

Notes:

• For an administrative installation, you pass the /a option to msiexec rather than the /i option. You also need to pass the TARGETDIR option instead of the INSTALLDIR option.
• The first time you test this installation, you should pass /q rather than /qn so that if you have neglected to provide information about a setting that does not have a default, you receive a prompt asking for that information.

The bolded portion of the preceding command line is included so that if something goes wrong during the installation, you receive messages about it. You pass /L and a series of suboptions to have the installation process log errors and other types of messages related to the process. (You can then send the log file to Nuance Technical Support should any issues arise.) Here are other optional actions you can take on the command line that link you to further instructions, below:

**Additional Options for Installations with MSIECSEX.EXE**

Additional Options for Silent Installations
- Modifying the Default Installation Directory
- Configuring Installation of Product Updates
- Suppressing Reboot of Machine After Installation
- Setting *Dragon* to QuickStart Mode
- Installing Same Roaming User Configuration on Additional Machine(s)

**Additional Options with Extensive Settings for Silent Installations**
- Installing Some Vocabularies Locally/Others Only On Demand
- Installing Text-to-Speech Feature
- Reinstalling *Dragon* with Particular Set of Features
- Setting Day/Time of Scheduled Tasks

Additionally, you can launch the Online Registration Form After Installation

**Additional Options for Silent Installations**

Additional Options for Silent Installations
- Modifying the Default Installation Directory
- Configuring Installation of Product Updates
- Suppressing Reboot of Machine After Installation
- Setting *Dragon* to QuickStart Mode
- Installing Same Roaming User Configuration on Additional Machine(s)

**Additional Options with Extensive Settings for Silent Installations**
- Installing Some Vocabularies Locally/Others Only On Demand
- Installing Text-to-Speech Feature
- Reinstalling *Dragon* with Particular Set of Features
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer

- Setting Day/Time of Scheduled Tasks
  Additionally, you can launch the Online Registration Form After Installation

Modifying Default Installation Directory

If you want to set an installation directory other than the default, pass INSTALLDIR="<path to install>" to msiexec on the command line:

```
msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10"
/L*v "C:\Logs\logfile.log" /qn
```

Note: For an administrative installation, you should pass the TARGETDIR option instead of the INSTALLDIR option.

Configuring Installation of Product Updates

If you want the individual client machine to download product updates to Dragon over the web, you would set the PRODUCTUPDATEFLAG option to 1 (option checks the check box). If you prefer to let the server download the updates and later distribute them to client machines, set this option to 0 (unchecks the check box). To not even display the check box, set the option to -1. For enterprise sites, choose -1 to prevent product updates from being downloaded.

```
msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10"
PRODUCTUPDATEFLAG=-1 /L*v "C:\Logs\logfile.log" /qn
```

Suppressing Reboot of Machine After Installation

To suppress rebooting of the machine after installation of Dragon completes, you can pass Microsoft’s REBOOT option set to ReallySuppress. Using this option also suppresses the reboot sometimes required by the installation of Visual C++ Runtime for Dragon, which setup.exe installs in the background. Using this option is highly recommended if you are executing a silent installation (But if system updates are pending, rebooting is required for DNS to work normally.

```
REBOOT=ReallySuppress
```

The altered command line would look like this:

```
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10\" /qn
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress
/L*v C:\Logs\logfile.log /qn"
```

Suppressing Reboot of Machine After Installation

To prevent the machine where you are installing Dragon from rebooting automatically after the installation ends, you can pass Microsoft’s REBOOT option set to ReallySuppress:

```
REBOOT=ReallySuppress
```

The altered command line would look like this:

```
msiexec /i "Dragon NaturallySpeaking 10.msi"
```

SERIALNUMBER=#####-###-####-####-##
Setting Dragon to run in QuickStart Mode

To set Dragon to QuickStart mode and create a shortcut for Dragon in the Windows Startup folder, set the QUICKSTART option to 1:

QUICKSTART=1

The altered command line would look like this:

msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10"
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress
QUICKSTART=1 /L*v "C:\Logs\logfile.log" /qn

Installing the Same Roaming User Configuration on Additional Machine(s)

Use the roamingdef.ini file you created during the initial installation as the input for the ROAMINGUSERINI option in this format (be sure to use the full path to the file when you pass the option):

ROAMINGUSERINI="Y:\<full_path>\roamingdef.ini"

In the above example, Y: is mapped network drive, accessible from client machines.

Optionally include the ROAMINGUSERINI option in the installation command line. If you do not use this property, default settings are assumed.

msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v "C:\nuanceLogs\logfile.log" /qn

After you have completed the installation, verify that all options are correctly set on the client machine.

Launching Online Registration Form After Installation

To have the online registration form for Dragon pop up on the workstation in its browser immediately after the installation completes, you can pass a option to the WEBREGISTRATION option and set it to 1 (applies only if you do not use the /qn option). The default is 0 which means registration will not be launched.

WEBREGISTRATION=1

The revised command line would look like this:

msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10" PRODUCTUPDATEFLAG=-1
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer

Installing Some Vocabularies Locally and Others On Demand

When you install Dragon Medical on a client machine, by default you install all the available vocabularies locally.

If you do not want all of those vocabularies to be installed locally, but to instead have them installed only if/when a user attempts to create a particular vocabulary, you can indicate that fact on the installation command line by adding the ADDLOCAL option and setting it to the names of the vocabularies to install locally. For instance, to install only an English Legal vocabulary, you would set ADDLOCAL to natspeak, ENUMedical and the command line would appear as follows (natspeak must be in the setting of ADDLOCAL, unless you set ADDLOCAL to ALL, or the installation will fail):

```
msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10" PRODUCTUPDATEFLAG=-1
REBOOT=Really Suppress ADDLOCAL=natspeak,ENUMedical
/L*v "C:\Logs\logfile.log" /qn
```

Separate the features/vocabularies for ADDLOCAL with commas, but do not put spaces in the list. The names you must use for the vocabularies consist of a prefix for the language, then the name of the vocabulary, such as ENU for English and Cardiology to form ENUCardiology. For a list of the exact names for features/vocabularies you can assign to ADDLOCAL or ADVERTISE on the command line, refer to Summary: MSI Options for Installing Dragon Features/Advanced Options.

Particularly in a Dragon Medical installation, you might find it useful to have most vocabularies available but not locally installed. You can take that action by setting ADDLOCAL to ALL and then setting the ADVERTISE property to a list of vocabularies to not be installed locally, so that you end up with a subset of the medical vocabularies locally installed and all others available only on demand. The command line might look like the following:

```
msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10" PRODUCTUPDATEFLAG=-1
REBOOT=Really Suppress ADDLOCAL=ALL
ADVERTISE=ENUCardiology,ENUEmergency,ENUGastroenterology
/L*v "C:\Logs\logfile.log" /qn
```

Installing Text-to-Speech Feature

To install Text-to-Speech locally, you would include the feature in the list of features for ADDLOCAL; for instance, you would add TTSENX for Text-to-Speech in English:

```
msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10" PRODUCTUPDATEFLAG=-1
REBOOT=Really Suppress ADDLOCAL=TTSENX,natspeak,ENUMedical
/L*v "C:\Logs\logfile.log" /qn
```
Reinstalling Dragon with Particular Set of Features

Sometimes you want to reinstall Dragon and add or remove particular features of the product. You can also take this action on the command line using the REINSTALL and REINSTALLMODE options of the MSI installer. You set REINSTALL to those features you want to install or to ALL.

For example, to install a minor upgrade to Dragon, you might use this command line:

```
msiexec /i "Dragon NaturallySpeaking10.msi" REINSTALL=ALL REINSTALLMODE=vemus /qn
```

The vemus options: v indicates to reinstall from the source (reupdating cache), e indicates to install the newer file if one is available, mu means to rewrite the registry settings, and s means to reinstall all shortcuts and recache all icons. For more information on the REINSTALL and REINSTALLMODE settings, refer to Summary: MSI Options for Installing Dragon Features/Advanced Options.

Setting Day/Time for Scheduled Tasks

To retain the default schedule for data collection and modify schedules for acoustic model optimization to Mondays at 1 AM and language model optimization to Mondays at 6 AM, you would set the PERIODIC_TASK string as follows:

```
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
```

An MSI installation command line including the option setting this schedule would look like this:

```
msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
/L*v "C:\Logs\logfile.log" /qn
```

For more information on the PERIODIC_TASK option, refer to MSI Options for Roaming User, Tuning, and Data Collection Setup.

Launching Online Registration Form After Installation

To have the online registration form for Dragon pop up on the workstation in its browser immediately after the installation completes, you can pass a option to the WEBREGISTRATION option and set it to 1 (applies only if you do not use the /qn option). The default is 0 which means registration will not be launched.

```
WEBREGISTRATION=1
```

The revised command line would look like this:

```
msiexec /i "Dragon NaturallySpeaking 10.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon10" PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress QUICKSTART=1 WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"
```
MSI Options Specific to Dragon

This section describes the fundamental msiexec.exe options that apply to Dragon Medical. Additional options that apply only to a Dragon installation are listed in:

- MSI Windows Installer Options
- MSI Options for Installing Dragon Features/Advanced Options
- MSI Options for Roaming User, Tuning, and Data Collection Setup

⚠️ Caution: Before you install Dragon using an MSI installation, you must install Visual C++ Runtime for Dragon on each dictation machine using the vcruntime.exe available on the product DVD. You cannot install Visual C++ Runtime as part of a typical msiexec.exe installation. For details, refer to Installing Visual C++ Runtime for Dragon.

If you install Dragon using its setup.exe file, InstallShield installs vcruntime.exe for you. Dragon command line options do not need to be prefaced by hyphens or slashes.

を持っている：Launching msiexec.exe /i "Dragon NaturallySpeaking 10.msi" XYZ=ABC automatically sets the property named XYZ to the value of ABC internally and continues the installation. However, if you use setup.exe to install, you must put all msiexec.exe options you pass it in quotation marks after the /v option.
Unless noted otherwise, all property values are in UPPERCASE.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFAULTSINI=&quot;c:&lt;path \ nsdefaults.ini&quot;</td>
<td>Indicates a default settings (nsdefaults.ini) file that the installer uses to change the default behavior of the product for all users at installation time. This file must be in an .ini file format; any settings you want to take effect on clients must have a section name encased in square brackets as well as the value and data. If only values and data are set in this file without the section name encased in brackets, the settings are not propagated on client machines. Usually, you do not edit the nsdefaults.ini file directly; instead you set defaults in Dragon’s Options and Administrative Settings dialog boxes. Follow these steps to create a nsdefaults.ini file for an MSI installation: Install Dragon on a machine with Windows administrator privileges. Set options in the Options and Administrative Settings dialog boxes as required in your environment and save them by closing Dragon. Copy the nsdefaults.ini file created by this installation of Dragon to a separate location. By default, the nsdefaults.ini is located in: C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\ Use the copied nsdefaults.ini as the input for the DEFAULTSINI option.</td>
</tr>
<tr>
<td>SERIALNUMBER=abcde-fgh-ijkl-mnop-qr</td>
<td>A serial (license) number is required for all installations. You must specify a valid serial number on the command line. <strong>Note:</strong> Specifying a serial number on the command line does not bypass the serial number checking within setup.</td>
</tr>
<tr>
<td>PRODUCTUPDATEFLAG=0 (or 1 or –1)</td>
<td>Sets the default state of the product update check box at the end of installation, to indicate whether the installation should automatically check the web for product updates. Automatic product updates are not supported for enterprise installations. A value of 0 (zero) turns the check box off by default, 1 (one) turns it on by default. To disable the option entirely (turn the option off and suppress the display of the check box altogether), set the value to –1. The default setting is 1 (enables the check box and checks for product updates by default).</td>
</tr>
<tr>
<td>QUICKSTART=0 (or 1)</td>
<td>Set the default state of <strong>Enable QuickStart Mode</strong> check box to enable <strong>QuickStart</strong> and to create shortcut for <strong>Dragon</strong> in the Windows <strong>Startup</strong> folder. A value of 0/1 will turn check box off/on, respectively.</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SETDEFAULTS=0 (or 1)</td>
<td>If set to 1, sets the default state of <strong>Modify the application’s settings for all users</strong> check box to display the <strong>Options</strong> dialog box at the end of the installation. The <strong>Options</strong> dialog box lets you change Dragon’s standard behavior, including specifying hot keys, customizing how text is formatted, changing initial microphone settings, and setting the how often your user files are backed up. Applies only if your installation displays the <strong>Installation Wizard</strong>. A value of 0/1 will turn check box off/on accordingly. With SETDEFAULTS=1, no dialogs display during installation if /qn is used for Quiet mode installation.</td>
</tr>
<tr>
<td>SETADMINS=0 (or 1)</td>
<td>If set to 1, sets the default state of <strong>Modify the administrative settings</strong> check box to display the <strong>Administrative settings</strong> dialog box at the end of the installation. The <strong>Administrative settings</strong> dialog box lets you set up the <strong>Roaming User</strong> feature, set the backup location of your user files, and restrict users from modifying commands and vocabularies. Applies only if your installation displays the <strong>Installation Wizard</strong>. A value of 0/1 will turn check box off/on accordingly. With SETADMINS=1, no dialogs display during installation if /qn is used for Quiet mode installation.</td>
</tr>
<tr>
<td>SETFORMATTINGS=0 (or 1)</td>
<td>If set to 1, sets the default state of <strong>Modify the administrative settings</strong> check box to display the <strong>Formatting</strong> dialog box at the end of the installation. The <strong>Formatting</strong> dialog box lets you set up visual formats for the output of the recognized text, including standard abbreviations and other preferences. Applies only if your installation displays the <strong>Installation Wizard</strong>. A value of 0/1 will turn check box off/on accordingly. With SETFORMATTINGS=1, no dialogs display during installation if /qn is used for Quiet mode installation.</td>
</tr>
<tr>
<td>WEBREGISTRATION=1 (or 0)</td>
<td>Determines whether or not to launch the on-line product registration form after the installation completes. 0 disables the product registration. The default of 1 enables display of the form.</td>
</tr>
</tbody>
</table>

**MSI Options for Installing Dragon Features/Advanced Options**

This section describes additional msiexec.exe options that apply to Dragon Medical. Although these options are for msiexec.exe, they are also available for setup.exe if you use them with the /v“ option.

Other options are listed under:

- Summary: MSI Windows Installer Options
Summary: MSI Options Specific to Dragon.

Summary: MSI Options for Roaming User, Tuning, and Data Collection Setup

The following table presents options that apply to a Dragon installation where you select particular features to install. Unless noted otherwise, all property values are in UPPERCASE.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDLOCAL=Feature1,Feature2,... or ADDLOCAL=ALL</td>
<td>Set the ADDLOCAL property to a list of features to be installed locally, delimited by commas. To install all features locally (including speech files), use ADDLOCAL=ALL on the command line.</td>
</tr>
<tr>
<td>ADVERTISE=Feature1,Feature2,FEATURE3,...</td>
<td>Set the ADVERTISE property to a list of features to be available but not locally installed, delimited by commas. To install all features as advertised, use ADVERTISE=ALL on the command line. The ADVERTISE option overrides the ADDLOCAL option. The best method for installing a particular set of features is to set the ADDLOCAL property to ALL and then set the ADVERTISE property to those features you do not want installed locally. A list of the features that you can set for installation is listed in the section after this table.</td>
</tr>
<tr>
<td>REINSTALL=Feature1,Feature2,... (or ALL)</td>
<td>List of features that are to be reinstalled, delimited by commas. To reinstall all features use REINSTALL=ALL on the command line. If you set the REINSTALL property, you should also set the REINSTALLMODE property, to indicate the type of reinstall to be performed. If the REINSTALLMODE property is not set, then by default all files that are currently installed are reinstalled only if the currently installed file is an earlier version (or is not present). By default, no registry entries are rewritten. Note that even if REINSTALL is set to ALL, only those features that were already installed previously are reinstalled. Thus, if REINSTALL is set for a product that is yet to be installed, no installation action takes place at all. For more information, see:</td>
</tr>
<tr>
<td>REINSTALLMODE={type of reinstall to perform}</td>
<td>String that contains letters indicating the type of reinstall to perform. Options are case-insensitive and order-independent. This property should normally always be used in conjunction with the REINSTALL property. However, this property can also be used during installation, not just during a reinstall.</td>
</tr>
</tbody>
</table>
Chapter 3: Installing Dragon® Medical Using the Windows MSI Installer

By default the REINSTALLMODE=omus to reinstall all files whose checksums are missing or corrupt, rewrite all registry names, reinstall all shortcuts and recache icons. Below is a list of the options with abbreviated definitions:

- **p** — Reinstall only if the file is missing.
- **o** — Reinstall if the file is missing or is an older version.
- **e** — Reinstall if the file is missing or is an equal or older version.
- **d** — Reinstall if the file is missing or a different version is present.
- **c** — Reinstall only files whose checksums are missing or corrupt.
- **a** — Force all files to be reinstalled, regardless of checksum or version.
- **u** — Rewrite all required registry entries from the Registry Table that go under HKEY_CURRENT_USER or HKEY_USERS.
- **m** — Rewrite all required registry entries from the Registry Table that go under HKEY_LOCAL_MACHINE or HKEY_CLASSES_ROOT. Regardless of machine or user assignment, rewrite all info from these tables: Class,Verb,PublishComponent,ProgID, MIME, Icon, Extension, and AppID. Reinstall all qualified components. When reinstalling an application, run the RegisterTypeLibraries and InstallODBC actions.
- **s** — Reinstall all shortcuts and re-cache all icons, overwriting existing shortcuts and icons.
- **v** — Run from the source package, re-cache the local package. Does not apply to new installation of a product or feature.

If you set REINSTALLMODE without also setting REINSTALL, then the detection modes you specify still apply and the overwrite mode is used. The REINSTALLMODE property affects only those features selected for installation using REINSTALL.

For example, to launch a minor upgrade without using setup.exe, you must set the following properties on the command line:

```
REINSTALL=ALL REINSTALLMODE=vemus
```

To install a minor upgrade using an .msi file, use this command line:

```
msiexec /i "Dragon NaturallySpeaking10.msi" REINSTALL=ALL REINSTALLMODE=vemus
```

For more information on REINSTALLMODE and the reinstall option codes, see:

<table>
<thead>
<tr>
<th>REMOVEOLDPROD=1</th>
<th>Removes the old version of the product before installing the new version. Should be used in major upgrades only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>/x&lt;Product.msi</td>
<td>ProductCode&gt;</td>
</tr>
</tbody>
</table>
MSI Options for Roaming User, Tuning, and Data Collection Setup

This section summarizes the roaming user, acoustic/language model tuning, and data collection options for command line installations of Dragon Medical. Other options are listed under:

- Summary: MSI Windows Installer Options
- Summary: MSI Options Specific to Dragon
- Summary: MSI Options for Installing Dragon Features/Advanced Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERIODIC_TASK=&lt;string&gt;</td>
<td>Sets schedule for either one, two, or three tasks — an acoustic model optimization (ACO) task, language model optimization (LMO) task, and/or data collection (DC) task. You can schedule each task to run daily or weekly, but need to set the schedule for each task only once.</td>
</tr>
</tbody>
</table>

The <string> of PERIODIC_TASK contains these arguments, separated by semicolons: aco | lmo | dc — One, two, or all three of them with a vertical bar separating each. If you do not pass the acronym for the feature, that feature is set to its default.

Administrator login name. Be sure you use the fully qualified <domain name><account name> in a case where the user is a local administrator but the machine is on a domain.

Administrator password.

When to run the task(s), with times for each of multiple tasks separated by a vertical bar (|). Each scheduled time should be in the format DayOfWeek, hh:mm, where the day of the week is the three letter abbreviation (no period), the time is the 24-hour time, and the comma between them is required.

The task runs once a week on the day/at the time you indicate. If you omit the DayOfWeek, the task runs every day at the time given.

The first of multiple times becomes the schedule for the first task named in the first parameter, the second time the schedule for the second task, the third the schedule for the third task. If you omit a time by having two vertical bars with no time between them or by leaving out the first or last time, the corresponding task is scheduled for a default time.

Default Schedules
Acoustic model optimization (ACO) — Mon, 02:00
Language model optimization (LMO) — Every day, 03:00
Data collection (DC) — Fri, 01:00
### Examples of PERIODIC_TASK Settings

A string setting this option to perform an acoustic model optimization every Monday at 1 AM and a language model optimization the same day at 4 AM is (notice the comma between the day of the week and the time):

```
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 04:00"
```

To schedule only data collection and language model optimization tasks and have them occur every day at 4 PM and 11 PM, respectively, you would enter only the time for each task, without indicating a particular day:

```
PERIODIC_TASK="dc|lmo;myadmin;mypswd;04:00|23:00"
```

A string setting this option to perform an acoustic model optimization every Tuesday at midnight, data collection every Wednesday at 3 AM, and a language model optimization every Friday night at 10 PM is:

```
PERIODIC_TASK="aco|dc|lmo;myadmin;mypswd;Tue, 00:00|Wed, 03:00|Fri, 22:00"
```

To have the data collection and language model optimization tasks occur at default times, you modify the previous string by removing the times for those tasks, but leaving space between the vertical bars and after the last vertical bar:

```
PERIODIC_TASK="aco|dc|lmo;myadmin;mypswd;Tue, 00:00| "
```
ROAMINGUSERINI="c:\xyz.ini"

Specifies a roaming user .ini file (roamingdef.ini) that contains the Master Roaming User location and any associated HTTP or HTTPS settings for a roaming user. These are the same options set in the Network Directories field of the Roaming tab of the Administrative settings dialog box and the HTTP and HTTPS Settings dialog boxes.

When you enable Roaming User, Dragon creates an encrypted roamingdef.ini file. Use the following steps to create a roamingdef.ini file to be used for an MSI installation where Roaming User is enabled:

1. Install Dragon on a machine with Windows administrator privileges.
2. Enable the Roaming User feature and set all the Roaming User options required in your environment. These must include the Master Roaming User location set in the Network Directories field in the Roaming tab of the Administrative Settings dialog box and any HTTP or HTTPS settings.
3. Test these settings to make sure the Roaming User connection works.
4. Save your settings by closing Dragon.
5. Copy the encrypted roamingdef.ini or roaming.ini file (use the one that is newer) created by this installation of Dragon to a separate location. By default, the .ini is located in:
   C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\
   Set the ROAMINGUSERINI option to the name of the roamingdef.ini file. The default is empty (no .ini file will be used).
6. To set these options using ROAMINGUSERINI, the Roaming User feature must be enabled in the nsdefaults.ini file.
Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties

When specifying features on the command line:

- If a feature does not exist in a particular edition or language, overriding its default property has no effect.

- Some features (such as Text-to-Speech) have subfeatures. Setting these features on the command line automatically turns on the properties of all subfeatures, unless you specify an additional override for those subfeatures.

- Any information in parentheses after the subfeature is not included in the feature name.

You can specify any of the following features using ADDLOCAL and ADVERTISE properties on the command line:

<table>
<thead>
<tr>
<th>Feature—Sub-feature</th>
<th>Sub-feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>NatSpeak</td>
<td>None</td>
</tr>
<tr>
<td>Samples (Sample Commands files)</td>
<td>None</td>
</tr>
</tbody>
</table>

| TTS (Text-to-Speech) | TTSDEU *(German Text-to-Speech)*  
|                       | TTSENU *(US English Text-to-Speech)*  
|                       | TTSENG *(British English Text-to-Speech)*  |
|                       | TTSESP *(Spanish Text-to-Speech)*  
|                       | TTSFRA *(French Text-to-Speech)*  
|                       | TTSITA *(Italian Text-to-Speech)*  
|                       | TTSNLD *(Dutch Text-to-Speech)*  |

| Tutorial | TutDEU *(German Tutorial)*  
|          | TutENX *(English Tutorial)*  
|          | TutESP *(Spanish Tutorial)*  |
|          | TutFRA *(French Tutorial)*  
|          | TutITA *(Italian Tutorial)*  
|          | TutNLD *(Dutch Tutorial)*  |

| Speech—DEU (German) | Sub-features for DEU (German):  
|                     | DEUGeneral *(German General Large, Swiss German General, Empty Dictation General)*  
|                     | DEULegal *(German Legal)*  |
|                     | DEUMedical *(German Medical Large)*  
<p>|                     | DEURadiology <em>(German Medical Radiology Large)</em>  |</p>
<table>
<thead>
<tr>
<th>Feature—Sub-feature</th>
<th>Sub-feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragon Medical: Sub-features for ENU (US English):</td>
<td></td>
</tr>
<tr>
<td>ENULegal (US English Legal Large)</td>
<td></td>
</tr>
<tr>
<td>ENUGeneral (US English General Medium, US English Empty Dictation, US English Commands Only)</td>
<td></td>
</tr>
<tr>
<td>ENUGenSvc (US English Large General)</td>
<td></td>
</tr>
<tr>
<td>Feature—Sub-feature</td>
<td>Sub-feature</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Speech</td>
<td>ENX (English)—ENU (US English) (continued)</td>
</tr>
<tr>
<td></td>
<td>Note: ENURadiology and ENUPathology are not available in the Dragon Medical Small Practice Edition.</td>
</tr>
<tr>
<td></td>
<td>Dragon Medical Only Sub-features for ENU (US English):</td>
</tr>
<tr>
<td></td>
<td>ENUCardiology (US English Medical Large Cardiology, Pediatric Cardiology)</td>
</tr>
<tr>
<td></td>
<td>ENUEmergency (US English Emergency Medicine Large)</td>
</tr>
<tr>
<td></td>
<td>ENUGastroenterology (US English Medical Large Gastroenterology, Pediatric Gastroenterology)</td>
</tr>
<tr>
<td></td>
<td>ENUGeneralPractice (US English Large Family Medicine, Allergy and Immunology, Dermatology, Epidemiology, Geriatric, Hematology, Infectious Disease, Internal Medicine, Medical Education and Writing, Nephrology, Nursing, Osteopathy, Pulmonary Disease, Rheumatology, Sleep Lab)</td>
</tr>
<tr>
<td></td>
<td>ENUMedical (US English General Medical Large—No Specialty)</td>
</tr>
<tr>
<td></td>
<td>ENUMentalHealth (US English Large Medical Addiction Psychiatry; Endocrinology, Diabetes, and Metabolism; Psychiatry, Psychology)</td>
</tr>
<tr>
<td></td>
<td>ENUGastroenterology (US English Medical Large Gastroenterology, Pediatric Gastroenterology)</td>
</tr>
<tr>
<td></td>
<td>ENUNeurology (US English Anesthesiology, Neurology, Pain Medicine, Physical Medicine and Rehabilitation, Vascular and Interventional Radiology)</td>
</tr>
<tr>
<td></td>
<td>ENUObGyn (US English Medical Large ENT, Fetal Medicine, Midwifery, Obstetrics and Gynecology, Ophthalmology)</td>
</tr>
<tr>
<td></td>
<td>ENUOncology (US English Medical Large Oncology, Radiation Therapy)</td>
</tr>
<tr>
<td></td>
<td>ENUOrthopaedic (US English Medical Large Dentistry, Large Hand Surgery, Neurosurgery, Orthopaedics, Oral and Facial Surgery, Orthopaedic Surgery, Plastic Surgery, Podiatry)</td>
</tr>
<tr>
<td></td>
<td>ENUObGyn (US English Medical Large ENT, Fetal Medicine, Midwifery, Obstetrics and Gynecology, Ophthalmology)</td>
</tr>
<tr>
<td></td>
<td>ENUOncology (US English Medical Large Oncology, Radiation Therapy)</td>
</tr>
<tr>
<td></td>
<td>ENUPathology (US English Medical Large Pathology)</td>
</tr>
<tr>
<td></td>
<td>ENUPediatrics (US English Medical Large Pediatrics, Neonatal and Perinatal Medicine, Pediatric Dentistry)</td>
</tr>
<tr>
<td></td>
<td>ENURelation (Neurology, Physical Medicine, Rehabilitation and Speech and Language Pathology)</td>
</tr>
<tr>
<td></td>
<td>ENUObGyn (US English Medical Large ENT, Fetal Medicine, Midwifery, Obstetrics and Gynecology, Ophthalmology)</td>
</tr>
<tr>
<td></td>
<td>ENUOrthopaedic (US English Medical Large Dentistry, Large Hand Surgery, Neurosurgery, Orthopaedics, Oral and Facial Surgery, Orthopaedic Surgery, Plastic Surgery, Podiatry)</td>
</tr>
<tr>
<td></td>
<td>ENUPediatrics (US English Medical Large Pediatrics, Neonatal and Perinatal Medicine, Pediatric Dentistry)</td>
</tr>
<tr>
<td></td>
<td>ENURelation (Neurology, Physical Medicine, Rehabilitation and Speech and Language Pathology)</td>
</tr>
<tr>
<td></td>
<td>ENUObGyn (US English Medical Large ENT, Fetal Medicine, Midwifery, Obstetrics and Gynecology, Ophthalmology)</td>
</tr>
<tr>
<td></td>
<td>ENUOrthopaedic (US English Medical Large Dentistry, Large Hand Surgery, Neurosurgery, Orthopaedics, Oral and Facial Surgery, Orthopaedic Surgery, Plastic Surgery, Podiatry)</td>
</tr>
<tr>
<td></td>
<td>ENUPediatrics (US English Medical Large Pediatrics, Neonatal and Perinatal Medicine, Pediatric Dentistry)</td>
</tr>
<tr>
<td></td>
<td>ENURelation (Neurology, Physical Medicine, Rehabilitation and Speech and Language Pathology)</td>
</tr>
<tr>
<td></td>
<td>ENUObGyn (US English Medical Large ENT, Fetal Medicine, Midwifery, Obstetrics and Gynecology, Ophthalmology)</td>
</tr>
<tr>
<td></td>
<td>ENUOrthopaedic (US English Medical Large Dentistry, Large Hand Surgery, Neurosurgery, Orthopaedics, Oral and Facial Surgery, Orthopaedic Surgery, Plastic Surgery, Podiatry)</td>
</tr>
<tr>
<td></td>
<td>ENUPediatrics (US English Medical Large Pediatrics, Neonatal and Perinatal Medicine, Pediatric Dentistry)</td>
</tr>
<tr>
<td></td>
<td>ENURelation (Neurology, Physical Medicine, Rehabilitation and Speech and Language Pathology)</td>
</tr>
<tr>
<td></td>
<td>ENUObGyn (US English Medical Large ENT, Fetal Medicine, Midwifery, Obstetrics and Gynecology, Ophthalmology)</td>
</tr>
<tr>
<td></td>
<td>ENUOrthopaedic (US English Medical Large Dentistry, Large Hand Surgery, Neurosurgery, Orthopaedics, Oral and Facial Surgery, Orthopaedic Surgery, Plastic Surgery, Podiatry)</td>
</tr>
<tr>
<td></td>
<td>ENUPediatrics (US English Medical Large Pediatrics, Neonatal and Perinatal Medicine, Pediatric Dentistry)</td>
</tr>
<tr>
<td></td>
<td>ENURelation (Neurology, Physical Medicine, Rehabilitation and Speech and Language Pathology)</td>
</tr>
<tr>
<td></td>
<td>ENUObGyn (US English Medical Large ENT, Fetal Medicine, Midwifery, Obstetrics and Gynecology, Ophthalmology)</td>
</tr>
<tr>
<td></td>
<td>ENUOrthopaedic (US English Medical Large Dentistry, Large Hand Surgery, Neurosurgery, Orthopaedics, Oral and Facial Surgery, Orthopaedic Surgery, Plastic Surgery, Podiatry)</td>
</tr>
<tr>
<td></td>
<td>ENUPediatrics (US English Medical Large Pediatrics, Neonatal and Perinatal Medicine, Pediatric Dentistry)</td>
</tr>
<tr>
<td></td>
<td>ENURelation (Neurology, Physical Medicine, Rehabilitation and Speech and Language Pathology)</td>
</tr>
<tr>
<td></td>
<td>ENUObGyn (US English Medical Large ENT, Fetal Medicine, Midwifery, Obstetrics and Gynecology, Ophthalmology)</td>
</tr>
<tr>
<td></td>
<td>ENUOrthopaedic (US English Medical Large Dentistry, Large Hand Surgery, Neurosurgery, Orthopaedics, Oral and Facial Surgery, Orthopaedic Surgery, Plastic Surgery, Podiatry)</td>
</tr>
<tr>
<td></td>
<td>ENUPediatrics (US English Medical Large Pediatrics, Neonatal and Perinatal Medicine, Pediatric Dentistry)</td>
</tr>
<tr>
<td></td>
<td>ENURelation (Neurology, Physical Medicine, Rehabilitation and Speech and Language Pathology)</td>
</tr>
<tr>
<td></td>
<td>ENUObGyn (US English Medical Large ENT, Fetal Medicine, Midwifery, Obstetrics and Gynecology, Ophthalmology)</td>
</tr>
<tr>
<td></td>
<td>ENUOrthopaedic (US English Medical Large Dentistry, Large Hand Surgery, Neurosurgery, Orthopaedics, Oral and Facial Surgery, Orthopaedic Surgery, Plastic Surgery, Podiatry)</td>
</tr>
<tr>
<td></td>
<td>ENUPediatrics (US English Medical Large Pediatrics, Neonatal and Perinatal Medicine, Pediatric Dentistry)</td>
</tr>
<tr>
<td></td>
<td>ENURelation (Neurology, Physical Medicine, Rehabilitation and Speech and Language Pathology)</td>
</tr>
<tr>
<td>Feature—Sub-feature</td>
<td>Sub-feature</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Speech ENX (English)—ENG (UK English) | **Dragon Medical** Sub-features for ENG (UK English):  
ENGeneral (UK English General Large, Empty Dictation General, Commands Only)  
ENGEmergency (UK English Emergency Large)  
ENGGastroenterology (UK English Gastroenterology Large)  
ENGGeneralPractice (UK English General Practice Large)  
ENGMedical (UK English Medical Large — No Specialty)  
ENGMentalHealth (UK English Mental Health Large)  
ENGNurology (UK English Neurology Large) |                                                                                     |
| Speech—ITA (Italian) | **Sub-features for ITA (Italian):**  
ITA (Italian General Large and Italian Empty Dictation General Large) |                                                                                     |
### Installing Visual C++ Runtime for Dragon

**Caution:** Before you carry out an installation of Dragon using msiexec.exe, you must install Visual C++ Runtime for Dragon on every dictation client machine. You can install it one of the following ways:

- Use the Dragon setup.exe on the command line, which automatically installs vcruntime.exe for you.
- Include a vcruntime.exe command line in your admininstall.bat script (see [Carrying Out an Administrative Installation](#)).
- If you are using msiexec.exe to install Dragon, manually install vcruntime.exe from the DVD (see instructions below).
- With Citrix, be sure you publish vcruntime.exe as an application in Citrix and then install it before installing Dragon.

### Speech—NLD (Dutch)

<table>
<thead>
<tr>
<th>Sub-feature for NLD (Dutch):</th>
<th>NLDPathology (Dutch Pathology Large)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NLDGeneral (Dutch General Large and Dutch Empty Dictation General Large)</td>
<td>NLDPediatrics (Dutch Pediatrics)</td>
</tr>
<tr>
<td>Dragon Medical Only</td>
<td>NLDRadiology (Dutch Radiology Large)</td>
</tr>
<tr>
<td>Sub-features for NLD (Dutch):</td>
<td>NLD Ralph (Dutch Ralph Large)</td>
</tr>
<tr>
<td>NLDOrthopaedics (Dutch Orthopaedics Large)</td>
<td>NLDSurgery (Dutch Surgery Large)</td>
</tr>
</tbody>
</table>

### Speech—FRA (French)

<table>
<thead>
<tr>
<th>Sub-features for FRA (French):</th>
<th>FRAMedical (French Medical Large)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRAGeneral (French General Large, French Empty Dictation General Large)</td>
<td>FRARadiology (French Radiology Large)</td>
</tr>
</tbody>
</table>

### Speech—ESP (Spanish)

<table>
<thead>
<tr>
<th>Sub-features for ESP (Spanish):</th>
<th>ESP (Latin American Spanish General Large)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESP (Latin American Spanish Empty Dictation General Large)</td>
<td>ESP (Castilian Spanish General Large)</td>
</tr>
<tr>
<td>ESP (Castilian Spanish Empty Dictation General Large)</td>
<td>ESP (Castilian Spanish Medical Large)</td>
</tr>
</tbody>
</table>
Manually Installing Visual C++ Runtime

Note: These steps are included in the msiexec.exe installation of Dragon.

1. Find the ISSetupPrerequisites/VCRuntime directory on the product DVD and open it. In this directory you find the vcruntime.exe and vcruntime_x64.exe files.
   If you are installing Version 10 rather than Version 10.x, look in the ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5} directory; you find only the 32-bit version of vcruntime.exe for Version 10.
2. Copy the vcruntime files to your server or to another accessible location. These .exe files install Visual C++ Runtime for Dragon. Run vcruntime.exe on each 32-bit machine where you intend to install Dragon and vcruntime_x64.exe on each 64-bit machine.

Caution: Do not attempt to extract the .msi file from either vcruntime.exe or vcruntime_x64.exe. Installing the Visual C++ Runtime for Dragon as part of an msiexec.exe command line installation of Dragon is not recommended and not supported.

Command Line Options for vcruntime.exe

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose of Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>/L &lt;Lang ID&gt;</td>
<td>To provide language ID. The default is US English.</td>
</tr>
<tr>
<td>/S</td>
<td>Silent mode. To turn off GUI prompt for the Choose Setup Language dialog box.</td>
</tr>
<tr>
<td>/v&quot;&lt;msiexec options&gt;&quot;</td>
<td>To hide all GUI dialogs. To provide msiexec.exe parameters, especially /qn for a silent msiexec installation and /l*v to indicate a file where extensive installation messages should be logged. If you want fewer messages in the log, you can pass /l without the v option. The * is a wildcard that calls all the other logging options available.</td>
</tr>
</tbody>
</table>
Chapter 4

Setting Up and Dictating with Roaming Users
Setting Up and Dictating with Roaming Users

The Roaming User feature lets users dictate with Dragon from different network locations and on different machines without having to create and train individual User Profiles at each location.

The Roaming User feature works by storing user profiles in a central network location so that the information *Dragon* learns from a user dictating on one machine is also available on other machines.

To set up, then use Roaming Users, carry out the steps shown in the table below, in chronological order.

<table>
<thead>
<tr>
<th>For information on:</th>
<th>See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Roaming User feature</td>
<td>Overview of the Roaming User feature</td>
</tr>
<tr>
<td>Setting up the Roaming User feature, including:</td>
<td>Setting up the Roaming User feature</td>
</tr>
<tr>
<td>▪ Creating a network storage location for the Master Roaming User Profiles</td>
<td></td>
</tr>
<tr>
<td>▪ Where to install and configure Dragon</td>
<td></td>
</tr>
<tr>
<td>▪ Storage space required for the Master and Local Roaming User Profiles</td>
<td></td>
</tr>
<tr>
<td>▪ How <em>Dragon</em> Synchronizes Master and Local Roaming users</td>
<td></td>
</tr>
<tr>
<td>▪ Estimating Network traffic caused by synchronization</td>
<td></td>
</tr>
<tr>
<td>Enabling the Roaming User on each machine where a user will dictate, including:</td>
<td>Enabling the Roaming User on each machine where a user will dictate</td>
</tr>
<tr>
<td>▪ Setting Roaming User locations</td>
<td></td>
</tr>
<tr>
<td>▪ Setting Roaming User options</td>
<td></td>
</tr>
<tr>
<td>▪ Testing an HTTP or HTTPS connection</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 4: Setting Up and Dictating with Roaming Users

Overview of the Roaming User feature

The Roaming User feature lets users dictate with *Dragon* from different network locations and on different machines without having to create and train individual User Profiles at each location.

Some situations that the Roaming User feature makes possible:

- A doctor may need to dictate reports in a medical office building using a desktop computer, in a hospital room using a Tablet PC, or at home using a laptop computer. The Roaming User feature allows the doctor to use the same set of User Profiles containing the same vocabulary words with the acoustic information from each location.

- A user dictates on the same laptop at multiple offices and at home. Before leaving the office, the user loads a set of User Profiles from a central location on the network to his laptop. Once home, the user dictates and corrects as you normally would. When you return to the office, you reconnect the laptop to the network. The next time the user opens a *Dragon* user, the Roaming User feature synchronizes the updated User Profiles on the laptop with those at the network’s central location.

The relationship between the Master and the Local Roaming User

With the Roaming User feature, each *Dragon* user has a single Master Roaming User that can...
be opened from multiple networked machines running Dragon. The Master Roaming User is stored on a network location accessible to your dictating users.

When a Master Roaming User is opened from that central network location, Dragon transfers a copy of that user to the local machine. That local copy is called the Local Roaming User.

The Local Roaming User is a copy of the user data taken from the Master Roaming User but modified locally by corrections and acoustic data gathered during a dictation session.

You can set a central storage device to contain all your Master Roaming User Profiles. By loading a Dragon user from the central network location, your users can dictate at any computer where Dragon is installed. When users exit Dragon and save the changes to their User Profiles, these changes are saved in that central location. The next time the user runs Dragon, all the changes saved are available regardless of which computer on the network he or she uses for dictation.

Advantages of the Roaming User capability

It is important to distinguish the Roaming User capability from simply browsing to a network directory and creating files there. Nuance recommends using the Roaming User capability rather than storing non-roaming User Profiles in a network directory. Using the Roaming User capability, you can:

- Minimize network traffic. When Dragon opens a User Profile, if there is already a copy of the roaming User Profile on the local machine, only the updates are downloaded from the network. When the user closes the file at the end of his or her dictation session, only the updates from the current session are uploaded to the network. These updates typically amount to no more than a few KB of data, as opposed to roughly 25 MB of data if the entire User Profile is opened and closed over the network.

- Warn the user if the user attempts to open the same User Profile from more than one workstation at a time.

- Allow the user to use Dragon even if the network directory is unavailable. In that case, Dragon opens the local copy of the roaming User Profile.

- Give the administrator precise control over where users can put User Profiles. If roaming is enabled, the administrator can specify whether or not to also allow users to browse to any User Profile location; the default is not to allow browsing. This means that the administrator can easily see how many User Profiles have been created and who created them. If roaming is not enabled, users can browse to any location to which they have access and create User Profiles there.

- If HTTP Roaming is configured, it can be used to provide username/password authentication on User Profiles.
Hosting Master Roaming User Profiles

There are several methods for hosting your Master Roaming User Profiles:

- On a file server you connect to over a Mapped Drive
- On a file server that you connect to over a UNC (Universal Naming Convention) address
- On a web server that you connect to over HTTP (http://)
- On a secure web server that you connect to over SSL (https://)

Why the Master Roaming User Profiles should be in shared directories

Nuance recommends placing the files in a shared directory to make certain administrative tasks more efficient. These tasks include:

- Scheduling an Acoustic and Language Model Optimizer task that optimizes multiple users
- Upgrading multiple User Profiles to a new major release of Dragon
- Keeping track of how many User Profiles have been created, which helps with licensing compliance (note that Dragon is licensed per user, not per workstation)

It is possible, though not recommended, to place roaming user files in a non-shared, user-specific location such as the user’s home drive, provided every user’s home drive is mapped to the same drive letter (this is because the roaming user file location is an administrative setting that is per-workstation, not per-user).

Using multiple Roaming User locations

If you have a large number of Roaming Users, you may want to divide them among multiple shared directories. This facilitates performing tasks such as scheduling the Acoustic and Language Model Optimizer on a subset of users. You can choose how to divide your users, for example:

- By department
- By alphabetical groupings (for example A through H, I through M, N through R, and S through Z)

On each PC, you can configure any number of Roaming User locations. Make sure you give each Roaming User location a display name that makes it clear to your users which location to choose from.

Controlling user access to other user’s files

If you have multiple Dragon users on an end-user workstation, those users will have multiple users to choose from in Dragon’s Open User dialog box.

If you use a shared directory for User Profiles, whether they are roaming or non-roaming, you may be concerned about the ability of a user to see and/or open another user’s file as well as
their ability to open the correct file. There are several ways to address this concern:

- Many of Nuance’s customers address this concern simply through user training. Each user should be aware that if they open another user’s file and try to use it, their accuracy will be poor and user-specific customizations will not be available. Therefore, each user has an incentive to use only their own file. However, this fact doesn’t prevent a malicious user from damaging another user’s file.

- If users always log into Windows with a unique Windows user ID, you can use Windows file permissions to control access to the files. Typically, you do this by granting Full Control or Read/Write/Modify access to the shared directory, but do not allow this permission to propagate to subdirectories. That way, each user becomes the creator owner of any Dragon User Profile that he or she creates. Users can still see all of the Dragon user names in the Open User dialog box, but if they try to select another user’s file a message will appear saying that they do not have permission to access that file. Apply similar file permissions to the local copy of each roaming User Profile; the default location for local copies is under c:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\Roaming Users.

- If users log in using a shared Windows user ID, the best way to control access is through HTTP Roaming. In this configuration, you set up a web server running either IIS or Apache and with the WebDAV file system enabled. On each workstation, you specify a URL on the web server as the roaming user location. When a user launches Dragon, before displaying the Open User dialog it prompts for a user name and password, which it uses to authenticate against the web server.

You can use file permissions on the web server to specify which User Profiles are accessible to each account on the web server. File security is a function of the web server and the WebDAV software.

### Opening Roaming Users from the command line.

As described above, the Dragon Open User dialog shows a list of all of the User Profiles in a shared directory (unless you are using HTTP Roaming to limit access to User Profiles). If there are more User Profiles than will fit on one screen, you can train users to go directly to a specific User Profile by typing the first few letters of its name.

It is possible to create an icon in the Start Menu and/or the Windows desktop that opens a specific user name. This can be helpful if there are only a few users of Dragon who share a particular workstation. Make a copy of the Dragon icon for each user, and place the parameter /user "user name" on the natspeak.exe command line.

For more information, see [Summary of natspeak command line switches](#).

**Notes:**

To open a Roaming User from the command line on a mapped, UNC drive or a http/https server, you must point directly at the Roaming user location. For example:

- UNC

  natspeak.exe /user \\<directory>\<directory>\<username>
For example: `natspeak.exe /user \Roaming\Profiles\Roaming1`

- **Http/Https:**
  
  `natspeak.exe /user http://<url_of_server>/<user_name>`

  For example:`natspeak.exe /user http://test01.roam.test\Roaming1`

  The path to http/https location must contain forward slashes only; the same as specified in Network Location dialog.

  The username must be proceeded by a backslash.

**Back up your Master Roaming Users**

*Dragon* does not backup local roaming users on the end-user workstations and does not backup the Master Roaming User Profiles on the location where they are stored on your network. It is the responsibility of your local system administrator to backup the Master Roaming User Profiles.

**Setting up the Roaming User feature**

When setting up the Roaming User feature, note the following:

- Creating a network storage location for the Master Roaming User Profiles
- Where to install and configure Dragon
- Storage space required for the Master and Local Roaming User Profiles
- Synchronizing Master and Local Roaming users
- Estimating Network traffic caused by synchronization

*Note: To enable Roaming Users and set the Roaming User options, you must log into an account with Windows Administrator privileges.*

**Creating a network storage location for the Master Roaming User Profiles**

For any installation of Dragon, you must first determine where on the network the Master Roaming User Profiles should be located.

Dragon lets you store your Master Roaming Users on:

- Any networked machine.
  
  You are not strictly required to store Master Roaming User Profiles on a server. Any shared location accessible to other computers on the network is a perfectly acceptable
place to store Master Roaming User Profiles.

- a Windows file server
- A web server (HTTP)
- A secure web server running SSL (HTTPS)

**Note:** The location(s) you pick must be accessible to all computers where users will dictate with a Roaming User. Each location must have adequate storage space for Roaming User Profiles. For more information, see [Storage space required for User Profiles](#).

**What to consider for the Master Roaming User location**

To set up a location for the Master Roaming User Profiles, you should first determine:

- The kind of network file server on which you want to store your Master Roaming User Profiles. Make sure it has enough storage space. Each location you pick must be accessible to all computers where your users will dictate with a Roaming User. You can create multiple network storage locations.

- How the machines from where your users will dictate will connect to that network location; for example using a mapped drive, UNC connection, or an HTTP or HTTPS connection.

**Using a networked machine or Windows file server**

If you choose to use a networked machine or Windows server, you should determine the path to where the Master Roaming Users will reside. You can create multiple network storage locations.

The Roaming User feature supports the following types of locations for your Master Roaming Users:

- Mapped Drives—Connects to a shared network folder that has a drive letter assigned to it.

- UNC Paths—Connects to a shared network folder using the Universal Naming Convention (UNC) to locate a user. Format is: `\<servername>\<sharename>\<path>\<filename>`.

**Using a HTTP or HTTPS web server**

If you choose to use a HTTP or HTTPS web server, the Roaming User feature supports the following types of locations for your Master Roaming Users

- HTTP ([http:](http))—Connects to machine on the internet or your local intranet. Format is: `http://<myserver.com>/<webdav>`

- HTTP with SSL ([https:](https:))—Connects to machine on the internet or your local intranet with SSL. Format is: `https://<myserver.com>/<webdav>`

**Supported web servers**

If you want to store your Master Roaming Users on a web server, Internet access to Master Roaming User Profiles is supported on two web servers:
Microsoft Internet Information Services (IIS) 6.0. For this type of server:

- Digest authentication through a proxy server with Internet Information Server (IIS) 6.0 is not supported.
- Be sure that the server has Web-based Distributed Authoring and Versioning (WebDAV) software is turned on to publish content to an Internet Information Services (IIS) web server.

If you have not already installed the WebDAV component, use the Add or Remove Programs in your Control Panel and run the Windows Components Wizard. WebDav is listed under Application Server>Internet Information Services>World Wide Web Service>WebDAV Publishing.

Apache HTTP Server 2.0.54 and higher. For this type of server:

- Internet Roaming User—Redirects must be turned on when using Digest authentication.
- Be sure that the server has Web-based Distributed Authoring and Versioning (WebDAV) software turned on. The WebDAV Apache module is available free of charge at http://www.webdav.org/mod_dav/.

### What you’ll need to know to configure your local Roaming Users

After you have chosen the type of machine to store the Master Roaming Users, you should determine the following information so that you configure your local copies of Dragon to connect to the HTTP server:

- **The network location:** You need to know the URL address of your HTTP server. For more information, see [SSL Settings](#).
- **HTTP settings:** For your http (or https) connection you need to know authentication, firewall, and proxy server information. For more information, see [HTTP Settings](#).

### Where to install and configure Dragon

**Installing Dragon on where you plan to dictate using the Roaming User feature**

Dragon must be installed each computer where you plan to have users dictating as a Roaming User.

**Installing Dragon on the same machine as your Master Roaming User Profiles**

Nuance recommends that you install Dragon on the same machine where the Master Roaming User Profiles for your network are located.

As the system administrator, you are responsible for running the *Acoustic and Language Model Optimizer* on the network location of the Master Roaming Users files. The *Acoustic and Language Model Optimizer Scheduler* can only be run on the Master Roaming User profiles.

Running the Acoustic and Language Model Optimizer updates the Master Roaming User
Profiles with the accumulated acoustic data from any corrections and additional training done by the users at the machines where they dictate. Running the Acoustic and Language Model Optimizer will increase your overall accuracy. Any optimizations done by the **Acoustic and Language Model Optimizer** are copied to each Local Roaming User when synchronization occurs.

Running the **Acoustic and Language Model Optimizer** over the network can result in a large amount of data being transferred between the server and the workstation running the optimizer. For more information, see [Running the Acoustic and Language Model Optimizer for Roaming Users](#).

**Notes:**

- You must have Windows Administrator privileges on the machine where you are running the **Scheduler** for the **Acoustic and Language Model Optimizer**.

- Do not enable the Roaming User function on the administrator machine where you plan to run the **Acoustic and Language Model Optimizer**.

- When the Roaming User feature is enabled on a machine where someone dictates, that machine is blocked from locally running the **Acoustic and Language Model Optimizer** or the **Acoustic and Language Model Optimizer Scheduler** on the local copy of the Roaming User Profiles.

**For more information on installing or upgrading Dragon**

For more information on installing or upgrading Dragon on the machines in your network, see:

- [Upgrading roaming User Profiles: Overview](#) for information how to upgrade Roaming User Profiles from Dragon Medical Version 9.x to Version 10.

- The Installation Guide that came with your copy of *Dragon* for information on installing *Dragon* on a single machine

- The System Administrator’s Guide for information on how to use a MSI to install or upgrade *Dragon* on multiple machines.

**Storage space required for the Master and Local Roaming User Profiles**

Adequate storage space must be available for User Profiles that store information about each particular user’s speech patterns.

You need to plan for storage space on:

- Each computer where you plan to have users dictating as a Roaming User.

- The network accessible central machine or machines where Master Roaming User Profiles are stored.

These are guidelines only and not definitive specifications—actual size will vary from site to site.
Chapter 4: Setting Up and Dictating with Roaming Users

For each Master Roaming User - on the network

For each Master Roaming User (User Profiles stored on the central network location), you should plan on:

- 30 MB for each set of roaming User Profiles. This includes:
  - 15 MB for each additional vocabulary you add for this user
  - 13 MB for each additional dictation source you add for this user
- 500 MB for acoustic optimizer data associated with each dictation source of each user

For each computer where Dragon is installed

You must install 1 copy of Dragon on each computer where your users will be dictating with the Roaming User feature. Multiple users can use a single Dragon installation.

Each installation of Dragon takes a minimum of 1 GB of free hard disk space for a custom Installation where you install only the program files and 1 set of speech files. Installations can range from 800 MB (US English Standard Edition) to 2.5 GB (US English Medical Edition), depending on which languages and vocabularies you install.

For each Local Roaming User - on the client PC

On each installation of Dragon where your users plan to dictate using the Roaming User feature, each Local Roaming User (the User Profiles stored on the local machine running Dragon), require the following:

- 30 MB for each set of roaming User Profiles. This includes:
  - 15 MB for each additional vocabulary you add for this user
  - 13 MB for each additional dictation source you add for this user
- 10 MB per topic for language model optimizer data in the topic container data
- 240 MB for acoustic optimizer data associated with each dictation source of each user.

How much acoustic optimizer data is retained locally is controlled by settings on the Data tab of the Options dialog box:

1. To set the number of minutes of audio to retain locally, click the Archive size... button and position the slider.
2. To turn off retaining this data locally, check the Conserve disk space required by user files (for portability) option.

For each non-roaming user, you should plan on approximately twice as much space as a Local Roaming User, because Dragon periodically makes a backup copy of the files and stores it on the same machine. The product does not back up Roaming User Profiles this way as they are located on a central machine that your Information Technology department should back up regularly.
How Dragon Synchronizes Master and Local Roaming User Profiles

When a Roaming User exits Dragon, switches users, closes a user, or saves a user, Dragon saves changes to the Local Roaming User and then synchronizes these changes with the Master Roaming User Profiles on the network.

In a networked situation, this occurs at the time one of these operations is performed.

When a user dictates using a computer not currently connected to a network, all changes are saved to the Local Roaming User; synchronization occurs when the user reattaches the computer to the network containing the Master Roaming User and opens that user again.

For more information on what options effect what data gets synchronized between the Master and Local Roaming User, see Setting/selecting Roaming User options.

Note: During synchronization, changes to the Master Roaming User overwrite any changes made to a Local Roaming User who has been dictating and correcting dictation while not on the network.

What happens during synchronization

The following changes take place when Local and Master Roaming Users are synchronized.

Synchronization:

- Combines words added to the Local Roaming User during a dictation session with the Master Roaming User vocabulary,
- Removes words deleted from the Local Roaming User from the Master Roaming User vocabulary.
- Copies acoustic data (from files with a .DRA or .NWV extension) from the Local Roaming User and adds them to the Master Roaming User where the data become available to the Acoustic Optimizer (Note that .DRA files saved voluntarily by the user along with a document do not get added to the Master Roaming User. The.DRA files created automatically by Dragon for use by the optimizer are the only ones that get added to the Master Roaming User). For more information on running the Acoustic Optimizer, see Running the Acoustic and Language Model Optimizer for roaming users.
- Copies any custom commands created or modified locally (using the MyCommands editor) to the Master Roaming User.

What changes don’t get synchronized

The following options are not synchronized with the Master Roaming User; they remain exclusively on the local computer with the Local Roaming User:

Locally set options on the Options dialog:

- On the Data tab:
  - Conserve disk space required by user files option
  - Create usability log option in the Advanced dialog box
  - Incremental adaptation in additional training option

- On the Miscellaneous tab:
  - Use Active Accessibility for menu and dialog control option
Chapter 4: Setting Up and Dictating with Roaming Users

- **Launch in QuickStart mode on Windows startup** option

- **On other tabs of Options dialog box:**
  - All the options on the Text-to-speech tab
  - All the options on the Hot keys tab

- **Settings in the Formatting dialog box:**
  - The Enable postal code commands option
  - Medical formatting options -

**What files are synchronized**

The following table explains how and when individual files are copied or updated to the master roaming user or to the local cache when the Master and Local Roaming users are synchronized. For more information on what options effect what data gets synchronized between the Master and Local Roaming User, see Setting/selecting Roaming User options.

These options can effect how much data is transferred across your network when the Master and Local Roaming Users are synchronized. For more information, see Estimating Network traffic caused by synchronization.

<table>
<thead>
<tr>
<th>File Name or Type</th>
<th>When Copied or Updated to Master Roaming User</th>
<th>When Copied or Updated to Local Cache</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acoustic files: *.usr and *.sig</td>
<td>At save time if the Always copy acoustic information to network setting in the Administrative settings is on. If the setting is off (the default), after the acoustic optimizer runs on the master roaming user, the server incorporates the changes</td>
<td>Copied if version number on server is different</td>
</tr>
<tr>
<td>Vocabulary files: *.voc</td>
<td>Copied only after the vocabulary files for the user have been modified with information from Add Words From Documents, Add Words from Email, Add Lists of Words, and similar procedures.</td>
<td>Copied if version number on server is different</td>
</tr>
<tr>
<td>Acoustic archive created for each dictation session: acarchive.nwv, acarchive.enwv</td>
<td>Copied to session folder if it exists; once master voice_container limit is reached, nothing more is copied. The local copy is deleted and a zero-length file is created.</td>
<td>Never</td>
</tr>
<tr>
<td>File Name or Type</td>
<td>When Copied or Updated to Master Roaming User</td>
<td>When Copied or Updated to Local Cache</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>Audio.ini</td>
<td>Copied to master after running the Audio Setup Wizard or at user close if not copied successfully after running the Audio Setup Wizard</td>
<td>Copied if version number on server is different; also copied right before Audio Setup Wizard is run</td>
</tr>
</tbody>
</table>
| User Backups     | Never  
*Dragon* does not backup local roaming users on the end-user workstations and does not backup the Master Roaming User Profiles on the location where they are stored on your network.  
It is the responsibility of your local system administrator to backup the Master Roaming User Profiles.  
However, *Dragon* does automatically backs up local non-roaming users on the end-user workstations as specified in the Miscellaneous tab of the Administrative Settings dialog box. | Never |
| DRA files created during dictation: DRA files, aco.ini; drafiles.ini | Copied to session folder if the master voice container has space. Files are deleted after being copied; aco.ini and drafiles.ini are recreated at zero-length | Never |
| Custom commands created on client PC: Mycmds.dat | Copied when user profiles are saved, or user is closed and saved. | Copied at user open |
### File Name or Type

<table>
<thead>
<tr>
<th>File Name or Type</th>
<th>When Copied or Updated to Master Roaming User</th>
<th>When Copied or Updated to Local Cache</th>
</tr>
</thead>
<tbody>
<tr>
<td>.INI file changes on client PC: Options.ini, soptions.ini, itnoptions.ini</td>
<td>Copied at user close, options dialog close when the timestamp on the local file has changed.</td>
<td>Copied on user open, options dialog open if version number is different on the server</td>
</tr>
<tr>
<td>History of changes to the vocabulary: Vocdelta.dat</td>
<td>Merged to master copy on user save and open. When vocabularies are copied up, vocdelta.dat is reset to zero in the master copy for that topic.</td>
<td>Copied to local cache on user open and merged into the voc if version number is different on the server</td>
</tr>
<tr>
<td>.INI file changes on client PC: nsuser.ini, local.ini, nssystem.ini, natspeak.ini</td>
<td>Never (machine dependent)</td>
<td>Never</td>
</tr>
</tbody>
</table>

### Estimating Network traffic caused by synchronization

The following table explains how and when individual files are copied or updated to the master roaming user or to the local cache when the Master and Local Roaming users are synchronized and how much data is transferred in the process.

In addition, this table which option controls whether the data is transferred. For more information on what options effect what data gets synchronized between the Master and Local Roaming User, see [Setting/selecting Roaming User options](#).

The estimates of the data transferred across the network is for a single Roaming user.
Enabling the Roaming User on each machine where a user will dictate

After you have set up the network location for the Master Roaming Users files and installed or upgrading Dragon on the machines in your network, you must enable the Roaming User feature on each machine where the user will dictate as a Roaming User.

**Step 1: Start Dragon**

You must start Dragon to enable the Roaming User feature.

**Step 2: If already Dragon is running, close any open users**

If *Dragon* is already running, you must first close any open users before you can enable the Roaming User feature:

- If the *Open User* or *New User Wizard* dialog box appears when you start *Dragon*, click *Cancel*.

<table>
<thead>
<tr>
<th>Files Copied to the Master Roaming User Profile...</th>
<th>Files Copied to the Local Roaming User Profile...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acoustic files: &quot;usr &amp; *.sig&quot;</td>
<td>Acoustic archive created for each dictation session: sc/archive/uv, sc/archive.envv</td>
</tr>
<tr>
<td>User Actions: Dictation, Audio Setup</td>
<td>User Actions: Dictation and Correction</td>
</tr>
<tr>
<td>15MB</td>
<td>240MB</td>
</tr>
<tr>
<td>When the user profile is saved if the option to save the files is on.</td>
<td>Copied to session folder if it exists. Once master voice_container has reached, nothing more is copied. Copy only happens after save or user close.</td>
</tr>
<tr>
<td>Access network at user open/close only</td>
<td>Access network at user open/close only</td>
</tr>
<tr>
<td></td>
<td>Never. The local copy is deleted and a zero-length file is created after files are copied to the server.</td>
</tr>
<tr>
<td></td>
<td>Never. Files are deleted after being copied. acxo.ini and draffles.ini are never created at zero-length.</td>
</tr>
<tr>
<td>DNA files created during dictation: DNA files, acxo.ini, draffles.ini</td>
<td>Custom commands created on client PC: Mycommands.dat, User Actions: Changes to some Options on the local PC</td>
</tr>
<tr>
<td>1.3MB/minute</td>
<td>66K</td>
</tr>
<tr>
<td></td>
<td>Copied to session folder if the master voice_container has space.</td>
</tr>
<tr>
<td></td>
<td>Copied at user open on local PC</td>
</tr>
<tr>
<td></td>
<td>Copied to local cache on user open and merged into the voc if version number is different on the server</td>
</tr>
<tr>
<td></td>
<td>Copied in the master copy for that vocabulary</td>
</tr>
<tr>
<td></td>
<td>&lt;1K</td>
</tr>
<tr>
<td>History of changes to the vocabulary: vocabdata.dat</td>
<td>History of changes to the vocabulary: vocabdata.dat</td>
</tr>
<tr>
<td></td>
<td>500 KB max. (12 bytes/word)</td>
</tr>
<tr>
<td>User Actions: Adding words, changing word properties</td>
<td>Merge contents of vocabdata.dat into network user when file is full</td>
</tr>
<tr>
<td></td>
<td>Copied in user open and Options dialog open if server version is different from client version.</td>
</tr>
</tbody>
</table>

| DragonLog | | Copy Dragon log to network |
|-----------|------------------|
| User Actions: Any use of Dragon | <1MB |
| Copied if the Admin Option is set. | Never |
Chapter 4: Setting Up and Dictating with Roaming Users

- If a user opens automatically (Dragon does this if there is only one user available), click Close User on the DragonBar Dragon menu.

Step 3: Turn on Roaming User feature

After closing any open users:

1. If Dragon is running, from the DragonBar menu, select Tools > Administrative Settings. This action displays the Administrative Settings dialog box.

   Note: You do not have to be running Dragon to act as an administrator of the product. Instead of opening the Administrative Settings dialog box from the DragonBar menus, you can open the dialog box from the command line by selecting Start > Run, then entering the following command in the Open text box (include a space between natspeak.exe and the /SetAdministrativeOptions option that follows it):

   
   "C:\Program Files\Nuance\NaturallySpeaking10\Program\natspeak.exe" /SetAdministrativeOptions

2. On the Roaming tab, check Enable.

3. Click Apply to save the changes and keep the dialog box open.

   Note: With the Roaming User feature enabled, the Open User dialog box later displays only users in the Roaming User storage locations. To let the users open both local (non-roaming) and Roaming Users, check the Allow non-roaming users to be opened option in the Administrative Settings dialog box. Clearing this option prevents users from dictating with a non-roaming (local) user by mistake, but you should check it now if you want to ensure you can open existing local users so that you can convert them to Roaming Users.

Step 4: Set location of Master Roaming Users

On each computer where you plan to have users dictating as a Roaming Users, you must tell that installation of Dragon where the Master Roaming users are located.

After selecting Enable on the Roaming tab:

1. Click the Add button. The Roaming User Network Location dialog box displays. You use the Roaming User Network Location dialog box to define the network location of the master roaming users. The location you pick must be accessible to all computers on the network that you want available for dictation with Dragon.

2. Set the Display Name to the way the name of the directory should display in other dialog boxes. The display name later appears in the Roaming tab of the Administrative Settings dialog and the Location of user files text box of both the Open User and the Manage Users dialog boxes.

3. Set the Network Location. See the types of locations that the Roaming User feature supports in Step 1: Create network storage location for Master Roaming User Profiles.

4. If you are using a web server to store Master Roaming User Profiles, click the
HTTP Settings and SSL Settings (if you are using HTTPS) button to set information about your HTTP and HTTPS connection and proceed with HTTP Settings and SSL Settings for further information. After entering the HTTP and SSL Settings, use the Test Connection button to make sure your settings are correct. For help troubleshooting a problem with the connection, see Testing and troubleshooting an HTTP connection.

5. Click OK in the Roaming User Network Location dialog box.

For more information on setting the location of the master roaming user, see Roaming User Network Location.

Note: You cannot create a non-Roaming user on an HTTP connection. You can only create Roaming Users on an HTTP connection when the Roaming User feature is enabled.

Step 5: Set location of Local Roaming Users

When a user opens a Master Roaming User, Dragon transfers a copy of that user to the local machine. That local copy is called the Local Roaming User. This is the location on the computer where changes made during a dictation session, such as corrections or new acoustic data, are stored before they are synchronized with the master roaming user.

You can set this location, called <Roaming Local>, from the Administrative Settings dialog box. Nuance recommends leaving this option at the default setting.

Note: The location of <Roaming Local> is per-PC and cannot be changed to a user-specific location.

<Roaming Local>

To accept the default <Roaming Local> location (which Nuance recommends), click OK on the Administrative Settings dialog box. You will be prompted to create the default directory if it does not already exists. When you see the following message, click Yes.

The default location of <Roaming Local> is:

- **XP:** C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\RoamingUsers\<display name>\n- **Vista:** C:\Users\All Users\Nuance\NaturallySpeaking10\RoamingUsers\<display name>\n
The <display name> is the name you defined for the Master Roaming User location. You can have multiple network storage locations for your Master Roaming User Profiles and each has its own corresponding directory for Local Roaming Users.

Changing the default location for <Roaming Local>

1. Use the Browse for Folder dialog box to open a location where you want to store the local roaming user. This is the location on the computer where changes made during a dictation session, such as corrections or new acoustic data are stored before they are synchronized.
2. If the directory does not currently exist, click **Make New Folder** and type a name for the new folder. The new directory can have any name, but calling it something meaningful, such as *Local Roaming Users*, will make the folder easier to find in the future.

3. Click **OK**.

**Step 6: Set Roaming User options**

The **Administrative Settings** dialog box also contains several options that affect how the Roaming User feature works. You select the options that indicate how you want a roaming user to function at each Roaming User location. For a list of the options to choose from, refer to [Selecting Roaming User options](#).

**Notes:**

- *Once you set up an installation of Dragon to use the Roaming User feature, users on that machine can only open Roaming Users; they cannot open any locally created users unless you choose the "Allow non-roaming users to be opened" option. For a list of the options to choose from, refer to [Selecting Roaming User options](#).*

- *If a user is dictating with a Roaming User, the Acoustic and Language Model Optimizer Scheduler is disabled on the local user’s machine. You must run the Acoustic and Language Model Optimizer on the machine where your Master Roaming User Profiles are located or on an administrator’s workstation. For more information, see [Running the Acoustic and Language Model Optimizer with a Roaming User](#).*

---

**Administrative Settings: Roaming tab**

You use the **Roaming** tab of the **Administrative Settings** dialog box to set up the Roaming User feature. You must set up the Roaming User feature on each computer where you want users to dictate with a Roaming User.

**Enable**

Select **Enable** to activate the Roaming User feature and the Roaming User options.

**Network Directories**

To set the location of the master Roaming User(s):

1. Click the **Add** button. You use the **Roaming User Network Location** dialog box to define the network location of the master roaming users. The location you pick must be accessible to all computers on the network that you want available for dictation with Dragon.

2. Set the **Display Name** and the **Address** under **Network Location**. The Roaming User feature supports the following types of locations:

   - Mapped Drive—the format is: `<drive letter>:\<folder name>`. For example, `y:\roaming`. 
- UNC Path—the format is: `\servername\sharename\path\filename`.

- HTTP (http:)—the format is: `http://myserver.com/webDAV`. For HTTP locations, click the HTTP Settings button to set information specific to your HTTP connection. You can also test your connection to the HTTP server from HTTP Settings dialog box.

- HTTP with SSL (https:)—the format is: `https://myserver.com/WebDAV`. For HTTP with SSL locations, click the SSL Settings button to set information specific to your HTTP with SSL connection. You can also test your connection to the HTTP with SSL server from SSL Settings dialog box.

**Local directory (for cache)**

When a user opens a Master Roaming User, Dragon transfers a copy of that user to the local machine. That local copy is called the Local Roaming User.

You can change the setting of this location, always called `<Roaming Local>`.

The default location of `<Roaming Local>` is:

```
Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking10\RoamingUsers\<display name>\<username>
```

The `<display name>` is a name you assigned as a Master Roaming User Profiles location. You can have multiple network storage locations for your Master Roaming User Profiles.

The `<username>` is the name of an individual Master Roaming User. There is a separate directory for each user.

Click the **Browse** button to find or create a new location.

**Check Boxes for Roaming User Options**

The check boxes and other components below the **Local directory** are the Roaming User Options. For when and why to set these options, refer to Selecting Roaming User options.

**Restore Defaults**

Returns the Administrative Settings dialog box to the state it had when you first installed Dragon. Note that the default is to have the Roaming User feature turned off.

**Notes:**

- **If you connected to your Roaming User Master Directory over HTTP and you find that either not all your users are listed in the Open User dialog box or after creating a roaming user you cannot open it again, be sure to:**
  - Add all file extensions within your Master Roaming User directories and subdirectories to the Registered MIME types list of your IIS server. You could also add a wildcard (*) MIME-type. For more information on adding a wildcard (*) MIME-type, see [http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8e-b552-83a2c180cd32.mspx?mfr=true](http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8e-b552-83a2c180cd32.mspx?mfr=true).

- **Check that no files in your user directory are locked, password protected, or otherwise access-restricted by your server permissions.**
Administrative Settings: Roaming User Network Location

You use the Roaming User Network Location dialog box to define the network location of the master roaming users.

The location you pick must be accessible to all computers where users will dictate using a Roaming User.

**Display Name**

Sets the directory name displayed in the following locations:

- The Roaming tab of the Administrative Settings dialog box
- The Location of user files drop-down list in the Open User dialog box.

*Note:* With the Roaming User enabled, the Open User dialog box displays only users in the Roaming User locations. To let the users open both local (non-roaming) and Roaming users, select the Allow non-roaming users to be opened option on the Administrative Settings dialog box. Clearing this option prevents users from dictating with a non-roaming (local) user by accident. For more information, see Enabling the Roaming User on each machine where a user will dictate.

- The Location of user files drop-down list in the Manage Users dialog box.

**Network Location—Address**

On each computer where you plan to have users dictating as a Roaming Users, you must tell that installation of Dragon where the Master Roaming User Profiles are located.

The Roaming User feature supports the following types of locations:

**Mapped Drives and UNC Paths**

Mapped drives connect to a shared network folder that has a drive letter assigned to it.

UNC paths connect to a shared network folder using the Universal Naming Convention (UNC) to locate a user. The UNC is a way to identify a shared file on a computer or network without having to know the storage device it is on. The UNC path format is: `\servername\sharename\path\filename`.

To use a mapped drive or UNC path:

1. Under Network Location, enter the address of the mapped drive or UNC path.
   
   You can click Browse to browse for the location of the mapped drive or UNC path. This displays the Browse for Folder dialog box. You can also create a new directory on the mapped drive or UNC path by clicking the Make New Folder button.

2. Click OK when you are done.

**Intranet/Internet connections**

The Intranet/Internet connection supports both HTTP and HTTP over an encrypted Secure Sockets Layer (SSL).

To use an Intranet/Internet connection:
1. Under **Network Location**, enter the URL address of your HTTP or HTTPS server where your roaming user master files are located.

2. Click

   - **HTTP Settings...** to display the **HTTP Settings** dialog box, where you can set information specific to your HTTP connection like Authentication, Firewall, and Proxy Server information. You can also test your connection to the HTTP server from this dialog box. For more information, see [HTTP Settings](#).

   - **SSL Settings...** to display the **SSL Settings** dialog box, where you can set information specific to your HTTPS (SSL) connection. You can also test your connection to the HTTPS server from this dialog box. For more information, see [HTTPS Settings](#).

   **Note:** You cannot create a non-Roaming user on an HTTP or HTTPS connection. You can create only Roaming Users on an HTTP or HTTPS connection and only when the Roaming User feature is enabled.

### Setting up HTTP Connection: HTTP Settings

You use the **HTTP Settings** dialog box to define and configure the connection to your web (HTTP) server. Enter information about your connection in the following sections and text boxes of the dialog box:

**Authentication**

**Passwords**

Defines how the roaming user enters the server username and password. This username/password is to the server, not a local login:

- **Prompt for User and Password:** Select if local users will be prompted for a username/password when they connect to the HTTP server.

- **User/password:** Sets the default username/password needed to connect to the HTTP server. Be sure to put the domain name followed by a backslash in front of the user login name; for example, `Nuance\JWyman`.

**Authentication Type**

Sets the type of authentication used on the HTTP server you specified as the **Address** in the **Roaming User Network Location** dialog box. Select the type that indicates how your server is configured:

- **Basic:** Choose if the server is configured for Basic authentication, where the username and password are passed over the network as clear text

- **Digest:** Choose if the server is configured for Digest authentication, where the passwords are never transmitted across the Internet in unencrypted form. Digest is not supported for IIS.

Note: Digest authentication through a proxy server with Internet Information Server (IIS) 6.0 is not supported.
Chapter 4: Setting Up and Dictating with Roaming Users

Note: For security reasons, be sure that anonymous logins are disabled on the HTTP or HTTPS server.

Connection

Follow Redirects
If you are storing the Master Roaming User Profiles on a server that redirects incoming connections to another location, you can define how Dragon handles these redirects:

- **Never**: redirects are never followed, but ignored.
- **Always**: redirects are always followed.
- **Same Scheme Only**: only redirects using the same scheme as the client request are permitted.

Keep Connection Alive
This setting tells the client and server to keep the connection alive after the current session ends.

Firewall and Proxy Servers

Use Proxy Server if you are connecting to your HTTP server through a proxy server.

Type
Select **Use Proxy Server** if you are connecting to your HTTP server through a proxy server.

Select the type of firewall used on the HTTP server from the drop-down list:

- **HTTP Proxy**: Select for a proxy server that specializes in HTML (web page) transactions.
- **Tunnel**: Select if you are connecting to the server with tunneling software.
- **SOCKS4**: Select for a SOCKS4 protocol that relays TCP sessions at a firewall host to allow application users transparent access across the firewall. SOCKS4 doesn’t support authentication, UDP proxy. SOCKS4 clients require full Domain Name Service (DNS).
- **SOCKS5**: Select for a SOCKS5 protocol that relays TCP sessions at a firewall host to allow application users transparent access across the firewall. SOCKS5 supports multiple authentication methods. SOCKS5 clients use the SOCKS5 server to perform the DNS lookup.

Server
Enter the server name provided by your network administrator.

Port
Enter the port number needed to connect to the proxy server or firewall.

Username
Enter any username needed to log in to the proxy server or firewall.

Password
Enter any password needed to log in to the proxy server or firewall.

Firewall Data or Proxy Authorization
Enter any special authentication string provided by your network administrator.
Timeouts

Lock Timeout

Set to the number of seconds the server should wait before breaking the lock on any open Master Roaming User Profiles. Setting the lock to 0 uses the default setting from the server. Specifying another time overrides the server default. The administrator is responsible for breaking this type of lock.

A network locks prevent anyone from opening a Master Roaming User that someone else has already opened. While this process does not take a long time, network problems can cause a lock to become “stuck” and not release when the opening process is completed. When this happens, the next time you try to open that user, you see a message informing you of the lock. The Administrator has to break the lock.

Connection

Number of seconds before Dragon should close the connection to the server either when the connection is idle or after the connection has been open for that duration.

Connection Timeout Type

Sets when the connection timeout in the previous text box applies:

- **Inactivity**: Closes the connection after the roaming user is inactive for the specified time.
- **Absolute**: Closes the connection after the specified time independent of any roaming user network activity. Use this option with caution, as it could close the connection during synchronization.

Test Connection

Once you have filled in the information, you can click the Test Connection button to test the connection to the HTTP server.

Restore Defaults

Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.

Setting up HTTP Connection: HTTP Settings

You use the HTTP Settings dialog box to define and configure the connection to your web (HTTP) server. Enter information about your connection in the following sections and text boxes of the dialog box:

Authentication

Password

Defines how the roaming user enters the server username and password. This username/password is to the server, not a local login:

- **Prompt for User and Password**: Select if local users will be prompted for a username/password when they connect to the HTTP server.

- **User/password**: Sets the default username/password needed to connect to the HTTP server. Be sure to put the domain name followed by a backslash in front of the user login name; for example, Nuance\JWyman.
Authentication Type

Sets the type of authentication used on the HTTP server you specified as the Address in the Roaming User Network Location dialog box. Select the type that indicates how your server is configured:

- **Basic**: Choose if the server is configured for Basic authentication, where the username and password are passed over the network as clear text.

- **Digest**: Choose if the server is configured for Digest authentication, where the passwords are never transmitted across the Internet in unencrypted form. Digest is not supported for IIS.
  
  Note: Digest authentication through a proxy server with Internet Information Server (IIS) 6.0 is not supported.

  **Note**: For security reasons, be sure that anonymous logins are disabled on the HTTP or HTTPS server.

Connection

Follow Redirects

If you are storing the Master Roaming User Profiles on a server that redirects incoming connections to another location, you can define how Dragon handles these redirects:

- **Never**: redirects are never followed, but ignored.

- **Always**: redirects are always followed.

- **Same Scheme Only**: only redirects using the same scheme as the client request are permitted.

Keep Connection Alive

This setting tells the client and server to keep the connection alive after the current session ends.

Firewall and Proxy Servers

Use Proxy Server

Select **Use Proxy Server** if you are connecting to your HTTP server through a proxy server.

Type

Select the type of firewall used on the HTTP server from the drop-down list:

- **HTTP Proxy**: Select for a proxy server that specializes in HTML (web page) transactions.

- **Tunnel**: Select if you are connecting to the server with tunneling software.

- **SOCKS4**: Select for a SOCKS4 protocol that relays TCP sessions at a firewall host to allow application users transparent access across the firewall. SOCKS4 doesn’t support authentication, UDP proxy. SOCKS4 clients require full Domain Name Service (DNS).

- **SOCKS5**: Select for a SOCKS5 protocol that relays TCP sessions at a firewall host to allow application users transparent access across the firewall. SOCKS5 supports multiple authentication methods. SOCKS5 clients use the SOCKS5 server to perform the DNS lookup.
Server
Enter the server name provided by your network administrator.

Port
Enter the port number needed to connect to the proxy server or firewall.

Username
Enter any username needed to log in to the proxy server or firewall.

Password
Enter any password needed to log in to the proxy server or firewall.

Firewall Data or Proxy Authorization
Enter any special authentication string provided by your network administrator.

Timeouts

Lock Timeout
Set to the number of seconds the server should wait before breaking the lock on any open Master Roaming User Profiles. Setting the lock to 0 uses the default setting from the server. Specifying another time overrides the server default. The administrator is responsible for breaking this type of lock.

A network locks prevent anyone from opening a Master Roaming User that someone else has already opened. While this process does not take a long time, network problems can cause a lock to become "stuck" and not release when the opening process is completed. When this happens, the next time you try to open that user, you see a message informing you of the lock. The Administrator has to break the lock.

Connection

Number of seconds before Dragon should close the connection to the server either when the connection is idle or after the connection has been open for that duration.

Connection Timeout Type
Sets when the connection timeout in the previous text box applies:

- **Inactivity**: Closes the connection after the roaming user is inactive for the specified time.

- **Absolute**: Closes the connection after the specified time independent of any roaming user network activity. Use this option with caution, as it could close the connection during synchronization.

Test Connection
Once you have filled in the information, you can click the Test Connection button to test the connection to the HTTP server.

Restore Defaults
Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.

Setting up secure web server connection: SSL Settings
You use the SSL Settings dialog box to define and configure the connection to your secure web (HTTPS) server. Enter information about your connection in the following sections and text boxes of the dialog box:
Certificate Store

Here you indicate the type of certificate that provides server identity, certificate, and public key information to clients that try to establish a connection:

Certificate Store Type

Select the certificate store type used for the client certificate on the local machine:

- **User (default):** For Windows, choose if the certificate store is a certificate store owned by the current user. For Java, choose if the certificate store is the name of a JKS (Java Key Store) file. If the provider is OpenSSL, choose if the certificate store is a file that contains the PEM encoded certificate and private key.

- **Machine:** Choose if the certificate store is a machine store (not available in Java or when provider is OpenSSL).

- **PFX file:** Choose if the certificate store is the name of a Private Key Server or PFX (PKCS12) file containing certificates. If the provider is OpenSSL, the file may contain only one certificate and private key.

- **PFX Blob:** Choose if the certificate store is a string (binary or base64 encoded) representing a certificate store in PFX (PKCS12) format.

- **PEM Key:** Choose if the certificate store is a string or file name that contains a Privacy Enhanced Mail (PEM) encoded certificate and private key. This store type is currently not supported in Java.

Certificate Store

The name of the certificate store for the client certificate on the local machine:

The storage location is called the certificate store. A certificate store will often have numerous certificates, possibly issued from a number of different certification authorities:

- **MY:** A certificate store holding personal certificates with their associated private keys.

- **CA:** A certificate store holding Certifying Authority (CA) certificates.

- **ROOT:** A certificate store holding ROOT certificates.

- **SPC:** A certificate store holding Software Publisher Certificate (SPC) certificates.

- **Other:** Any other Certificate Store not listed above.

**Notes:**

- If you select PFX file for the **Certificate Store Type**, for the **Certificate Store** select **Other** and enter the name of the file in the associated text box below it.

- If you select PFX Blob for the **Certificate Store Type**, for the **Certificate Store** select **Other** and enter the binary contents of a PFX file (for example, the PKCS12) in the associated text box below it.

- If you are using OpenSSL, for the **Certificate Store** select **Other** and enter the name of the file containing a certificate and a private key in the associated text box.
Certificate Store Password

The password for the Certificate Store on the local machine if one is required.

Open SSL

Select Using OpenSSL if the HTTPS server uses OpenSSL as a Certificate Authority. OpenSSL is a free non-commercial implementation of SSL.

When you select Using OpenSSL, you must provide:

- **Cipher List**: A string that controls the ciphers to be used by SSL. The cipher list consists of one or more cipher strings separated by colons.

- **Certificate Authority File**: Name of the file containing the list of certificate authorities (CAs) trusted by your application. The file set by this property should contain a list of CA certificates in PEM format.

- **CA Directory**: Path to a directory containing CA certificates. The path set by this property should point to a directory containing CA certificates in PEM format.

General

Use this section to enable/disable the supported security protocols on the HTTPS server.

- **TLS1**: Version 1 of the Transport Layer Security (TLS) protocol.
- **SSL3**: Version 3 of the Secure Sockets Layer (SSL) protocol.
- **SSL2**: Version 2 of the Secure Sockets Layer (SSL) protocol.
- **PCT1**: Version 1 of the Private Communications Transport (PCT) protocol.

Notes:

- Although a number of sites still support SSL2, Nuance recommends that you disable it because of potential security vulnerabilities.
- If you select Using OpenSSL, this functionality is provided by the Cipher List.

Test Connection

Once you have filled in the information, you can click the Test Connection button to test the connection to the HTTPS (SSL) server.

Restore Defaults

Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.

Testing and troubleshooting an HTTP connection

Once you have supplied all the necessary information needed to connect to your HTTP server, press the Test Connection button. The Test Connection button tests the connection to your HTTP server based on the information you supplied in the Roaming User Network Location and HTTP Settings dialog boxes.

Troubleshooting test connections

The table below lists the possible messages you might receive after pressing the Test Connection button.
<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection test successful!</td>
<td>None—test successful.</td>
</tr>
<tr>
<td>Could not connect to the network location</td>
<td>▪ Check spelling and syntax of the HTTP address in the <a href="#">HTTP Settings</a> dialog.</td>
</tr>
<tr>
<td></td>
<td>▪ Check your local network for problems.</td>
</tr>
<tr>
<td>Could not copy a file to the network location</td>
<td>▪ Check create and write privileges on the server</td>
</tr>
<tr>
<td></td>
<td>▪ WebDav Server not installed or active.</td>
</tr>
<tr>
<td>Could not create a directory on the network location</td>
<td>▪ Check the create directory privileges on the server for the Master Roaming directory.</td>
</tr>
<tr>
<td></td>
<td>▪ Check the privileges for creating sub-directories under the Master Roaming directory.</td>
</tr>
<tr>
<td>Could not delete a file from the network location</td>
<td>▪ Check permissions on the Master Roaming directory. The user must have read, write, and modify privileges.</td>
</tr>
<tr>
<td></td>
<td>▪ Check that privileges are inherited in the subdirectories.</td>
</tr>
<tr>
<td>Could not delete a directory from the network location</td>
<td>▪ Check permissions on the Master Roaming directory. The user must have read, write, and modify privileges.</td>
</tr>
<tr>
<td></td>
<td>▪ Check that privileges are inherited in the subdirectories.</td>
</tr>
<tr>
<td>Could not copy files into a directory created on the network location</td>
<td>▪ Check permissions on the Master Roaming directory. The user must have read, write, and modify privileges.</td>
</tr>
<tr>
<td></td>
<td>▪ Check for authentication time-out on your server.</td>
</tr>
<tr>
<td></td>
<td>▪ Check your local network for problems.</td>
</tr>
<tr>
<td>Could not list the contents of a directory created on the network location</td>
<td>▪ Check permissions on the Master Roaming directory. The user must have read, write, and modify privileges.</td>
</tr>
<tr>
<td></td>
<td>▪ Check that privileges are inherited in the subdirectories.</td>
</tr>
</tbody>
</table>
### Setting/selecting Roaming User options

The **Administrative Settings** dialog box also contains several options that you can choose from to indicate how you want a Roaming User to function at each Roaming User location.

These options can effect how much data is transferred across your network when the Master and Local Roaming Users are synchronized. For more information, see [Estimating Network traffic caused by synchronization](#) and [How Dragon Synchronizes Master and Local Roaming users](#).

#### Roaming Options on the Administrative Settings dialog box

**Allow non-Roaming Users to be opened**

Select this box to permit the user to open non-Roaming (local) users. Nuance recommends

<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents of newly created directory TempDir were incorrect</td>
<td>Caused by an incomplete directory listing. Try again. If the problem persists, check the condition of your network.</td>
</tr>
</tbody>
</table>
| Could not copy a file from the network location | - Check permissions on the Local Master Roaming directory.  
- Check that the Local Master Roaming directory exists.                                                                                                                                             |
| Could not get the size of a newly created directory on the network location | ![| Could not rename a file on the network location | - Check permissions on the Master Roaming directory. The user must have read, write, and modify privileges  
- Check that privileges are inherited in the subdirectories.                                                                                                                                         |
| Could not rename a directory on the network location | - Check permissions on the Master Roaming directory. The user must have read, write, and modify privileges  
- Check that privileges are inherited in the subdirectories.                                                                                                                                         |
| Could not copy a directory within the network location | - Check permissions on the Master Roaming directory. The user must have read, write, and modify privileges  
- Check that privileges are inherited in the subdirectories.                                                                                                                                         |
clearing this option to prevent anyone from dictating with a non-Roaming (local) user by accident. You may want to set this option temporarily in order to convert non-roaming (local) users to Roaming Users, and then clear it when you are done.

**Merge contents of vocdelta.dat into network user when file is full**

Select this box to copy the contents of the local *vocdelta.dat* file to the master Roaming User without running the Acoustic and Language Model Optimizer.

If you do not set this option and if you have not run the Acoustic and Language Model Optimizer for a long time, the user will see a message when the vocdelta.dat file becomes full. If you do not run the Acoustic and Language Model Optimizer regularly, you should set this option to prevent end users from seeing this message.

Vocdelta.dat is the file used to store vocabulary changes in the Master Roaming User. It is updated whenever a Local Roaming User is closed, and it is used to update the Local Roaming User Profile with vocabulary changes every time that user is opened. When you run the Acoustic and Language Model Optimizer on the Master Roaming User, *Dragon* incorporates the contents of vocdelta.dat into the vocabulary (.voc) file and clears the content of vocdelta.dat.

If you check this setting, *Dragon* monitors the size of the *vocdelta.dat* file. When the *vocdelta.dat* file reaches 90% of it’s maximum size (500KB), *Dragon* incorporates the contents of the vocdelta.dat file into the vocabulary (.voc) file and clears vocdelta.dat.

This operation occurs when the user opens the local Roaming User. This operation can take a long time because the vocabulary file must be transferred over the network twice. Subsequently, opening the local roaming user on another workstation can also take a long time because the entire vocabulary file must be copied from the master to the local roaming user.

Selecting this option will transfer at maximum 500 KB, or 12 bytes/word across the network at synchronization if the Roaming and Local copies are different.

**Access network at user open/close only**

Select this box to synchronize changes made to the local Roaming User to the Master Roaming User only when a local Roaming User opens or closes. If this box is not selected, then these local changes are immediately transferred to the Master Roaming User. The only changes affected by this setting are the changes a user makes locally from the Options dialog box, therefore this setting is highly unlikely to have a perceptible impact on *Dragon’s* performance.

At synchronization, setting this option will copy approximately

- 13 MB of vocabulary files (*.voc).
- 240 MB of acoustic archive files create for each dictation session (acarchive.nwv and acarchive.enwv).

**Note:** These files are only copied from the Local to the Roaming User; they are never copied to Roaming User to the Local User.

These file will synchronize across the network when:

- Vocabulary files - when the Local user modifies the vocabulary with information from the Add Words from Documents, Add Words from Email, or Vocabulary Optimizer dialogs or when the Roaming and Local copies are different.
- Acoustic archive files - these files will be copied to session folder if it exists. Once the master voice_container limit is reached, nothing more is copied.
Ask before breaking locks on network users (recommended for UNC and mapped drives)

Select this box to keep the option of maintaining or breaking a network lock when opening a Roaming User. Normally, network locks prevent anyone from opening a Roaming User at the same time someone else is opening that user. While this process does not take a long time, network problems can cause a lock to become "stuck" and not release when the opening process is completed. When this happens, the next time anyone tries to open that user, Dragon displays a message stating that the user is locked and giving them the option of overriding it. If you do not want this message displaying and always want to break a network lock in this situation, you can clear this option to prevent the message from appearing. Because the presence of a lock can indicate a problem that needs to be addressed, Nuance recommends that you enable this option.

Notes:

- This option is valid for users connecting to the Master Roaming User location using a mapped drive or UNC drive, but is not supported for users connecting over HTTP.
- Be careful when in breaking a locked Roaming User Profile. For example, if you break a lock when another user is writing to the Master Roaming User, breaking the lock may corrupt the Master Roaming User Profiles.
- If a user opens a Roaming User while the Acoustic and Language Model Optimizer is running on the Master Roaming User, the user will see a message but can continue.

Set audio levels on each machine (recommended)

Select this box to run the Check your audio settings option from the Accuracy Center window before your first session with a Roaming User. This includes the Volume Check and the microphone Quality Check. Check this option if your users are dictating on different machines or on a single machine, like a laptop, in many different locations. When a user changes machines or locations, the audio setup data can vary depending on differences in the microphone and sound card, as well as differences in ambient sound levels of each Roaming User location. In situations where Dragon detects a significant difference between operating systems, sound cards, microphones, or other hardware, the program will prompt you to run Check your audio settings even if you do not have this option selected.

Copy Dragon Log to Network

Select this box to copy the Dragon.log file from the local workstation to the master Roaming User location whenever the program synchronizes the local and master Roaming User. Dragon.log contains information that can help to diagnose problems that your users might encounter using Dragon.

Note: The Dragon.log file will not be copied once the maximum size is reached in the Disk space reserved for network archive option.

Selecting this option can increase how long it takes to close a Roaming User. It can also limit the usefulness of the Acoustic and Language Model Optimizer because it reduces the amount of acoustic data that can be stored in the network archive. Nuance recommends that you not set this option unless requested by Nuance Technical Support.

Selecting this option will transfer 1 MB or less of data across the network at synchronization. These files are only copied from the Local Roaming User to the Master Roaming User; they are never copied from the Master Roaming User to the Local Roaming User.

Always copy acoustic information to network

Select this box to copy the user’s acoustic model (.usr and .sig files) to the Master Roaming
User location.

If you chose not to copy the user’s acoustic information to the network, updates to the acoustic model that you make on one machine (for example by correcting and training words) will not be available on other machines used by that particular Roaming User until you run the **Acoustic and Language Model Optimizer** on the Master Roaming User location and the Local and Master Roaming users synchronize. Therefore, if you do not run the **Acoustic and Language Model Optimizer** on the Master Roaming Users regularly, you should set this option. By always copying the acoustic information to the Master Roaming User location, you ensure these accuracy improvements will be available when the Master Roaming User is opened from another location. However, setting this option can increase the amount of time it takes to close a Roaming User.

The transfer of acoustic information based on this option’s setting is not limited by setting the **Disk space reserved for network archive** option.

Setting this option will copy approximately 15 MB across the network at synchronization if the Roaming and Local copies are different.

**Conserve archive size on network**

Select this box to prevent copying of .DRA files (files that contain the acoustic data from the latest dictation session) to the Master Roaming User location when the program synchronizes the Local and Master Roaming users. Leaving this box unchecked allows the local .DRA files to synchronize with the Master Roaming User, which makes the .DRA files available to the **Acoustic and Language Model Optimizer** when it is run on the Master Roaming User locations and provides increased accuracy.

However, because .DRA files can be large, if you experience excessive network slowdowns, checking this option may solve the problem by eliminating the copying of these files each time the Master and Local Roaming users synchronize. You can still run the **Acoustic and Language Model Optimizer** on the Master Roaming User, but since it will not have the .DRA files to process, the accuracy gains will be less.

Note: The .DRA files will not be copied once the maximum size is reached in the Disk space reserved for network archive option.

At synchronization, setting this option will copy approximately 1.3 MB for each minute of dictation saved in the .DRA files. These files are only copied from the Local Roaming User to the Master Roaming User; they are never copied from the Master Roaming User to the Local Roaming User.

**Disk space reserved for network archive**

Use this option to specify the maximum size of the directory containing the acoustic data (the .dra and the log files) available to the **Acoustic Optimizer**. By default the archive size is 500 MB per dictation source. To conserve space, you can reduce the default size and select the Conserve archive size on network option.
Creating a Roaming User on the local machine

There are two ways to create a Roaming User:

- Train a new Roaming User
- Convert a non-roaming local user into a Roaming User

To open or create a Roaming User, your local installation of Dragon must be configured for Roaming Users. For more information, see Enabling the Roaming User on each machine where a user will dictate.

Notes:

- If you use a variety of microphones or input devices with your Roaming User, see the topic: Using multiple dictation sources with a single user.
- If you modify a master Roaming User while you have a local Roaming User open on a computer that is not currently connected to the network (for example, a laptop at a remote location), the changes to the master Roaming User will overwrite any changes you make to the local Roaming User when you synchronize the local and master Roaming Users.
- When a Roaming User exits Dragon, switches users, closes a user, or saves a user, Dragon saves changes to the Local Roaming User and then synchronizes these changes with the Master Roaming User on the network. For more information, see How Dragon Synchronizes Master and Local Roaming users.

Creating and training a new Roaming User

To create and train a new Roaming User:

1. To display the Open User dialog box, select **Dragon > Open Users** on the **DragonBar**.

   **Note:** When the Roaming User feature is enabled, users can create only Roaming Users. The Location of user files field displays only the Roaming User locations you defined in the Administrative Settings dialog box. To let the users create both local (non-roaming) and Roaming Users, select the Allow non-Roaming Users to be opened option on the Roaming tab of the Administrative Settings dialog box. Clearing this option prevents users from dictating with a non-roaming local user by accident. For more information, see Enabling the Roaming User on each machine where a user will dictate.

   If you allow users to open both non-roaming local and Roaming Users, be sure they select the correct location from the Location of user files field.

   If there are multiple roaming user locations, make sure each user selects the correct location from the Location of user files field.
2. Click New and begin training the user as you would any other user.

3. When you are finished training the user, the program saves the User Profiles into the master Roaming User location specified in the Location of user files field.

### Converting a non-roaming local user into a Roaming User

You can convert an existing non-roaming local user to a Roaming User from the Manage Users dialog box. Converting a non-roaming local user copies that user to the Master Roaming User location.

To convert a non-roaming user to a roaming user:

1. Select Dragon > Manage Users from the DragonBar. This action displays the Manager Users dialog box.

2. In the Location of user files drop-down list at the bottom of the dialog box, select the non-roaming local location of your User Profiles. Now the list under Users should include all the non-roaming local users that you can convert to Master Roaming Users.

3. Select the non-roaming local user you want to convert to a Master Roaming User.

4. Click the Advanced button and then select Save to Roaming from the menu that pops up. The Save to Roaming dialog box appears.

5. Select the appropriate Master Roaming User location from the drop-down list and click OK. A Master Roaming User location appears in this list only if it is currently available to the local machine.

6. Repeat the process for any other non-roaming local users you want to convert to Master Roaming Users.

### Dictating with a Roaming User

You dictate with a Roaming User the same way you would with any other user. For specific information about working with a Roaming User, refer to the following topics:

- Opening a Roaming User
- Using multiple dictation sources with a single user
- Running the Acoustic and Language Model Optimizer for Roaming Users
- Synchronizing Master and Local Roaming users

### Opening a Roaming User

When the Roaming User feature is enabled, you can only open Roaming Users (unless you set an option allowing speakers to open both Roaming and Local Users).

To open a Roaming User:

2. On the Open User dialog box, select a user from the list, and click Open. If you do not see the user you are looking for, press F5 to refresh the list of users.

Notes:

- If you allow users to select both non-roaming local and Roaming Users, make sure they select the correct location from the Location of user files drop-down list.

- When the Roaming User feature is enabled, you can only open Roaming Users. The Location of user files drop down list displays only the Roaming User locations you defined in the Administrative Settings dialog box. To let the users open both local (non-roaming) and Roaming Users, select the Allow non-Roaming Users to be opened option in the Administrative Settings dialog box. Clearing this option prevents users from dictating with a non-roaming local user by accident. For more information, see Enabling the Roaming User on each machine where a user will dictate.

- If you connect to your Roaming User Master Directory over HTTP or HTTP with SSL, and you find that not all your users are listed in the Open User dialog box, make sure that:
  - The .INI extensions is registered in MIME types (ini.png) list of your IIS server.
  - Add all file extensions within your Master Roaming User directories and subdirectories to the Registered MIME types list of your IIS server. You could also add a wildcard (.*) MIME-type. For more information on adding a wildcard (.* ) MIME-type, see:
  - The user’s topics.ini and acoustics.ini files are not locked, password protected, or otherwise access restricted by your server permissions.

Using multiple dictation sources with a single user

It is possible to have a variety of dictation sources (audio input devices) for a single set of User Profiles so that the speaker can deploy various microphones or portable recording devices. This ability is especially useful with a Roaming User. By allowing multiple dictation sources, you can still have the same User Profiles for each location regardless of the microphone type.

To add a new dictation source to a user

1. In the Open User dialog box, select the user to dictate with the new dictation source.

2. Click the Source button and then click New. The New Dictation Source dialog box appears.

3. Select a new input device for dictation from the list on the New Dictation Source dialog
box. You can choose from among different microphone or recorder types.

4. Click **OK**. You return to the **Open User** dialog box.

5. Select the user you just created and click **Open**. If you have not previously trained the user with the new dictation source, the **New User wizard** appears and you can begin training.

**Running the Acoustic and Language Model Optimizer for Roaming Users**

When the Roaming User feature is enabled on a workstation, that workstation cannot run the **Acoustic and Language Model Optimizer** or the **Acoustic and Language Model Optimizer Scheduler** because the optimizer or scheduler can only be run on the Master Roaming User. Later, any optimizations done by the **Acoustic and Language Model Optimizer** are copied to each Local Roaming User when **synchronization** occurs.

The system administrator is responsible for running the **Acoustic and Language Model Optimizer** on the network location of the Master Roaming Users. The administrator can install **Dragon** on the machine where the Master Roaming User Profiles are located or an administrator’s machine that has network access to the Master Roaming User Profiles and run the **Scheduler** for the **Acoustic and Language Model Optimizer**. If possible, the administrator's workstation should be co-located with the server because a large amount of data needs to be transferred between the server and the workstation running the optimizer.

**Note:** You must have Windows Administrator privileges on the machine where you are running the **Scheduler** for the **Acoustic and Language Model Optimizer**.

**To run the Acoustic and Language Model Optimizer to optimize Roaming Users**

1. Be sure that a copy of **Dragon** is installed on the computer where you plan to run the **Acoustic and Language Model Optimizer**. Also be sure that the Roaming User capability is not enabled.

2. On the Windows **Start** menu, select **Programs > Dragon NaturallySpeaking 10.0 > Dragon NaturallySpeaking Tools > Scheduler for Acoustic and Language Model Optimizer** to start the **Acoustic and Language Model Optimizer Scheduler**.

3. Access the master directory of the Roaming Users you want to optimize: select **File > Set Speaker Directory** from the menu of the **Acoustic and Language Model Optimizer Scheduler** window. In the **Set User Profile Directory** dialog box, either enter the path of the directory or click the **Browse** button. If the users you want to optimize are located in multiple directories, you can change directories to locate the additional users.

4. Select the user or users you want to optimize and set a schedule for running the **Acoustic and Language Model Optimizer**. For specific instructions, click the **Help** button in the window.
Running the Acoustic and Language Model Optimizer for Roaming Users

When the Roaming User feature is enabled on a workstation, that workstation cannot run the Acoustic and Language Model Optimizer or the Acoustic and Language Model Optimizer Scheduler because the optimizer or scheduler can only be run on the Master Roaming User. Later, any optimizations done by the Acoustic and Language Model Optimizer are copied to each Local Roaming User when synchronization occurs.

The system administrator is responsible for running the Acoustic and Language Model Optimizer on the network location of the Master Roaming Users. The administrator can install Dragon on the machine where the Master Roaming User Profiles are located or an administrator’s machine that has network access to the Master Roaming User Profiles and run the Scheduler for the Acoustic and Language Model Optimizer. If possible, the administrator's workstation should be co-located with the server because a large amount of data needs to be transferred between the server and the workstation running the optimizer.

**Note:** You must have Windows Administrator privileges on the machine where you are running the Scheduler for the Acoustic and Language Model Optimizer.

To run the Acoustic and Language Model Optimizer to optimize Roaming Users

1. Be sure that a copy of Dragon is installed on the computer where you plan to run the Acoustic and Language Model Optimizer. Also be sure that the Roaming User capability is not enabled.

2. On the Windows Start menu, select Programs > Dragon NaturallySpeaking 10.0 > Dragon NaturallySpeaking Tools > Scheduler for Acoustic and Language Model Optimizer to start the Acoustic and Language Model Optimizer Scheduler.

3. Access the master directory of the Roaming Users you want to optimize: select File > Set Speaker Directory from the menu of the Acoustic and Language Model Optimizer Scheduler window. In the Set User Profile Directory dialog box, either enter the path of the directory or click the Browse button. If the users you want to optimize are located in multiple directories, you can change directories to locate the additional users.

4. Select the user or users you want to optimize and set a schedule for running the Acoustic and Language Model Optimizer. For specific instructions, click the Help button in the window.
Using Dragon in a Citrix Presentation Server Environment

Dragon includes support for deploying and running Dragon in a Citrix environment.

**Notes:**

- Citrix is not supported for Dragon Medical Small Practice Edition.
- When you dictate using Dragon Medical in a Citrix environment, you can use all capabilities of the PowerMic II microphone, including all of the device’s standard and programmable button functions and its bar code scanner. The earlier model PowerMic I is not supported.

<table>
<thead>
<tr>
<th>For information on:</th>
<th>See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sizing and Configuring Dragon for Citrix</td>
<td>Sizing and Configuring environment for Dragon in Citrix</td>
</tr>
<tr>
<td>Installing and publishing Dragon on the Citrix server</td>
<td>Installing and publishing Dragon on the Citrix server</td>
</tr>
<tr>
<td>Creating the two Citrix policies needed before Dragon users can access Dragon from their desktops.</td>
<td>Creating Policies for Dragon on the Citrix server</td>
</tr>
<tr>
<td>Using Dragon published on a Citrix Presentation Server with another published application like Microsoft Word.</td>
<td>Making Published Applications Work together</td>
</tr>
<tr>
<td>Setting Up the Program Neighborhood on Citrix clients. This includes:</td>
<td>Setting Up the Program Neighborhood on Citrix clients</td>
</tr>
<tr>
<td>- Enabling sound quality on the client</td>
<td></td>
</tr>
<tr>
<td>- Installing the Citrix Client Update</td>
<td></td>
</tr>
<tr>
<td>Using a Wyse thin computing device running Microsoft Windows XPe to dictate using Dragon</td>
<td>Running Dragon on a Winterm device</td>
</tr>
</tbody>
</table>

**Sizing and performance information**

For sizing and performance information for running Dragon in a Citrix environment, please see:

http://www.nuance.com/naturallyspeaking/citrix

**Sizing and configuring environment for Dragon in Citrix**

Organizations considering deployments of Dragon in a Citrix environment need to consider...
Chapter 5: Using Dragon® in a Citrix Presentation Server Environment

several items for configuring the Citrix environment and scaling client usage on Citrix servers. This section provides some basic guidelines on how to address these issues to ensure maximum performance.

These are guidelines only and not definitive specifications — actual performance will vary from site to site.

Projected User Base

Before considering any deployment of Dragon in Citrix, organizations need to answer key questions about the user base and potential growth. These metrics are essential since they are needed to size the appropriate network and hardware requirements.

- How many users do you plan to enable access to Dragon through a Citrix environment in the first 6 months? 12 months?
- What is the projected distribution of simultaneous user access to Dragon in a Citrix environment?
- Where will these users be physically distributed? On the same corporate LAN, WAN, remote access, or a combination?

Server-Side Hardware

Dragon Version 10 has been tested to run in a Citrix enterprise environment configured with Citrix Presentation Server 4.0, and clients running Citrix ICA thin-client software.

Based on answers to the questions above, your organization will need to scale and deploy an appropriate number of Windows servers to run Citrix Presentation Server 4.0 to support all your Dragon users.

Network bandwidth

The request for network bandwidth when running Dragon derives primarily from requests issued on the virtual audio channel. Nuance recommends and checks for use of the high-quality sound on Citrix to ensure the highest quality of accuracy for speech recognition.

Based on the user population you intend to serve, you must account for and allocate the appropriate amount of network bandwidth for users to be able to utilize Dragon Version 10 from a Citrix client.

Test Results of Running Dragon 10 in Citrix

Listed below are the results of Nuance’s internal testing of Dragon Version 10 in a Citrix environment. The information stated here is only meant to provide guidance for setting up your Citrix environment—it is not a definitive specification.

Your experience using Dragon with Citrix may vary, depending on many factors that might not be addressed in this brief overview. This information should help you accurately size what is required within your Citrix environment for Dragon.

The internal Nuance testing of Dragon Version 10 with Citrix utilized the following components.
Server Hardware

Dell PowerEdge™ 2850:
- Processor: Dual Intel® Xeon™ single-core processor, 3.16 GHz/1MB cache, 800 MHz FSB
- Memory: 4GB DDR2 400 MHz (4x1GB), single ranked DIMMs
- Hard Drive: 146GB 10K RPM Ultra 320 SCSI Hard Drive
- Network Card: Dual Onboard NICs

Dell PowerEdge™ 6850:
- Processor: Quad Intel® Xeon™ single-core processor, 3.16 GHz/1MB cache, Redundant
- Memory: 8GB DDR2 400 MHz (8x1GB), single ranked DIMMs
- Hard Drive: 146GB 10K RPM Ultra 320 SCSI Hard Drive
- Network Card: Dual Onboard NICs

Server Software

Windows Server 2003
Published applications:
- Dragon Medical, Version 10
- Dragon Audio Client Update
- Microsoft® Outlook
- Microsoft® Word 2003

Client Software

- Citrix client user interfaces: ICA 32-bit clients, version 9.x and 10.x
- Program Neighborhood
- Program Neighborhood Agent
- Web Client

PC Client Specifications

- Dell Optiplex™ GX 620 and 745 with Windows XP
- 1024 RAM and 2 GHz CPU
- Sound card: Sound Blaster Live! and on-board sound systems. USB headsets, line-in microphones, and
  (Dragon Medical only) PowerMic II with button support.
Chapter 5: Using Dragon® in a Citrix Presentation Server Environment

Network Specifications

Network speed: 100 Mbps Fast Ethernet

- Network environment and active software run on the server:
  - Latest Citrix Presentation Server 4.0 and 4.5
  - Citrix tools for CPU and memory management were activated to optimize server performance.

A sound card might be necessary for certain server installations.

**Note:** no additional high-memory or CPU-consuming applications were active during testing

CPU Consumption and Memory Usage Running Dragon 10

The following tables show the CPU time and memory usage observed on the Citrix servers with Dragon Version 10 running. The CPU time represents the total time (expressed as a percentage) used by a single client session; the percentage is a total of available CPU. Memory usage is also represented for a single-user session as a percentage of total RAM available.

This information stated is meant only to provide guidance for setting up your Citrix environment—it is not a definitive specification.

**Notes:**

- *Peak CPU consumption is reached when Dragon user profiles are being opened, saved, and closed.*
- *Acoustic training appears to consume the most amount of CPU time for any process executed with Dragon on Citrix. As such, administrative procedures that run any training process need to take this into consideration.*

<table>
<thead>
<tr>
<th></th>
<th>Average</th>
<th>Peak</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU time (Dual processor)</td>
<td>10%</td>
<td>25%</td>
</tr>
<tr>
<td>CPU time (Quad processor)</td>
<td>5%</td>
<td>13%</td>
</tr>
</tbody>
</table>
When other applications are running concurrently with Dragon:

- Dragon consumes the same amount of CPU time as it does when it runs alone.
- Memory usage for Dragon Version 10 increases.

For example, memory usage for Dragon 10 goes up when running together with Microsoft Word 2003.

<table>
<thead>
<tr>
<th>RAM required for a single session, Dragon 10/Microsoft Word 2003</th>
<th>Average</th>
<th>Peak</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>160 MB</td>
<td>190 MB</td>
</tr>
</tbody>
</table>

When Dragon Version 10 is not being used:

- CPU time consumed is 0.
- The same amount of RAM is required.
- Network bandwidth is 1.3 Mbps if the microphone is active; 0 Mbps if the microphone is turned off.

<table>
<thead>
<tr>
<th>CPU consumption, performing General Training in New User Wizard, Additional Training or running the Acoustic Optimizer</th>
<th>Average</th>
<th>Peak</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU time (Dual processor)</td>
<td>25%</td>
<td>30%</td>
</tr>
<tr>
<td>CPU time (Quad processor)</td>
<td>12%</td>
<td>18%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Memory consumption, with one user dictating and correcting in the DragonPad Average</th>
<th>Average</th>
<th>Peak</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM required for both Dual and Quad processor</td>
<td>130 MB</td>
<td>160 MB</td>
</tr>
</tbody>
</table>
Chapter 5: Using Dragon® in a Citrix Presentation Server Environment

Initial Results—Network Bandwidth

Network bandwidth setting for a single Dragon Citrix client MUST be at least 1.3 Mbps.

Note: If the microphone is turned off for an active Dragon session running on Citrix, network bandwidth on a channel drops almost to 0.

Summary

Based on the preceding observations made while testing a single Dragon Version 10 session running on Citrix, it is reasonable to conclude that deployment of Dragon Version 10 will scale linearly in a Citrix Presentation Server environment. CPU consumption emerges as the most important limiting factor, as collective CPU time per session will determine how many Dragon Version 10 sessions can be active at the same time.

Using the hardware and software configurations detailed above, here is the approximate range of Dragon Version 10 sessions that can be expected to run on the Citrix Presentation Server 4.0:

- **Maximum Load:** In a realistic scenario, where multiple sessions are performing different types of activities (opening, saving and closing users, dictating, and correcting dictation), it can be expected that 6 concurrent Dragon Version 10/Citrix sessions can be executed.

- **Minimum Load:** Expect to run 4 concurrent Dragon Version 10/Citrix sessions in the case when all Dragon sessions are running acoustic training.

Installing and publishing Dragon on the Citrix server

*Dragon Medical* includes support for deploying and running Dragon in a Citrix environment. Dragon can be run through the Citrix Webclient, Program Neighborhood Agent, and/or the Program Neighborhood.

Requirements

**Server:**

Citrix Presentation Server 3.0 or 4.0 (Enterprise and Advanced Editions).

*Note: Standard Edition is not supported.*

Please check [http://www.citrix.com](http://www.citrix.com) to download the latest patches.

**Client:**

Citrix ICA clients 9.x

*Note: The Citrix client must be running Windows 2000 Service Pack 4 or higher, Windows XP Professional, or Windows XP Home (with SP1 or SP2).*
Installing and publishing Dragon on the Citrix server

1. Install *Dragon* as you normally would other applications that you make available on the Citrix server, noting the installation directory.

2. Publish *Dragon* as follows:

   - If you installed *Dragon*, you must publish it as an **Application**:

     ![Application Type]

     When publishing *Dragon* from the *Presentation Server Console*, use `natspeak.exe` as the *Dragon* executable. By default the *Dragon* applications are installed to:

     ```
     \Program Files\Nuance\NaturallySpeaking10\Program
     ```

     For example:

     ![Command Line]

   - If you installed the *Dragon SDK Client Edition*, you must publish the SDK as a Desktop from the *Citrix Presentation Server Console* in order to view and run the sample programs from a client.

     ![Application Type]

     3. In the *Specify Client Requirements* dialog box, check the **Enable legacy audio** setting. For example, if you are using the Program Neighborhood:
4. Publish the Dragon Citrix Client Update as Content:

When publishing the Dragon Citrix Client Update from the Presentation Server Console, use vddnspatch.exe as the Citrix Client Update executable. For example:

```
C:\Citrix\Program Files\Nuance\NaturallySpeaking9\Program\vddnspatch.exe
```

Notes:

- You must install this Client Update directly on each client computer. For more information, see Setting Up the Program Neighborhood on Citrix clients.
- You must have administrator rights to install the Citrix Client Update.
- You do not need to re-install the Citrix Client Update if was already installed as part of an MSI installation. See Installing the Citrix Client update for an MSI installation for more information.

Creating Policies for Dragon on the Citrix server

You must create two policies for Dragon before users can access Dragon Medical from their desktops.

Create the AudioIn policy

1. From the Presentation Server Console, select Policies and click the Create Policy button (or select Actions > Policy > Create Policy from the menu) to create a policy named AudioIn.

2. Select the AudioIn policy and then click the Properties button (or select Actions > Properties from the menu) to set the properties. Use the Properties dialog to enable

Client Options

These settings control defaults for users that connect to the application with Program Neighborhood.

- Enable legacy audio
Microphones so the client’s microphones can be used for audio input. For example:

3. Select the *AudioIn* policy and then click the **Apply this policy to** button (or select **Actions > Policy > Apply this policy** … from the menu) to specify which users can use the AudioIn policy (in other words, all users who will use Dragon). This displays the **Policy Filters** for the *AudioIn Policy* – select **Users** and grant access to the appropriate users.

**Create the AudioOut policy**

1. From the **Management Console**, select **Policies** and click the **Create Policy**… button (or select **Actions > Policy > Create Policy** from the menu) to create a second policy named *AudioOut*.

2. Select the *AudioOut* policy and then click the **Properties** button to set the properties to enable the **Sound Quality** and set the client audio quality to **High sound quality; lowest performance**. For example:

3. Select the *AudioOut* policy and then click the **Apply this policy to** button (or select **Actions > Policy > Apply this policy** … from the menu) to specify which users can use the *AudioOut* policy (in other words, all users who need access to Dragon). This displays the **Policy Filters** for the *AudioOut Policy* – select **Users** and grant access to the appropriate users.
Chapter 5: Using Dragon® in a Citrix Presentation Server Environment

Making Published Applications Work together

To be able to use a published Dragon with another published application like Microsoft Word in a Citrix environment, both applications must be running in a single Citrix client session. Use the following guidelines to make sure all published applications work together.

For the Administrator

Give users access to applications

There are two ways to give users access to applications:

1. Publish the desktop and let users start applications from the published desktop.
2. Publish all needed applications with identical settings. If the settings are not identical, Dragon may not operate correctly in other published applications. For example, if Microsoft Word is published with different settings than the published Dragon, the microphone hot key will not work in Word.

For the Client

If you published separate applications and not a Desktop, use the following guidelines:

1. All applications must be started in Seamless mode.
2. Don’t change Application Set settings when a published application is running.
3. When using the Smooth Roaming feature with published applications on multiple computers, the user must do one of the following:
   - Close all published applications before moving to a new location.
   - Start the same published applications in the same order on all the machines that are used. If a user left a running published application on one machine and moved to another one, the user should start the same published application on the next machine. In this case, the user will connect to the already running application. For example, if the use left published Word running on one computer, moved to another computer, started published Dragon and then Word, dictation in Word won’t work because Dragon is running in a new session. In this particular case, the user should first start Word and then Dragon.

**Note:**

- Citrix starts two published applications in separate sessions for single user when:
  1. The applications are published with different settings (Colors, Enable Legacy Audio, Encryption). Citrix places applications into isolated Windows sessions if the color settings are different. Using different color settings may cause problems with dictation. If you have problems with applications with different color settings, use the same color settings for all applications.
  2. Any single application is published as a Desktop.
3. The client does not start the application in *Seamless* mode.

4. A client launches one application, changes *Application Set* settings, and then launches another application.

5. A user starts different applications from different machines. If the user starts the same application from a different machine, it connects to the same session and disconnects the previous session, as in *Smooth Roaming* feature.

### Setting Up the Program Neighborhood on Citrix clients

After publishing *Dragon* and the *Citrix Client Update*, the Citrix ICA clients should see both programs in their Citrix Program Neighborhood (or Web Client interface). For example:

![Citrix Program Neighborhood](image)

*Note:* When you start *Dragon* from the client, you should change the *DragonBar* mode to *Floating* mode to minimize any problems you may have in displaying any other applications you run from the server.

### Enabling sound quality on the client

Before starting *Dragon* as a published application, you must enable sound on the client for the application set for *Dragon* on each Citrix client.

1. From the Citrix Program Neighborhood, select the *Application Set* that contains *Dragon* and the Citrix Client Update.

2. From this *Application Set* click the *Settings* button.

   The *Settings* dialog for the selected application set displays.

3. Select the *Default Options* tab and unselect the *Sound Server Default* check box; then select the *Enable Sound* check box.
4. In the drop-down list select *High sound quality*. For example:

![Sound quality settings](image)

*Note:* Using the Web Client Interface: If Dragon is published with the *Audio quality* set to *low* on the server but with the *Audio quality* set to *high* on the client through the Program Neighborhood, the client will not receive an *Audio Quality* warning when Dragon is started through the Web Client Interface.

### Installing the Citrix Client Update

If you intend to dictate from the Citrix client, you must run the *Citrix Client Update* before you run *Dragon* for the first time.

1. Double-click the *Citrix Client Update* icon in the Program Neighborhood

![Citrix Client Update](image)

This starts the *Citrix Client Update* installer wizard.

2. When prompted, click *Next* and then *Patch*. Clicking *Patch* starts the installation.

3. When the installation completes, click *Finish*.

After installing the *Citrix Client Update*, you can start *Dragon* to create your users.

*Notes:*
- You must have administrator rights to install the *Citrix Client Update*. 
You do not need to re-install the *Citrix Client Update* if was installed earlier as part of an MSI installation. See [Installing the Citrix Client update for an MSI installation](#) for more information.

- In order to run the *Citrix Client Update*, each client machine must be joined to the network domain of the Citrix server. In other words, the Citrix server must be able to recognize the client’s Windows logon credentials. If the client is not joined to network domain of the Citrix server, you will see the following error when trying to run the Citrix Client Update:

If this is a problem, you can still use network resources by entering your domain user name and password. Before running the *Citrix Client Update*:

1. From the Windows Explorer, click on the **Tools** menu and then click **Map Network Drive**.

2. In **Drive**, type or select the drive letter to map to the shared resource.

3. In **Folder**, type the server and optionally, the share name of the resource, in the form of `\server name\share name`. You can also click **Browse** to locate the resource.

4. Click **Finish**.

5. In the **User name and password** dialog box, type your user name in the form of `domain\user name`.

6. In **Password**, type your domain password.

- If during the installation of *Citrix Client Update* you see the following error message:

  *Unable to set High Sound Quality in your Citrix client. It is recommended that you do this manually*

  Please double-check that the **Audio** settings on your client are set to high. For more information, see [Setting up Citrix Clients](#).

- If you are using a Phillips SpeechMike, set up your system so that sound playback is through a different device and not the SpeechMike. To do this, select **Sound and Audio Devices** from the Windows control panel and use the **Audio** tab to set your **Sound playback** and **Sound recording** devices.

- There must be sound system installed on the client. For example, if your client has disabled USB audio, you cannot create a *Dragon* user. If you disable USB audio, enable it and re-connect to the Citrix server.
Running Dragon on a Wintern device

If you want to dictate with Dragon Medical on a Wyse thin computing device (Wintern) running Microsoft Windows XP Embedded (XPe), you must run the Citrix Client Update on that device before you run Dragon for the first time.

*Note:* This procedure has only been tested with the Wyse S90 with native support for ICA client 9.x.

To prepare a WinTerm device for Dragon in a Citrix environment, please follow these steps:

1. Log into the Wyse thin computing device as an Administrator
2. From the Administrator account, disable the Enhanced Write Filter (EWF).

   You can disable the EWF from the Administrator desktop or the DOS command line.

   You need to disable the EWF because it blocks write operations on the flash memory itself needed to install the Dragon Citrix Client update.

3. Open the Citrix Program Neighborhood, enable sound on the client for the application set for Dragon.

   For more information, see Setting Up the Program Neighborhood on Citrix clients.

4. From the Wyse thin computing device, map a network drive to where the Dragon audio client is published as content.

   You can map the network drive using the Windows Explorer or from the DOS Command Prompt. For example:

   ```
   net use * \server_name\c$ /user:domain_name\user_name * /persistent:no
   ```

5. Install the Dragon audio client by double-clicking the Citrix Client Update icon in the Program Neighborhood and following the Citrix Client Update installer wizard prompts.

6. If needed, log out of the Administrator account

After installing the Citrix Client Update, you can start Dragon to create your users.

*Notes:*

- After installation, the Dragon Citrix Client Update takes up approximately 118 KB of flash memory on the Wintern device.

- If you get a "Sound level is too low" error while creating a Dragon user on the Wintern Device, you will need to manually boost the microphone’s volume. To manually boost the microphone’s volume:

   1. Select Start > Control Panel > Sound and Audio Device (Windows XP) or Sound (Windows Vista)
2. Select
   - **Windows XP**: Audio tab
   - **Windows Vista**: Recording tab.

3. Boost the microphone volume by:
   - **Windows XP**: double-clicking the *Volume* button under *Sound recording*. This action displays the microphone slider; move the slider all the way to the right to set the maximum boost. If you see a *Boost* check box, select the check box.
   - **Windows Vista**: double-clicking the Microphone icon to display the Microphone Properties dialog (depending on your sound card and microphone, you set the boost from the Levels or Custom tab). If you see a slider to set the boost, move the slider all the way to the right to set the maximum boost. If you see a *Boost* check box, select the check box.

### Disabling or redirecting Citrix Logging

When you start a Citrix ICA session, the ICA client starts and loads the *module.ini* file from the root folder of the Citrix client. This *module.ini* file contain a list of the parameters used to select and configure the communications stack modules.

To save space on the Citrix client, you can disable or redirect Citrix logging:

1. Open the *module.ini* file. By default, the *module.ini* file is located in the Citrix client directory:

   C:\Program Files\Citrix\ICA Client

2. To disable logging:
   - Go to the *[VDDNS]* section.
   - Change the line *LogLevel=2* to *LogLevel=0*

3. To redirect logging to another location or device, locate the line that begins "*LogFileName=*" and change the path in that line.

4. Save and exit *module.ini*. 
Chapter 6

Customizing Vocabularies with the Dragon® Vocabulary Tool
Customizing Vocabularies with the Vocabulary Tool

You use the *Dragon Vocabulary Tool* to customize a vocabulary by adding new words and by optimizing the language model.

This section of the *Administrator Guide* Help describes the *Vocabulary Tool Wizard* and includes the following topics:

- **Starting Voctool** — Starting the *Voctool* UI and command line.
- **Step 1: Selecting a user** — The type of information available that can be modified on the introduction screen.
- **Step 2: Choosing Documents** — Selecting documents for the *Vocabulary Tool* to analyze.
- **Step 3: Choosing Word Lists** — Selecting word lists for analysis.
- **Step 4: Analysis Settings** — Specifying how the *Dragon Vocabulary Tool* analyzes the documents and word list files you chose.
- **Step 5: Analyzing Files** — Confirming the file list; stopping and resuming the analysis.
- **Step 6: Previewing New Words** — Reviewing new words, their frequency, etc.; clearing, editing, saving, and training words from the word list.
- **Step 7: Training Added Words** — Selecting the words to train.
- **Step 8: Build the Language Model** — Building a new language model with the information you collect.
- **Summary Page** — Displaying information about the newly-built language model.
- **Voctool command line switches** — Listing command line switches.

Starting Voctool

There are two ways to start *Voctool*:

- Click *Start > All Programs > Dragon NaturallySpeaking 10 > Dragon NaturallySpeaking Tools > Voctool*.
- You can run the *Vocabulary Tool* using MS-DOS commands. To view a list of command-line switches for running the *Vocabulary Tool*, type `voctool.exe /?` at the prompt inside a command-prompt window. See [Voctool command line switches](#) for a list of switches. By default, *voctool* is located in:

  C:\Program Files\Nuance\NaturallySpeaking10\Program
**Chapter 6: Customizing Vocabularies with the Dragon® Vocabulary Tool**

*Note:* When you start the Voctool, on the **Introduction** page of the wizard you are immediately prompted to select a user/vocabulary. Once you select a user, you can click the **Change User/Vocabulary...** button to change the user only before you proceed with running the Voctool. Do not change the current user or the vocabulary after you make this selection or while you are running the Vocabulary Tool. If you do try to change the user or vocabulary, the Vocabulary Tool stops running and discard any changes.

**Overview: The Vocabulary Tool**

You can use the **Vocabulary Tool** to customize a vocabulary by adding new words and optimizing the language model.

You can use the **Introduction** page in the **Vocabulary Tool** to find and modify the following information:

**User**

The name of the user that the **Vocabulary Tool** modifies.

**Vocabulary**

The vocabulary type you apply when you create a user.

**The Change User/Vocabulary button**

You click this button to open the **Select User** dialog box and choose a different user from a list of available users.

**Using the Introduction page to add words to a vocabulary**

1. Select one of the following two options to add new words to the vocabulary:

   - Use the **Add new words from documents and adapt to writing style** option to instruct the **Vocabulary Tool** to examine the documents you choose in the **Choose Documents** page. In general, you should select documents that reflect the preferred writing style and vocabulary of the person that uses the modified user files for dictation.

   - Use the **Add new words from word list files** option to instruct the **Vocabulary Tool** to examine the files you choose in the **Choose Word Lists** page. When you choose this option, the **Vocabulary Tool** only add words and does not analyze word frequency or otherwise adapt the vocabulary to a particular writing style.

2. Click **Next**.
Notes:

- Do not change the current user or the vocabulary when you run the Vocabulary Tool. If you do try to change the user or vocabulary, the Vocabulary Tool stops running and does not save any changes it made.

- You can use MS-DOS commands to run the Vocabulary Tool. To view a list of command-line switches for the Vocabulary Tool, on a command line, type voctool.exe /?.

The Vocabulary Tool: Choosing Documents

You use the Choose Documents page of the Vocabulary Tool to select documents for the Vocabulary Tool to analyze. The Vocabulary Tool identifies words in a document that are not in the current vocabulary. The tool analyzes the frequency and order of the words in the samples to understand the writing style of the author of the document.

You can modify the list of documents that display on this page, then click Next to proceed with the wizard.

The following information and buttons appear on this page:

The document list

The document list is a list of documents that the Vocabulary Tool will process. If no documents appear in the list, click the Add Folder or Add Document button to find and add a folder or a document. You can use the button to the right of the document list to add and remove documents or folders from the list.

The Add Folder button

You click the Add Folder button to open the Browse for Folder dialog box and select a folder of documents to display in the documents list. You can click the Add Folder button as many times as necessary to add additional folders of documents to the list.

The Add Document button

You click the Add Document button to open the Add Documents dialog box and select documents from a folder to display in the documents list. You can press the CTRL key and select multiple documents at once. You can also press the SHIFT key and select a range of documents by clicking the first and last documents in a range of documents. You can click the Add Documents button as many times as necessary to select different documents to add to the list.

The Remove Document button

You select documents and click the Remove Document button to remove documents from the document list. You can press the CTRL key and select multiple documents at once. You can also press the SHIFT key and select a range of documents by clicking the first and last documents in a range of documents.
Chapter 6: Customizing Vocabularies with the Dragon® Vocabulary Tool

The View Document button

You select a document and click the View Document button to open the document in its native application. For example, if the document has a .doc extension, Microsoft Word starts and displays the document. The appropriate application must be available on your computer for you to view a document.

The Save List button

You click the Save List button to open the Save Document List as File dialog box and save the current list of documents as a .txt file in a folder. The text file contains the names of each file and the full path to each file. The Vocabulary Tool can process the following types of files:

- Microsoft Word (*.DOC)
- Corel WordPerfect (*.WPD)
- ASCII Text (*.TXT)
- Rich Text Format (*.RTF)
- HyperText (*.HTM, *.HTML, *.SHTM, and *.SHTML)

If your computer does not have access to an application that can open a particular type of file, the Vocabulary Tool will not be able to process the document.

The Load List button

You click the Load List button to open the Load Document List from File dialog box and load a file that contains a list of documents. This is the file you create using the Save List button. If you attempt to load a file that does not contain an appropriate file list, an error message displays and the contents of the file do not appear in the document list.

Note: Do not process a document that contains invalid characters or text that does not reflect the writing style of a user represents. Processing the document may damage the vocabulary or decrease the recognition accuracy of Dragon by building a Language Model from examples that do not reflect the dictation style of the user.

The Vocabulary Tool: Choosing Word Lists

You use the Choosing Word Lists page of the Vocabulary Tool to select word lists for the Vocabulary Tool to analyze. The Vocabulary Tool can identify if a word is in the current vocabulary.

A word list is an ASCII text document that contains words or shorts phrases to add to a vocabulary. Each word or phrase should be on an separate line. You can use a backslash (\) to separate the written form of a word from the spoken form of a word. For example: "& Co.\and Company"

The following information and buttons appear on this page:
Word Lists
A list of files that contain the word lists that the Vocabulary Tool can process. You can use the buttons on the right of the Word list to add or remove file names from the list. You can use the Export Words dialog box on the Tools menu of the DragonBar to create a word list file from a current Dragon user.

The Add Word List button
You click the Add Word button to open the Add Word List Files dialog box and to select file names to display in the documents list. You can press the CTRL key and select multiple files at once. You can also press the SHIFT key and select a range of files by clicking the first and last files in a range of files. You can click the Add Word List button as many times as necessary to select different folders that contain files to add to the document list.

The Remove Word List button
You click the Remove Word List button to remove a file or set of files from the documents list. You can press the CTRL key and select multiple documents at once. You can also press the SHIFT key and select a range of files by clicking the first and last files in a range of files.

Note: Do not process a document that contains invalid characters or text that does not reflect the writing style of a user represents. Processing the document may damage the vocabulary or decrease the recognition accuracy of Dragon by building a Language Model from examples that do not reflect the dictation style of the user.

The Vocabulary Tool: Analyzing Settings
You use the Analyze Settings page in the Vocabulary Tool to configure how the Vocabulary Tool analyzes documents and word list files. You use the Choose Documents page or Choose Word Lists the page in the Vocabulary Tool to select documents and word list files.

You can change the following settings:

The Vocabulary Tool: Finding unknown words
You use the Find unknown words option to have the Vocabulary Tool find words that are not already in the vocabulary. This option is only available if the Vocabulary Tool is analyzing documents and not word lists.

The Vocabulary Tool: Find known words with unknown capitalization
You use the Find known words with unknown capitalization option to have the Vocabulary Tool find words that are in the vocabulary but with a different capitalization. Only use the Find known words with unknown capitalization option with word lists that you want to add to a vocabulary to. Otherwise, you might add words to a vocabulary unintentionally.

The Vocabulary Tool: Enable word frequency counting
The Enable word frequency counting option only displays when you select Add new words from documents.
You use the **Enable word frequency counting** option to let *Dragon* count how many times a new word appears in your documents and display that number in the *Vocabulary Tool* after *Dragon* analyzes the documents. The maximum number *Dragon* displays is **100**.

**Note:** If you are analyzing a large set of text, you should disable frequency counting to improve performance.

## The Vocabulary Tool: Preview the list of unknown words

You use the **Preview the list of unknown words** option to make the *Vocabulary Tool* open the *Preview New Words* page and display unknown words and known words with unique capitalization. A *Preview New Words* page appears where you can modify the list and select specific words that the *Vocabulary Tool* found.

## The Vocabulary Tool: Add all unknown words without previewing them

You use the **Add all unknown words without previewing them** option to have the *Vocabulary Tool* skip the *Preview New Words* page. The *Vocabulary Tool* adds all the unknown words and the known words with unique capitalization to the vocabulary without letting you modify the list.

## The Vocabulary Tool: Analyzing Files

You use the **Analyzing Files** page of the *Vocabulary Tool* to analyze the documents and word list files you choose in the *Choose Documents* page or the *Choose Word Lists* page.

The *Analyzing Files* page contains the following information and controls:

### The File list

The file list is a scrollable list that displays the files or documents that the *Vocabulary Tool* is processing.

- A check mark next to a file name indicates that the *Vocabulary Tool* is done its analysis of a file.
- An X mark next to a file name indicates that the *Vocabulary Tool* did not successfully complete its analysis of a file. Reasons why the analysis did not complete include a user pressing the *Stop* button or an error occurring while the *Vocabulary Tool* read the contents of the file.
- An hourglass symbol next to a file name indicates that the *Vocabulary Tool* is currently analyzing the file.

When the *Vocabulary Tool* finishes analyzing all the files in the file list, a message displays below the file list with information about the number of documents the *Vocabulary Tool* analyzed.
The Stop button and the Resume button

You click Stop to stop the Vocabulary Tool from processing a file. You click Resume to have the Vocabulary Tool restart the analysis of a file.

The Progress bar

As the Vocabulary Tool performs analysis of a file, the progress bar displays information about how much of the file the Vocabulary Tool has analyzed.

The Vocabulary Tool: Previewing New Words

You can use the Preview New Words page of the Vocabulary Tool to view the list of words that the Vocabulary Tool identifies as either not in the current vocabulary or as having a unique capitalization. The following information and buttons appear on this page:

Word

You can scroll the Word list and use the check box to the left of a word to tell the Vocabulary Tool to add or not add the word to the vocabulary. Check this option to add a word to a vocabulary. Uncheck this option to not add a word to a vocabulary.

Frequency

Frequency indicates how many times a word appears in the documents the Vocabulary Tool analyzes. This information appears only if you select the Enable word frequency counting option on the Introduction page of the Vocabulary Tool. The maximum number the Vocabulary Tool displays is 100.

Check All

Click the Check All button to check all the words in the Word list.

Clear All

Click the Clear All button to clear all the words in the Word list.

Edit

You can select a word in the list and click the Edit button to open the Edit Word dialog box and change the written form and spoken form of a word. The Edit Word dialog box also displays the context and frequency with which the word appears in the document the Vocabulary Tool analyzes.

Save

You can click the Save button to open the Windows Save As dialog box and save the contents of the Word list as a file. Use the dialog box to provide a name and a location for the file. You
can use this file with the Vocabulary Tool at a later time to modify the vocabulary of other users.

Train added words

You can select the Train added words option to open the Train Added Words page of the Vocabulary Tool and train selected words and fine tune Dragon's recognition of your pronunciation.

The Train added words feature is only available when you run the Vocabulary Tool as part of a normal installation of Dragon. You cannot use the Vocabulary Tool to train words if you are running the DSS SDK edition of Dragon.

The Vocabulary Tool: Training Added Words

You can use the Training Added Words page of the Vocabulary Tool wizard to train Dragon to better recognize your pronunciation.

This feature is available only when you run the Vocabulary Tool as part of a normal installation of Dragon. You cannot use the Vocabulary Tool to train words if you are running the Dragon SDK Server Edition (DSS).

The following information and buttons appear on this screen:

Word

The Word list contains the words you selected on the Preview New Words screen. Select the words you want to train from this list. A check mark in the box to the left of the word indicates that you want to train that word.

Check All

Click the Check All button to select all the words in the Word list.

Clear All

Click the Clear All button to deselect all the words in the Word list.

Train

You can click the Train button to open the Train dialog box where you can train Dragon to recognize your pronunciation of the words you selected. If you have selected more than one word to train, the Train dialog box display the words in the order that they appear in the list.

Note: Only the person that will dictate with the user you are modifying can perform the training. If that person is unavailable for this Vocabulary Tool session, then training can also occur during a Dragon session by clicking Train from the Words menu on the DragonBar.
The Vocabulary Tool: Language Model Build Settings

You can use the **Language Model Build Settings** page of the **Vocabulary Tool** wizard to build a new language model with the information the tool gathers. You also use this page to provide **Dragon** with the location and maximum size of the new vocabulary.

The following settings appear on this page:

**Build language model**

You can use the **Build language model** option to have the **Vocabulary Tool** build a new language model that contains the words and other information you provide to the tool in other pages of the **Vocabulary Tool**.

**Language Model locator**

If you are building a language model for a Solution Series version of **Dragon**, you can select either the **Middle or the User slot** as a location for a language model. If you are building a language model for a Preferred version of **Dragon**, select the **User slot** as the location of the language model.

**Language model size limit (Solution Series or SDK Server Edition only)**

If you build the Language Model into the **Middle slot**, you can use the **Language model size limit** list to limit the size of the model. You can specify a size limit between 0.5 MB and 5 MB. If you do not want to set a limit, select **Unspecified** from the list.

**Existing Model built by:**

You can use the **Existing Model built by** option to specify the version of the **Vocabulary Builder** that created the previous Language Model. This information only appears if the user you are building a language model for has an existing language model.

**Preserve existing model**

This option only appears if the user you are building a language model for has an existing language model. Selecting **Yes** merges the new language model with the current one. Selecting **No** builds a new language model to replace the existing one. Normally, you should accept the recommended value, which can vary depending on the location of the language model and the version of **Dragon**. The recommendations for the Solution Series and Preferred editions of **Dragon** are:

- For **Dragon NaturallySpeaking** Solution Series, middle slot, the recommendation is **No**.
- For **Dragon NaturallySpeaking** Solution Series, user slot, the recommendation is **Yes**.
- For **Dragon NaturallySpeaking** Preferred, user slot, the recommendation is **Yes**.

You cannot build a language model in the middle slot of **Dragon NaturallySpeaking** Preferred edition.
The Vocabulary Tool: Summary Page

The **Summary** page of the **Vocabulary Tool** wizard displays information about the newly built language model. After you review the information on this page, click **Finish** to exit the wizard.

The following information appears on this page:

**Details**

The details box contains the following information:

**User**

The name of the user whose user files the **Vocabulary Tool** modifies.

**Vocabulary**

The base vocabulary type of the user.

**Language**

The language of the vocabulary, including any specific variation of that language, such as United States English.

**Additional information**

The following information may also appear:

- The number of documents analyzed.
- The names of the documents or word lists that were processed.
- The number of unknown words that were found.
- The number of added words.
- Whether the **Vocabulary Tool** saved the previous language model or built a new language model, and if it did, which language model location was used.
- Any warnings or any non-critical errors that might have occurred during processing

**Save speech files**

You can select the **Save speech files** option to save the new speech file so that it is available for future **Dragon** sessions.
Voctool command line switches

When you start the **Voctool** from the command line, you must first switch to the following directory:

```
C:\Program Files\Nuance\NaturallySpeaking10\Program
```

Then type the following syntax:

```
voctool.exe switches
```

where *switches* is one or more (or a combination of) the following:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Required with /S</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>/S</td>
<td>NA</td>
<td>Silent mode - do not display a GUI and do not display messages on the screen when you run voctool.</td>
</tr>
<tr>
<td>/U &lt;user&gt;</td>
<td>Yes.</td>
<td>User name - indicate the user whose vocabulary you are running the voctool on. voctool requires that you use this switch when you use /S.</td>
</tr>
<tr>
<td>/V &lt;vocabulary&gt;</td>
<td>Yes, for an existing vocabulary.</td>
<td>Vocabulary name - voctool requires that you use this switch if the vocabulary exists; otherwise use you must use /VN to create a new vocabulary.</td>
</tr>
<tr>
<td>/VN &lt;vocabulary&gt;</td>
<td>Yes, if vocabulary does not yet exist.</td>
<td>Create a new vocabulary if one doesn’t yet exist for this user. voctool uses the empty new vocabulary as the base vocabulary. voctool requires that you use this switch if the vocabulary does not yet exist; otherwise, if the vocabulary exists, use /V to use the current vocabulary name. If you are using a version of Dragon that does not have base vocabularies, you must include /VB to indicate the base vocabulary alongside /VN.</td>
</tr>
<tr>
<td>/VB &lt;base vocabulary&gt;</td>
<td>No.</td>
<td>Use in conjunction with /VN to indicate the name of the base vocabulary.</td>
</tr>
<tr>
<td>&lt;doc file&gt;</td>
<td>Yes, either this doc./WI with a word list, or /WLI with a list of word lists.</td>
<td>Input document.</td>
</tr>
<tr>
<td>Switch</td>
<td>Required with /S</td>
<td>Purpose</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/DI &lt;doc list file&gt;</td>
<td>No.</td>
<td>A list of input documents - a list of documents to retrieve words from for the vocabulary.</td>
</tr>
<tr>
<td>/DO &lt;doc list file&gt;</td>
<td>No.</td>
<td>A list of output documents - a list of documents to export words from the vocabulary to.</td>
</tr>
<tr>
<td>/WI &lt;word list file&gt;</td>
<td>Yes, either this option, &lt;doc file&gt;, or /WLI with a list of word lists.</td>
<td>An input predefined word list.</td>
</tr>
<tr>
<td>/WLI &lt;wordlists list file&gt;</td>
<td>Yes, either this option, &lt;doc file&gt;, or /WI with a list of words.</td>
<td>An input file that lists predefined word lists.</td>
</tr>
<tr>
<td>/WO &lt;word list file&gt;</td>
<td>No.</td>
<td>An output list of added/new words in the vocabulary to the file indicated.</td>
</tr>
<tr>
<td>/WLO &lt;word list file&gt;</td>
<td>No.</td>
<td>Output list of added words from both predefined word lists and documents along with word frequency.</td>
</tr>
<tr>
<td>/AW[C][&lt;n&gt;]</td>
<td>No.</td>
<td>Add unknown words to a vocabulary:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- C=add known words with unknown capitalization.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- n=the minimum number of times that a word must appear in a document. If a word appears the minimum number of times, add the word to the vocabulary.</td>
</tr>
<tr>
<td>/LM-</td>
<td>No.</td>
<td>Do not build language model - include the minus sign at the end of /LM.</td>
</tr>
<tr>
<td>/LM[M</td>
<td>U][N</td>
<td>I]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- M=Middle Slot* (default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- U=User Slot*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- N=Non-incremental (default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- I=Incremental</td>
</tr>
</tbody>
</table>
**Voctool command line examples**

The following are examples of how to use the Voctool from the command line:

**Example 1**

To use Voctool to add a set of new words to the General vocabulary of a user named Katarina Phelps, you would first copy the file of words (*NewWords.txt*) to the `Program Files\Nuance\NaturallySpeaking10\Program` directory, then type the following on the command line:

```bash
voctool.exe /S /U "Katarina Phelps" /V "General - Large" /WI NewWords.txt /AW /Summary voc_actions.txt
```

The `/AW` option is required to add the new "unknown" words to the vocabulary.

The *voc_actions.txt* file contains a summary of the actions that Voctool performs.

```plaintext
Processed 1 word list file(s):
   _______ NewWords.txt

7 unknown word(s) found.
7 word(s) added.

Language model was not built.
No errors occurred.
No warnings occurred.
```

---

**Switch** | **Required with /S** | **Purpose**
---|---|---
/LMSIZE <size> | No. | The size of the Middle Slot language model - one of (0.5, 1, 2, 3 [default], 4, or 5).*
/NS | No. | Do not save changes to the vocabulary. Applies only in Silent mode.
/Summary <file> | No. | Write summary of session actions to a file.
/? | No. | Displays this list of options.

*For more information on language model slots, see [Storing language model information](#).
To see some examples of running voctool.exe on the command line, see [Voctool command line examples](#).
Chapter 6: Customizing Vocabularies with the Dragon® Vocabulary Tool

Example 2

In this example, we perform all of the actions from Example 1 and also build the language model using the new words. On the command line, we include the /LM option to build the language model. To have Voctool store the language model in the Middle slot, you would add M after /LM; to store the language model in the User slot, you would add U after /LM.

You can instruct Voctool to have the language model include all previous changes (called non-incremental) by adding an N after /LM or have the language model include only the most recent changes (called incremental) by adding an I after /LM.

If you include /LM on the command line and do not specify a particular slot to build the language model in or do not specify the type of build to do, Voctool builds the language model non-incrementally and stores it in the Middle slot.

To build the language model in an incremental fashion and store it in the User slot, type the following on the command line:

```
voctool.exe /S /U "Katarina Phelps" /V "General - Large" /WI NewWords.txt /AW /LM U I /Summary voc_actions.txt
```

Example 3

To use Voctool to add a list of drug names to the vocabulary of a medical provider named Jackson Stone, you would first copy the file that contains the drug names (DrugNames.txt) to the `Program Files\Nuance\NaturallySpeaking10\Program` directory, then type the following on the command line:

```
voctool.exe /S /U "Jackson Stone" /V "Internal Medicine - Large" /WI DrugNames.txt /AW /Summary actions.txt
```

Be sure to use the full name of the vocabulary, including "- Large" in this case.

The `actions.txt` file contains a summary of the actions that Voctool performs:

```
Dragon Vocabulary Tool Version x.xx

User: Jackson Stone
Vocabulary: Internal Medicine - Large
Language: 0x409 - English (United States)

Processed 1 word list file(s):
    DrugNames.txt

7 unknown word(s) found.
7 word(s) added.

Language model was not built.
No errors occurred.
No warnings occurred.
```
Definition: The language model
In addition to a word list, a vocabulary has a language model that contains statistical information. The statistics help predict which words are most likely to occur in the context of a user’s speech. This information includes:

- **unigram probability**: The likelihood that a word occurs in text compared to other words in the same vocabulary. For example, if the verb *write* is more likely to occur in text compared with the name *Wright*, then *write* will have a higher unigram probability.

- **bigram and trigram probabilities**: The likelihood that a two-word or three-word sequence occurs in text. For example, if the bigram *Mr. Wright* is more likely than *Mr. write*, the language model should favor *Mr. Wright* even though *write* has a higher unigram probability than *Wright*. In this context the bigram/trigram probability outweighs the unigram probability.

Definition: About language model slots
A vocabulary includes three slots for storing language model information. Not all vocabularies contain information in each slot.

- **base slot** — Stores the base language model that ships with *Dragon*. You cannot modify the information in the base slot.

- **middle slot** — Can contain a custom language model based on a significant amount of data developed for a target group of users. The only way you can modify the custom slot is by using the *Dragon Vocabulary Tool*.

- **user slot** — Can contain a language model based on a relatively small amount of data for use by at most a few users. Individual users can modify the user slot using the *Vocabulary Builder* feature of *Dragon*. You can also modify the user slot using *Dragon Vocabulary Tool*.

Only *Dragon Medical* can use vocabularies with a middle slot language model that has been modified in the *Vocabulary Tool*.

Both SDK Client and SDK Server editions can use the *Dragon Vocabulary Tool* to modify middle slot language models.

Storing language model information
A vocabulary stores language model information in three slots. Not every vocabulary contains information in each slot.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>base</td>
<td>Stores the base language model that ships with <em>Dragon</em>. You cannot modify the information in the base slot.</td>
</tr>
<tr>
<td>middle</td>
<td>Can contain a custom language model based on a significant amount of data, developed for a target group of users. The only way you can modify the custom slot is by using the <em>Vocabulary Tool</em>.</td>
</tr>
</tbody>
</table>
Can contain a language model based on a relatively small amount of data for use by at most a few users. Individual users can modify the user slot using the *Vocabulary Builder* feature of *Dragon*. You can also modify the user slot using the *Vocabulary Tool*.

With the Professional editions of *Dragon NaturallySpeaking*, you can use vocabularies with a middle slot language model that you modify with the *Vocabulary Tool*.

In the SDK Client and SDK Server editions of *Dragon*, you can use the *Vocabulary Tool* to modify middle slot language models.
Chapter 7

Adding Words, Commands, and Vocabularies to User Files
Adding Words, Commands, or Vocabularies

You use the `nsadmin` utility or the Data Distribution Tool to make new words, customized vocabularies, or new commands available to all users on a particular installation of Dragon. Both the `nsadmin` utility and Data Distribution Tool can work across a network. Dragon Medical Small Practice Edition does not support the `nsadmin` utility or the Data Distribution Tool.

The `nsadmin` utility lets you use the command line to make new words, commands, and vocabularies available to users. The `nsadmin` utility can perform only one action at a time. However, you can create a batch file or script that can perform multiple `nsadmin` operations on a computer.

The Data Distribution Tool lets you use a GUI to interact with the `nsadmin` utility and make new words, commands, and vocabularies available to users.

Note: You can use the Voctool to customize a vocabulary by adding new words or optimizing the language model for a particular user profile. For more information, see the Voctool Help.

Using the Data Distribution Tool

On the Medical editions of Dragon, you can use the Data Distribution Tool to interactively make new words, customized vocabularies, or custom commands available to all users on a particular installation of Dragon.

You run the Data Distribution Tool on each installation of Dragon where you want the new words or vocabularies to be available to Dragon users.

This section describes:

- Creating the Data Distribution Directory
- Starting the Data Distribution Tool
- Adding and removing custom words
- Adding and removing vocabularies
- Adding and removing custom commands

You can also run `nsadmin` from the command line. For more information, see Nsadmin utility for new words, vocabularies, and commands.

Creating the Data Distribution Directory

You create a data distribution directory to store word lists, commands, or both, that you plan to distribute to multiple users of Dragon Medical.

When word lists and commands are in the data distribution directory, as soon as a person opens their user files, Dragon automatically imports words and commands from the data distribution directory.
directory into the user files. This occurs regardless of the location of the computer the user dictates on.

You can use the **Data Distribution Tool** to put words and commands into a data distribution directory. For more information, see [Starting the Data Distribution Tool](#).

**Note:** The default installation of Dragon places custom words for existing Dragon users in **C:\Documents and Settings\All Users\Application Data\Nuance\Dragon NaturallySpeaking10\custom**.

### Create a data distribution directory in a location other than the default location

Repeat the following steps for each workstation that should share the distributed words or commands.

1. In **Dragon**, close all open users.
2. On the network, create a directory and give all users that dictate with **Dragon** access to the directory. Grant read access to providers that dictate. Grant write access only to administrators.
3. If **Dragon** is running, on the **DragonBar**, select **Tools > Administrative Settings**. When the **Administrative Settings** dialog box opens, proceed to Step 6.
4. If **Dragon** is not running, select **Start > Run**. When the **Run** dialog box opens, in the **Open** text box, type the following, making sure to put a space between **natspeak.exe** and the **/SetDefaultAdministrativeOptions** option:

   ```
   "C:\Program Files\Nuance\NaturallySpeaking10\Program\natspeak.exe" /SetDefaultAdministrativeOptions
   ``

   (The quotation marks are required because **Program Files** contains a space. Your path might not require quotation marks.)

5. Click **OK**.
6. When the **Administrative Settings** dialog box opens, if the user opens automatically, click **Cancel** to close the user or go to the **DragonBar** and select **NaturallySpeaking > Close User**.
7. Click the **Miscellaneous** tab.
8. In the **Data distribution location** text box, click **Change...** and browse to a location where you want **Dragon** to store custom words and commands.
9. Click **OK**.
10. Click **Apply** to save the changes.
11. Click **OK** to close the dialog box.

You can now use the **Data Distribution Tool** or the **nsadmin** command line utility to put new words and commands into the data distribution directory. For more information, see [Starting](#).
Starting the Data Distribution Tool

You can use the **Data Distribution Tool** to make new words, customized vocabularies, or new commands available to all *Dragon* users on a particular installation of *Dragon*.

You can run the **Data Distribution Tool** on a local machine or through a network connection. The tool supports both mapped drives and UNC paths.

Before you use the **Data Distribution Tool**, you must create a data distribution directory. For more information, see [Creating Data Distribution Directory](#).

**Start the Data Distribution Tool**

A default installation of *Dragon* stores custom commands for *Dragon* users in: 

```
Documents and Settings\All Users\Application Data\Nuance\Dragon NaturallySpeaking\Custom\<language>.
```

1. Select **Start > All Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking Tools > Data Distribution Tool.** Dragon displays the first page of the **nsadmin wizard**.

   2. Select one of the following options:
      - **Add or remove base vocabularies**
      - **Add or remove shared commands**
      - **Add or remove word to share across vocabularies**

   3. Click **Next**.

   4. Click the **Advanced** button to set the location where the local installation of *Dragon* stores customized words and commands.

**Data Distribution Tool: Adding and removing custom words**

You can use the **Data Distribution Tool** to make new words available to all users on a particular installation of *Dragon*.

Before you use the **Data Distribution Tool**, you must create a data distribution directory. For more information, see [Creating Data Distribution Directory](#).

You must first either create a text file or export words from an existing user’s installation of *Dragon* before you can distribute the words (for example, a list of new drug names) to a different installation of *Dragon*.

After you use **nsadmin** to import the custom words, you must close your users, re-open the users, and save them for the changes to become available.

**Create a text file that contains custom words**

Perform one of the following two actions before you distribute a set of custom words to a
Chapter 7: Adding Words, Commands, and Vocabularies to User Files

particular installation of Dragon:

Create a text file that contains custom words

1. Create a text file.

2. In the text file, add each word or phrase that you want to add to the vocabulary. Make sure each word or phrase uses correct spelling and is on a separate line.
   
   ▪ To add a multiple-word phrase, such "Mayberry Tribune", type it on one line.

   ▪ To include a spoken form of a word, type the word followed by a backslash (\) and the spoken form of a word. For example, to have Dragon enter "Robert F. Kennedy" when you say "RFK", type Robert F. Kennedy\RFK in the text file.

Create a text file that contains custom words

1. If you have Dragon available on another machine, you can use it to create custom words and export the words to a .txt file. For more information, see the main Dragon Help file.

Add custom words to a shared location

You must create .txt file (newwords.txt in the following examples) that contains custom words before you perform the following steps. For more information, see Create a text file that contains custom words.

   ▪ If you have not already created it, create the data distribution directory. For more information, see Creating Data Distribution Directory.

2. On each computer that a user uses for dictation, map a network drive to the location of the data distribution directory. As an alternative, you may reference the network UNC address of the location of the nsadmin utility.

3. Start the Data Distribution Tool. For more information, see Starting the Data Distribution Tool.

4. In the Data Distribution Tool, make the appropriate selections to add the list of words to the data distribution directory. For more information, see Use the Data Distribution Tool to add custom words.

Use the Data Distribution Tool to add custom words

If you add custom words to a Commands Only vocabulary, when you upgrade a user, the upgrade process does not retain the custom words. In general, you should not add custom words to a Commands Only vocabulary.

1. On the Data Distribution Tool, select Add or remove words to share across vocabularies.

2. (optional) To choose a location for the custom words on the local machine, click Advanced. In the Custom directory text box of the Advanced Settings dialog box, type
the path to the new location for the custom words. If you do not take this step, Dragon copies the files to the following default location: \Documents and Settings\All Users\Application Data\Nuance\Dragon NaturallySpeaking10\Custom\enx

3. Click Next.

4. Associate a language with the custom words.

5. Click Next.

6. When the list of files appears, use the Import button to select the .txt files that contain custom words. To view the content of a file, select the file and click View. To remove a file from the list of files, select the file and click Remove. To remove all files from the list, click Remove All.

   Note: Once you add a text file that contains custom words to the data distribution directory, and a user opens the file, you cannot use the Remove and Remove All buttons to remove the custom words.

7. Click Next. The Data Distribution Tool displays a log of the operations it performs.

8. Click Finish to re-display the first page of the Data Distribution Tool or click Cancel to exit.

Data Distribution Tool: Adding and removing vocabularies

You can use the Data Distribution Tool to make a customized vocabulary available to all users on a particular installation of Dragon. For example, you can use the Data Distribution Tool to copy a user’s vocabulary and set it as the base vocabulary on any installation of Dragon. After you add a base vocabulary to an installation of Dragon, new users you create can use that vocabulary.

Notes:

- The default installation of Dragon places vocabularies for existing Dragon users here: \Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\users\<user_name>\current
- Vocabulary files end with the *.voc extension.

Prepare to use the Data Distribution Tool to add a vocabulary

1. If you have not already created it, create the data distribution directory. For more information, see Creating Data Distribution Directory.

2. On each computer that a user uses for dictation, map a network drive to the network location of the data distribution directory.

3. Start the Data Distribution Tool. For more information, see Starting the Data
Chapter 7: Adding Words, Commands, and Vocabularies to User Files

Distribution Tool.

4. In the **Data Distribution Tool**, add the vocabulary to the data distribution directory. For more information, see [Adding a vocabulary](#).

**Use the Data Distribution Tool to add a vocabulary**

1. In the **Data Distribution Tool**, select **Add or remove base vocabulary**.

2. Click **Next**.

3. Click **Add** to add a **Base Vocabulary**. *Dragon* displays the **Add Base Vocabulary** dialog.

4. In the **Add Base Vocabulary** dialog box:
   - Give the vocabulary a name. The name should describe the content of the vocabulary, such as *Astronomy* or *Marketing*.
   - Select the location of the vocabulary, either a mapped drive or a UNC address.
   - Give the vocabulary an unique numeric ID. Use a value greater than 9000 for the topic ID parameter.

5. Click **OK**.

The next time you open a user, *Dragon* automatically updates the user’s vocabulary.

**Use the Data Distribution Tool to add an exported vocabulary**

You can use the **Data Distribution Tool** to distribute a vocabulary that you create using a separate installation of *Dragon*. A *Dragon* vocabulary that you export saves as a group of files. One of the exported files has a .top file extension, the other files have .to* file extensions, where * is an integer.

1. In a command prompt, provide the path to the file with the .top file extension as an argument to the *nsadmin* utility. Do NOT include the .top file extension on the command line.

The following command adds the *myvoc* exported topic (*myvoc*.top) as a new base vocabulary:

```<PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large | Nuance" 9005```

**Use the Data Distribution Tool to remove a base vocabulary**

1. In the **Data Distribution Tool**, select **Add or remove base vocabulary**.

2. Click **Next**. *Dragon* displays the existing base vocabularies by ID and username.

3. Select the vocabulary to delete.

4. Click **Remove** and then click **Next**. The **Data Distribution Tool** displays a message when the vocabulary is deleted.

5. Click **Finish** to close the **Data Distribution Tool** or click your browser’s back button to re-display the screen.
Data Distribution Tool: Adding and removing custom commands

Custom commands are voice commands that you can create and modify to enter text, insert graphics, or activate menus and keystrokes in any application. You can use the MyCommands Editor to create custom commands or the Command Browser to modify custom commands.

You can use the Data Distribution Tool to copy a set of custom commands to the data distribution directory and make the set of custom commands available to all users at a particular installation of Dragon.

Before you use the Data Distribution Tool, you must have already created a data distribution directory, as explained in Creating Data Distribution Directory.

Notes:

- The default installation of Dragon places custom commands for existing Dragon users here:
  \Documents and Settings\All Users\Application
  Data\Nuance\NaturallySpeaking10\Custom\<language>
- After you import the custom commands to Dragon, for the changes to become available to those users, you must close your users, then re-open and save the users.
- You can enter a path as a complete local path, a relative path, a mapped network drive, a UNC path, or the path to removable media, such as a DVD, CD, or ZIP drive. For more information, see Using paths with nsadmin.

Prepare to use the Data Distribution Tool to export custom commands

1. In Dragon, create custom commands.
2. Use the Command Browser to export the custom commands to a .dat file, for example, NewCommands.dat.
3. If you have not already created it, create the data distribution directory. For more information, see Creating Data Distribution Directory.
4. On each computer that a user uses for dictation, use the Data Distribution Tool to add the .dat file to the data distribution directory. For more information, see Adding custom commands.

Use the Data Distribution Tool to add custom commands

1. Start the Data Distribution Tool. For more information, see Starting the Data Distribution Tool.
2. In the Data Distribution Tool, select Add or remove shared commands.
3. Click Next.
4. Select the languages for the user files that you will add custom words to.
5. Click Next.
6. Use the **Import** button to select the .dat files that contain the custom commands to add. Place the .dat files into the **New shared commands** list in the upper half of the dialog box. You can modify the list by selecting particular file names and using the **Remove** and **Remove All** buttons.

7. Click **Next**. The **Data Distribution Tool** displays a log of all the operations it performs.

8. Click **Finish** to re-display the **Data Distribution Tool** main screen or click **Cancel** to exit.

The next time you open a user, *Dragon* updates the commands in the associated user files.

**Use the Data Distribution Tool to remove shared commands**

1. In the **Data Distribution Tool**, select **Add or remove shared commands**.

2. Click **Next**.

3. Select the languages for the user files that you will remove words from.

4. Click **Next**.

5. In the **Existing shared commands** list, select the command.

6. Click **Remove**.

7. Click **Next**. The **Data Distribution Tool** displays a log of all operations it performs.

8. Click **Finish** to re-display the **Data Distribution Tool** main screen or click **Cancel** to exit.

**Nsadmin utility for new words, vocabularies, and commands**

*Dragon Medical* includes the **nsadmin** utility. The **nsadmin** utility is a command line utility that lets you make new words, customized vocabularies, and new commands available to all users on a particular installation of *Dragon*.

The **nsadmin** utility performs only one operation at a time. You can write a batch file or script to execute multiple **nsadmin** operations on each computer.

For step-by-step instructions on using the **nsadmin** utility, see the following topics:

- Creating the Data Distribution Directory
- Starting the nsadmin command line utility
- Adding custom words from a command line
- Adding and removing custom vocabularies from a command line
- Adding custom commands from a command line

You can use the **Data Distribution Tool** to run the **nsadmin** utility from a GUI. For more
Creating the Data Distribution Directory

You create a data distribution directory to store word lists, commands, or both, that you plan to distribute to multiple users of Dragon Medical.

When word lists and commands are in the data distribution directory, as soon as a person opens their user files, Dragon automatically imports words and commands from the data distribution directory into the user files. This occurs regardless of the location of the computer the user dictates on.

You can use the Data Distribution Tool to put words and commands into a data distribution directory. For more information, see Starting the Data Distribution Tool.

Note: The default installation of Dragon places custom words for existing Dragon users in C: \Documents and Settings\All Users\Application Data\Nuance\Dragon NaturallySpeaking10\custom.

Create a data distribution directory in a location other than the default location

Repeat the following steps for each workstation that should share the distributed words or commands.

1. In Dragon, close all open users.

2. On the network, create a directory and give all users that dictate with Dragon access to the directory. Grant read access to providers that dictate. Grant write access only to administrators.

3. If Dragon is running, on the DragonBar, select Tools > Administrative Settings. When the Administrative Settings dialog box opens, proceed to Step 6.

4. If Dragon is not running, select Start > Run. When the Run dialog box opens, in the Open text box, type the following, making sure to put a space between natspeak.exe and the /SetDefaultAdministrativeOptions option:

   “c:\Program Files\Nuance\NaturallySpeaking10\Program\natspeak.exe”
   /SetDefaultAdministrativeOptions

   (The quotation marks are required because Program Files contains a space. Your path might not require quotation marks.)

5. Click OK.

6. When the Administrative Settings dialog box opens, if the user opens automatically, click Cancel to close the user or go to the DragonBar and select NaturallySpeaking > Close User.

7. Click the Miscellaneous tab.

8. In the Data distribution location text box, click Change... and browse to a location where you want Dragon to store custom words and commands.
9. Click **OK**.

10. Click **Apply** to save the changes.

11. Click **OK** to close the dialog box.

You can now use the **Data Distribution Tool** or the **nsadmin** command line utility to put new words and commands into the data distribution directory. For more information, see **Starting the Data Distribution Tool** or **Starting the nsadmin command line utility**.

### Starting the nsadmin command line utility

You can use the **nsadmin** utility on a command line to make new words, vocabularies, or commands available to users.

The **nsadmin** utility performs only one operation at a time. However, you can write a batch file or script to execute multiple **nsadmin** operations on a computer. You can place the network location of new words or vocabularies in a script and run the script from a client machine to copy the new functionality to the machine.

You can find the **nsadmin.exe** file in the \Program directory under the parent **Dragon** installation directory. The default installation directory for **Dragon** is C:\Program Files\Nuance\NaturallySpeaking10\Program.

The **nsadmin** utility supports both mapped drives and UNC paths. For more information, see **Using paths with nsadmin**.

Before you can use the **nsadmin** utility, you must create a data distribution directory. For more information, see **Creating Data Distribution Directory**.

### Start the nsadmin utility

1. Select **Start** > **All Programs** > **Dragon NaturallySpeaking** > **Tools** > **NSAdmin**

   **nsadmin** starts in a DOS window and lists the **nsadmin** syntax.

### Display help information for the nsadmin utility

1. From a command prompt, type **nsadmin/?**

### Command line syntax for the nsadmin utility

The **nsadmin.exe** utility uses the following syntax.

```
nsadmin <operation> <parameters> [options]
```

<table>
<thead>
<tr>
<th>Commands and parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/commands &lt;src_filename&gt;</td>
<td>Adds a command file to the local installation of Dragon.</td>
</tr>
<tr>
<td>/words &lt;src_filename&gt;</td>
<td>Adds a list of new words to the local installation of Dragon.</td>
</tr>
<tr>
<td>/vocabulary &lt;src_directory&gt; &quot;&lt;language or dialect&gt;</td>
<td>&lt;model name&gt;</td>
</tr>
</tbody>
</table>
You can use `nsadmin` to make new words available to all users on a particular installation of Dragon.

You must first either create a text file or export words from an existing user’s installation of Dragon before you can distribute the words (for example, a list of new drug names) to a different installation of Dragon.

After you use `nsadmin` to import the custom words, you must close your users, re-open the users, and save them for the changes to become available.

### Create a text file that contains custom words

Perform one of the following two actions before you distribute a set of custom words to a particular installation of Dragon:

**Create a text file that contains custom words**

1. Create a text file.

2. In the text file, add each word of phrase that you want to add to the vocabulary. Make sure each word or phrase uses correct spelling and is a on a separate line.
   - To add a multiple-word phrase, such "Mayberry Tribune", type it on one line.
   - To include a spoken form of a word, type the word followed by a backslash (\) and the spoken form of a word. For example, to have Dragon enter "Robert F. Kennedy" when you say "RFK", type Robert F. Kennedy\RFK in the text file.

**Export words from a Dragon installation**

1. If you have Dragon available on another machine, you can use it to create custom words and export the words to a *.txt* file. For more information, see the main Dragon Help file.

### Add custom words to a shared location

When you use `nsadmin`, you can enter paths as complete local paths, relative paths, mapped network drives, a UNC path, or the path to removable media such as a CD-ROM or ZIP drive.

<table>
<thead>
<tr>
<th>Commands and parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/vocabulary delete &lt;topic ID&gt;</td>
<td>Deletes the base vocabulary specified by &lt;topic ID&gt;.</td>
</tr>
<tr>
<td>/language enx</td>
<td>fra</td>
</tr>
<tr>
<td>/overwrite yes</td>
<td>no</td>
</tr>
<tr>
<td>/?</td>
<td>Displays the command syntax.</td>
</tr>
</tbody>
</table>
Perform the following steps after you create a text file that contains custom words or after you export words from an installation of Dragon:

1. If you have not already created it, create the data distribution directory. For more information, see Creating the Data Distribution Directory.

2. On each computer that a user uses for dictation, map a network drive to the location of the data distribution directory. As an alternative, you may reference the network UNC address of the location of the nsadmin utility.

3. In a command prompt, type a command to add the custom words from the .txt file. The following command copies the NewWords.txt file to the C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\Custom\enx\NewWords.txt directory:

   ```
   <PATH>\nsadmin /words G:\NsAdmin\NewWords.txt
   ```

   The next time you open a user, Dragon automatically updates the user’s words to include the words from the .txt file.

**Use the command line to overwrite a custom word file**

1. Use the /overwrite option to overwrite an existing custom word file. If the custom word file already exists in the Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\Custom\enx directory, Dragon overwrites it without prompting you.

   The following command overwrites the NewWords.txt custom word file:

   ```
   <PATH>\nsadmin /words G:\NsAdmin\NewWords.txt /overwrite=yes
   ```

   **Note:** If you add custom words to a Commands Only vocabulary, Dragon does not retain those words if you upgrade the user at a later date. In general, you should not add custom words to a Commands Only vocabulary.

**nsadmin: Adding and removing custom vocabularies from a command line**

You can use nsadmin to make a customized vocabulary available to all users on a particular installation of Dragon. For example, you can use nsadmin to copy a user’s vocabulary and set it as the base vocabulary on any installation of Dragon. After you add a base vocabulary to an installation of Dragon, new users you create can use that vocabulary.

The nsadmin command uses the following syntax:

```
<PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model name> | <category>" <topic_ID>
```
The following `nsadmin` command copies the model name (Large), the category (Nuance), and the topic ID (9005) to the `models.ini` file and copies the contents of the `myvoc` directory to `\Documents and Settings\All Users\Application Data\Nuance\Dragon NaturallySpeaking9\Custom\enx\Custom9005\`.

```<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large | Nuance" 9005```

**Notes:**

- The default installation of Dragon installs vocabularies for existing Dragon users in the following directory:
  ```\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\users\<user_name>\current```
- Vocabulary files have a *.voc file extension.
- You can use Voctool to customize a vocabulary. For more information on Voctool, see Customizing Vocabularies with the Dragon Vocabulary Tool (Voctool).

**Prepare to use the command line to add a vocabulary**

1. If you have not already created it, create the data distribution directory. For more information, see Creating the Data Distribution Directory.

2. On each computer that a user uses for dictation, in a command prompt, start the `nsadmin` utility and use it to add the vocabulary to the data distribution directory. Make sure to reference the network UNC address of the computer in the command. Use the following syntax for the command:

   ```<PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model name> | <category>" <topic_ID>```

   The next time you open a user, Dragon automatically updates the user’s vocabularies. For more information on using the nsadmin utility, see Starting the nsadmin command line utility.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;language or dialect&gt;</code></td>
<td>Links a vocabulary to a language. For example, <strong>US English</strong> or <strong>UK English</strong> for an English install. The language or dialect must exist in the version of Dragon on the computer.</td>
</tr>
<tr>
<td><code>&lt;model_name&gt;</code></td>
<td>Specifies the size of the vocabulary you are importing.</td>
</tr>
<tr>
<td><code>&lt;category&gt;</code></td>
<td>Describes the content of the vocabulary, for example, <strong>Astronomy</strong> or <strong>Marketing</strong>.</td>
</tr>
<tr>
<td><code>&lt;topic_ID&gt;</code></td>
<td>Sets an ID for a topic.</td>
</tr>
</tbody>
</table>
Chapter 7: Adding Words, Commands, and Vocabularies to User Files

Use the command line to overwrite a vocabulary

1. Use the /overwrite option to overwrite an existing vocabulary file. If the vocabulary file already exists in \Documents and Settings\All Users\Application Data\Nuance\Dragon NaturallySpeaking9\Custom\enx\Custom9005, Dragon overwrites it without prompting you.

   The following command overwrites the myvoc topic:
   <PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large | Nuance" 9005 /overwrite=yes

Use the command line to add an exported vocabulary

You can use the nsadmin utility to distribute a vocabulary that you create using a separate installation of Dragon. A Dragon vocabulary that you export saves as a group of files.

One of the exported files has a .top file extension, the other files have .to* file extensions, where * is an integer.

1. In a command prompt, provide the path to the file with the .top file extension as an argument to the nsadmin utility. Do NOT include the .top file extension on the command line.

   The following command adds the myvoc exported topic (myvoc.top) as a new base vocabulary:
   <PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large | Nuance" 9005

Use the command line to remove a base vocabulary

1. On each client computer, in a command prompt, enter a command to delete the vocabulary and the corresponding entry in models.ini. You cannot use vocabularies that are based on a base vocabulary you delete. Use the following syntax:

   <PATH>\nsadmin /vocabulary delete <topic_ID>

   The following nsadmin command deletes a vocabulary with a topic id of 9005:
   <PATH>\nsadmin /vocabulary delete 9005

nsadmin: Adding custom commands from a command line

Custom commands are voice commands that you can create and modify to enter text, insert graphics, or activate menus and keystrokes in any application. You can use the MyCommands Editor to create custom commands or the Command Browser to modify custom commands.

You can use the nsadmin tool to copy a set of custom commands to the data distribution directory and make the set of custom commands available to all users of a particular installation of Dragon.

Before you use the nsadmin utility, you must have already created a data distribution directory, as explained in Creating the Data Distribution Directory.

Notes:

- The default installation of Dragon places custom commands for existing Dragon users here:
  \Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\Custom\<language>
• After you import the custom commands to Dragon, for the changes to become available to those users, you must close your users, then re-open and save the users.

• You can enter a path as a complete local path, a relative path, a mapped network drive, a UNC path, or the path to removable media, such as a DVD, CD, or ZIP drive. For more information, see Using paths with nsadmin.

Use the command line to add custom commands

1. In Dragon, create custom commands.

2. Use the Command Browser to export the custom commands to a .dat file, for example, NewCommands.dat.

3. If you have not already created it, create the data distribution directory. For more information, see Creating the Data Distribution Directory.

4. On each computer that a user uses for dictation, in a command prompt, type a command line using the following syntax, to add the custom commands from the .dat file. Reference the network address of the data distribution directory in the command:

   <PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat

   The next time you open a user, Dragon updates the commands in the user files for the user.

Use the command line to add custom commands to a language other than English

Use the /language option to associate commands with a non-english language.

The following command associates the NewCommands.dat file with the language of French.

   <PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat /language=fra

Use the command line to overwrite a custom command file

Use the /overwrite option to overwrite an existing command file.

The following command overwrites the NewCommands.dat file if it already exists in the G: \NsAdmin directory. Dragon overwrites the file without prompting you.

   <PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat /overwrite=yes

Using paths with nsadmin

When you use the nsadmin utility, you can use a path that is a complete local path, a relative path, a mapped network drive, a UNC path, or the path to removable media, such as a DVD, CD, or ZIP drive. If a path name includes spaces, you must enclose the path name in quotation marks.

When you are running nsadmin from a directory other than the one nsadmin resides in, you must provide the full path to the nsadmin.exe program on the command line.

The following command copies the NewCommands.dat file to the <drive>:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\Custom\enx\NewCommands.dat directory.

   <PATH>\nsadmin /commands \\HostComputer\NsAdmin\NewCommands.dat
Chapter 8

Maintaining Dragon®
Installations
Maintaining Installations

There are several actions you can take to maintain your Dragon installations:

- Run the *Acoustic and Language Model Optimizer* and schedule the *Optimizer* to run automatically (see *Using Acoustic and Language Model Optimizer and Scheduler Tools*).
- Export user files from one machine and import them to another as outlined in *Exporting and Importing User Files*.
- Work with the *Dragon.log* file to determine the cause of error messages (see *Handling Dragon Error Messages*).
- Work with a Usability log file—create a usability log (*DgnUsability.log*) by pressing the *Advanced* button on the *Data* tab of the *Options* dialog box. For more information, see *Working with the Usability Log*.
- Work with the Dragon knowledge base as outlined under *Accessing Dragon Knowledge Database*.
- Work with the hardware compatibility list (see *Hardware Compatibility List*).
- Manage who has administrative privileges (see *Managing Who Has Administrative Privileges*).

**Using Acoustic and Language Model Optimizer and Scheduler Tools**

You run *Acoustic and Language Model Optimizer Scheduler* to:

- Choose to optimize the acoustic files for the user
- Choose to optimize the language model for the user
- Schedule one or both types of optimization to occur on a particular day or time at particular intervals
- Enable or disable the scheduled optimizations
- Separate procedures exist for running the optimization on a Non-Roaming User (see *Running Acoustic and Language Model Optimizer on Non-Roaming Users*) or a Roaming User (see *Running Acoustic and Language Model Optimizer on Roaming Users*).
Running Acoustic and Language Model Optimizer on Non-Roaming Users

An open local user cannot run the optimizer tools on user files. Only an administrator can run the Acoustic and Language Model Optimizer or the associated Scheduler tools. You must have Windows Administrator privileges (at the operating system level) on the machine where you are running the Scheduler. If you want to optimize a Roaming User on the machine where you are running the Acoustic and Language Model Optimizer, disable roaming and browse to the Master Roaming User file location as if it were local.

As system administrator, you are responsible for running the Acoustic and Language Model Optimizer on the network location of the Master Roaming Users. You can install Dragon on the machine where the Master Roaming User files are located or on any machine that has network access to the Master Roaming User files, then run the Scheduler. Later, any optimizations that result from running these tools are copied to the Local Roaming User when Dragon synchronizes it with the Master Roaming User. You can run the Acoustic and Language Model Optimizer from the Windows Start menu (Select Start > All Programs > Dragon NaturallySpeaking 10 > Dragon NaturallySpeaking Tools > Acoustic and Language Model Optimizer Scheduler) without opening a user file, or you can run it from the DragonBar using the Tools menu when a user file is open as indicated here.

To run the acoustic and language model optimizers on non-roaming users:

2. In the Open User dialog box, select a user to run the optimization on and click Open.
3. On the DragonBar, select Tools > Accuracy Center. The Accuracy Center opens.
5. If the user has not dictated and corrected recognized text since the last time the optimizer was run, you receive this message: *There is no new data in the acoustic archive. Acoustic Optimizer does not need to be rerun.* Click OK and the Acoustic and Language Model Optimizer opens with the Perform Acoustic Optimization option grayed out.
6. Check the types of optimization you want to perform, Perform Acoustic Optimization (to optimize the acoustic files of the user), Perform Language Model Optimization (to optimize the language model of the user), or both.
7. Click Go to start the process. The process may take some time to complete. When the process completes, you receive a message notifying you that it has completed.
8. Click Done.
9. When asked if you would like to save your user files click Yes to return to the Accuracy Center. Click Exit in the Accuracy Center dialog box.
Running Acoustic and Language Model Optimizer on Roaming Users

To run the Acoustic and Language Model Optimizer on Roaming Users:

1. Be sure that a copy of Dragon is installed on the computer where you plan to run the Acoustic and Language Model Optimizer.


3. To access the master directory of the Roaming Users you want to optimize, in the Acoustic and Language Model Optimizer Scheduler dialog box, select File > Set User Directory. The Set a Directory Containing User Files dialog box opens.

4. On the Set a Directory Containing User Files dialog box, either enter the path to the directory or click the Browse button and browse to the location of the Master Roaming Users, then click OK. If the users you want to optimize are located in multiple directories, you can later repeat the steps outlined here and change this directory to locate the additional users.

5. In the tree of users, select the user you want to optimize. Notice that if you expand that user in the tree, you see one or more dictation sources under the Acoustic Optimization tasks in the tree. You also see the vocabulary of the user under the Language Model Optimization tasks.

   OR

   Select File > New Task. The Windows user name and password dialog box opens. To set a schedule for running the Acoustic and Language Model Optimizer, either double-click on the dictation source or the language model under that user.

6. Before you proceed, enter your Windows user name and password. If you are logged in to a domain, you must insert the domain name in front of your user name; for example, HospitalDB\RSessions for the HospitalDB domain.

7. Click OK. The Select Frequency dialog box opens.

8. Under Optimization, select Perform Acoustic Optimization, Perform Language Model Optimization, or both.

9. Under User Information, you can either select another user from the User Name drop-down list or, to select multiple users, click the Multiple Users button to open the Select Users dialog box.

   ▪ In the Select Users dialog box, use the Add> and <Remove buttons to put the users you want to run optimization on in the Selected users in this task list to the right. Or
you can click Add All>> or <<Remove All to add or remove all users from the list.

- You can also move a user up and down in the list by selecting a name and clicking the
  Move Up or Move Down button. When you are satisfied with the list, click OK to
  proceed.

10. If you selected multiple users in the previous step, skip this step. Otherwise, in the
    Dictation Source text box, select an audio input device from the drop-down list and in
    the Vocabulary text box, select a vocabulary from the drop-down list.

11. Under Select Frequency and Start Date & Time, select how often and at what time you
    want the optimization to run, as well as the first date it should run.

12. At the bottom of the dialog, click the Enabled (schedule task runs at specified time)
    check box to enable the optimization.

13. Click Apply to apply the changes.

14. Click OK to close the Select Frequency dialog box. The Acoustic and Language Model
    Optimizer Scheduler dialog box displays a list of the events scheduled in the right pane
    of its dialog box. You can create more than one optimization schedule for a single user.
    When you do, both optimization events appear in the schedule list.

15. Click Files > Exit to close the acoustic and language model optimizer scheduler

## Removing One or More Optimization Schedules

To remove one or more scheduled optimizations from the scheduler:

1. Select the schedule you want to remove. You can select multiple schedules by holding
   the CTRL key while clicking a schedule.

2. Press the Delete key on your keyboard or select Options > Delete Selected Tasks on the
   toolbar.

3. Click OK when you are asked to confirm the deletion.

OR

4. To remove all scheduled optimization events in the Acoustic and Language Model
   Optimizer Scheduler select Options > Delete Displayed Tasks.

5. Click OK when you are asked to confirm the deletion.

Alternatively, you can optimize multiple users on the same schedule by selecting all the users
you want to share one schedule in the Select Users dialog box.
Exporting and Importing User Files

You can export user files on one machine and import them for use on another.

When you export a user to a new location, any custom words added to a Local Roaming User do not accompany the user files unless you first run Add Words from Document wizard in the Accuracy Center.

Exporting User Files

To export users from Dragon:

1. On the DragonBar, select Dragon > Manage Users.
2. The Manage Users dialog box opens.
3. Select the user in the list that you want to export.
4. Click the Advanced button and select Export from the menu that appears.
5. When the Browse For Folder dialog box opens, navigate to the folder where you want to store the exported user (or create a new folder by clicking the Make New Folder button) and click OK.
6. When a dialog box opens displaying a message indicating the export was successful, click OK.
7. Repeat steps 3 through 6 for each set of user files you want to export.
8. Click Close to close the Manage Users dialog box.
9. In the operating system, navigate to the directory where you exported the users. In that directory you find a separate folder for each exported user, labeled with the user name.

Importing User Files

To import users into Dragon that you previously exported on a different machine:

2. Click the Advanced button and select Import from the menu.
3. When the Browse For Folder dialog box opens, navigate to the folder to retrieve a set of exported users files from.
4. Select the folder in that directory that has the name of the user to import and click OK.
5. If the user already exists a User already exists dialog box opens and asks you to choose how to proceed: Overwrite the existing user or Import the user with an alternate name. If you choose to import the user and assign it another name, enter the name in the text field.
box provided and click **OK**.

6. Repeat steps 2 through 5 for each user whose user files you want to import.

7. Click **Close** to close the **Manage Users** dialog box.

### Handling Dragon Error Messages

When *Dragon* displays an error message:

1. Read the message carefully. It may give you enough information to determine what to do.

2. If you dictated text into your document, click **Close** to close the error message box and then save your document.

3. Do not save your user files.

4. Copy the error message log file (**Dragon.log**) to a safe place. To locate this file, click **Start > Programs > Dragon NaturallySpeaking 10 > Show Dragon Log**. This file is normally located in the `C:\Documents and Settings\<username>\Application Data\Nuance\NaturallySpeaking10` folder. Technical Support may ask you to send this file for further study.

5. Exit *Dragon* and start it again. In some cases it may be necessary to restart your computer.

6. Insert your *Dragon* DVD into your DVD reader, run the installation program again, and choose the **Repair** option on the first screen of the *Dragon* setup program. After setup finishes, reinstall any *Dragon* patches that were previously installed.


**For more help**

If you are unable to resolve your problem or if it occurs again, contact [technical support](http://www.Nuance.com/NaturallySpeaking10/support/).

### Working with the Usability Log

You can set up *Dragon* to create a usability log that logs all menu commands, toolbar buttons, and voice commands that you use during a dictation session.

To set up a usability log:

1. With a user open, on the **DragonBar**, select **Tools > Options**.

2. Click the **Data** tab.

3. Click the **Advanced** button.

4. When the **Advanced** dialog box opens, check the **Create usability log** check box and
5. Click **Apply and then click OK** to close the **Data** tab of the **Options** dialog box.

Later, you can find the log under C:\Documents and Settings\ <username>\Application Data\Nuance\NaturallySpeaking 10.

## Accessing Dragon Knowledge Database

Solutions to known problems with *Dragon* are provided at the Nuance Knowledge Base, located at [http://knowledgebase.Nuance.com/](http://knowledgebase.Nuance.com/).

If you have problems using *Dragon* with Microsoft Word on Windows XP (for example if the program freezes or commands stop working in a Microsoft Office XP application), it may be that the Microsoft Word XP’s built-in speech recognition is interfering with *Dragon*.

To locate and use the *Dragon* Knowledge Database:


1. In the product drop-down list, select *Dragon NaturallySpeaking* and click **Continue**.

2. In the **Dragon NaturallySpeaking TechNotes-Basic search** section you can search using:
   - Product version — Select the version you are using.
   - Search Criteria — Type the words that would be expected to be found in the pages that contain the answer. Do not use words such as *how*, *why*, *the*, *in*, or *on*.
   - Using:
     - Any of the words — Show pages that contain any of the words
     - All of the words — Show pages that contain all of the words.
     - Exact phrase entered — Show pages that contain all of the words in the exact order typed.

3. Click **Search**, to begin the search.

## Hardware Compatibility List

You can find a list of headsets and microphones compatible with *Dragon* at the Nuance Communications web site.

To find the hardware compatibility list:


2. At the site, under **Select a Product** click on the product drop-down list and select *Dragon NaturallySpeaking*.

3. Click **Continue** to proceed.

4. Under **Select a Device Category** click on the device category drop-down list and select
the type of microphone or recorder. For instance, you can select *Wireless Microphones* to see the various types of bluetooth microphones that are compatible. A list of compatible hardware displays, along with a model, manufacturer, and accuracy scale *Dragon Score*.

5. Click on the device name to open an Evaluation Report on the device that provides more detail. Each device is either *Nuance Certified* (meets highest standard), *Nuance Authorized* (provides satisfactory performance), or *Reseller Endorsed* (not necessarily tested by Nuance, but reported by resellers/VARs to provide satisfactory performance).

**Managing Who Has Administrative Privileges**

**Before You Give Windows Administrator Privileges**

Before you decide to give a *Dragon* user Windows Administrator privileges on a laptop computer, note that you are giving that person access to the *Administrative Settings* dialog box on that machine.

**Determining Logged In User Has Admin Privileges**

If the logged in user has Windows Administrator privileges, the following line appears in the *Dragon.log* file after he or she logs in:

09:33:10 LOG (MainWin): Windows user has administrative access to NatSpeak
Chapter 9

Managing and Securing Custom Commands
Managing and Securing Custom Commands

You can make your custom commands more secure in two ways:

To make the tool available only in Dragon, convert any XML files of commands to DAT format. For details see Using the Convert XML to DAT tool.

To prevent any Dragon users from editing the commands, you can lock access to the file. For details see Using the MyCommands Protection Utility.

Using the Convert XML to DAT tool

You can open commands you have stored in XML format in any text editor, which is extremely convenient, but not terribly secure. To allow only Dragon users to access those command files, you might want to convert them from XML format to DAT format.

You can use the XML to DAT tool (mycmdsxml2dat.exe) to extract user-defined Dragon commands from an XML file. The tool writes out the commands to a .dat file. Dragon uses .dat files to store commands. To make these commands available to other Dragon users, use nsadmin or the Data Distribution Tool to make the new .dat files available to those other users.

⚠️ Note: If you are using the Dragon SDK Client Edition, you can programmatically import Dragon commands stored in XML or DAT files into a Dragon user file by using the DgnEngingControl::ImportMyCommands method.

Starting Convert XML to DAT (mycmdsxml2dat.exe)

To start Convert XML to DAT (mycmdsxml2dat.exe) select:

- In Dragon: Start > All Programs > Dragon NaturallySpeaking 10 > Dragon NaturallySpeaking Tools > Convert XML to DAT.

- In Dragon SDK Client Edition: Start > All Programs > Dragon SDK Client Edition 9 > Dragon SDK Client Tools > Convert XML to DAT.

The Convert XML to DAT tool starts in an MS-DOS window, listing the tool’s syntax. To display the syntax at any time, enter the following command line:

>mycmdsxml2dat

The mycmdsxml2dat.exe program is located in the \Program directory beneath the directory where Dragon SDK Client is installed. For example, in a default installation:

C:\Program Files\Nuance\NaturallySpeaking10\Program>

Convert XML to DAT (mycmdsxml2dat.exe) syntax

Convert XML to DAT (mycmdsxml2dat.exe) uses the following syntax:
mycmdsxml2dat.exe <dat-file-path> <xml-file-path> [options]

<table>
<thead>
<tr>
<th>Required parameters:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;dat-file-path&gt;</td>
<td>The full path to the local copy of the current user’s .DAT file</td>
</tr>
<tr>
<td>&lt;xml-file-path&gt;</td>
<td>The full path to the .XML file</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Optional parameters:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-v</td>
<td>Validates the specified .xml file over the Internet with a Nuance DTD (Document Type Definition) file. Disabled by default</td>
</tr>
</tbody>
</table>

Using the XML to DAT tool

To make a set of commands in an XML file available to other users:

1. Create the XML file containing the commands to be used in Dragon.

2. Execute the command line tool, mycmdsXML2DAT.exe, to convert the XML file to DAT format.

3. Use the nsadmin tool to import the .dat file into Dragon for all users.

After you use nsadmin or the Data Distribution Tool to copy the .dat file to the data distribution directory, the next time you open a user, Dragon incorporates the new commands into the user files for that user.

For more information, see:

- Adding custom commands (nsadmin)
- Adding and removing custom commands (Data Distribution Tool)

Using the MyCommands Protection Utility

In Dragon Medical, when you export a set of custom Graphic and Text, Step-by-Step, Macro, and/or Advanced Scripting commands into a .dat file, you can set the permissions on that file so that after a user imports them, that user can dictate the commands but cannot view their source code, edit their source code, or re-export the commands. As a result, the integrity of the commands remains intact.

To set the permissions on the .dat file of commands to protect the commands in this way:

1. Make a backup copy of the unprotected .dat file and store it in a secure location. You later use that file to edit the commands, because once you protect the .dat file that you are distributing, you cannot make the file available for editing again.

2. Select Start > Run and enter cmd into the Run dialog box.

3. Change directories to <drive letter>:\Documents and Settings\<user
4. Enter the following on the command line:

   `protectcmds.exe <dat-file-path> <vendor-name> [<vendor-contact-info>]`

5. Once you press return, after a user imports these commands, if that user attempts to edit any of them, the following message indicates that the commands cannot be edited:

   **The command was protected by** `<vendor-name>`.  
   **Please contact** `<vendor-contact-info>` **for more information.**

In the **Command Browser**, the same message appears as the **Preview Content** in **Script** mode.

Once you have protected the file, you can put it into the **Data Distribution** directory for distribution to multiple users. For more on distributing saved commands, refer to [Creating Data Distribution Directory](#), then refer to a topic about distributing commands to multiple users by either:

- Using the **Data Distribution Tool** ([Data Distribution Tool: Adding and removing custom commands](#))

OR

- Using the **nsadmin** command line tool ([nsadmin: Adding custom commands](#))
Chapter 10

Using Structured Commands
Using Structured Commands

*Dragon Medical* includes an extension to text and graphics commands that let you to set the values of variables in text blocks based on voice input.

You can create simple text and graphics commands with variables in the *My Commands Editor* without having to do extensive programming in Microsoft® VBA.

**Application states**

Structured commands let you control the action of a command based on the state of the application. For example, if you assign a state to each field in a form, the same command can perform different actions depending on which field is activated.

You can use *Advanced Scripting* methods to control the states within structured commands or to set the initial state from a non-structured command. You can also create structured commands that prompt the user to select values from a predefined list.

When the user speaks a command, the user is presented with a list of pre-defined values for the command. Once the user selects a value, the value is inserted into the correct location in the macro.

**Samples**

*Dragon* includes several sample text and graphics commands with variables and sample structured commands. You can import the samples into *Dragon* to use them as templates for your own commands. The sample commands are fully commented.

For more information, see:

- Structured Commands Samples
- Importing Sample Commands

**Methods**

For more information on the methods used by the sample commands, refer to the following topics in the Main Help file:

- Global Methods
  - SetState
  - GetState
- EngineControl Methods
  - MyCommandsActiveState
  - PromptValue

**Structured Command Samples**

*Dragon* includes several sample *Text and Graphics* commands with variables and sample
structured *Advanced Scripting* commands. You can import the samples into *Dragon* to use them as templates for your own commands. The sample commands are fully commented.

**Sample location**

The sample commands are installed in:

\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\Data\Enx\samplecommands

A shortcut to this directory is available on the Windows *Start* menu. To open this directory, click *Start > Programs > Dragon NaturallySpeaking 10 > MyCommands Samples*.

**Importing Sample Commands**

You can import the samples into *Dragon* to use them as templates for your own commands. For information, see *Importing Sample Commands*.

**Samples**

The following samples are included with *Dragon*:

**GroceryListSample_DragonPad**

*GroceryListSample_DragonPad.xml* contains *Advanced Scripting* commands that simulate an on-line grocery order form in *DragonPad*. It demonstrates how to set and change command states, activating and deactivating various state structured commands, and how to use the command prompt. The "*Prepare Grocery List*" voice command displays the first section of a grocery list in *DragonPad* and sets a command state. Each section of the grocery list is designed to have a separate state. The "*What's Available*" voice command prompts the user with a set of grocery list commands that are active in the given section.

**GroceryListSample_WordPad**

*GroceryListSample_WordPad.xml* contains *Advanced Scripting* commands similar to those of *GroceryListSample_DragonPad.xml*. It demonstrates how to set and change command states and to use the command prompt in WordPad and uses a different coding style. The "*Prepare Grocery List*" voice command starts the grocery list in WordPad, activate the initial grocery list state, and prompt the user with a set of grocery list commands that are active in the given state. To read more about this sample and its commands, refer to the code comments in the XML file.

**SampleBoilerPlate_ColonCancer**

*SampleBoilerPlate_ColonCancer.xml* contains *Advanced Scripting* commands that demonstrate how to use structured commands and the command prompt for boilerplate text. This sample is modeled after a colon cancer checklist and is designed to work in Microsoft Word 2003. The "*Colon Cancer Checklist*" voice command displays the boilerplate text and takes the user, field by field, through the checklist.

**SampleBoilerPlate_EndoBiopsy**

*SampleBoilerPlate_EndoBiopsy.xml* contains a single *Advanced Scripting* macro that demonstrates how to set up boilerplate text and use the command prompt to guide users in filling the boilerplate text without using states. This sample is modeled after an endoscopic
biopsy report and is designed to work in Microsoft Word 2003. The "*Prepare Endoscopic Biopsy Gross Template*" voice command displays the boilerplate text and takes the user, field by field, through the report.

**SampleTGV_Restaurant**

*SampleTGV_Restaurant.xml* contains *Text and Graphics* and *Advanced Scripting* commands that are used in *DragonPad* to simulate an ordering system for a Chinese and Japanese restaurant. This sample demonstrates how to set states for structured commands as well as how the same commands can be used to produce different results in different states. Either the "*Chinese Restaurant*" or "*Japanese Restaurant*" voice command starts the ordering system and activates the structured commands created for the given state. The "*Exit Ordering System*" voice command ends the ordering session.

**SetStateSample**

*SetStateSample.xml* contains simple *Text and Graphics* commands that demonstrate how to use variables and text formats and *Advanced Scripting* commands to set and unset a command state. This sample is designed to work in *DragonPad* with the initial command "*Sample Set State.*" When the command executes, a command state is set for *DragonPad* and a simple exchange of greetings is simulated between the user and the system. The user speaks the greeting, such as "*Good Morning,*" and the system responds in bold red text. When the user says "*Good-bye,*" the exchange is terminated and the command state is unset.

**SampleInjuryReport**

*SampleInjuryReport.xml* together with *SampleInjuryReport.dot* demonstrates how structured commands and Microsoft Word templates can be used together to create a voice-enabled form filling environment. The template is a mock injury report with several text and check box fields can be filled using the commands included in the XML file. You start a form filling session by speaking the "*Edit Report*" voice command in a new document based on the sample template. Both the template and the commands are designed to work in Microsoft Word 2003.

**Importing Structured Commands**

You can import existing structured commands, such as the *Structured Commands Samples*, into *Dragon* to use as templates for your own commands. Use the following procedure to import the sample structured commands that are supplied with *Dragon*:

**To import the sample structured commands:**

1. On the *DragonBar*, select *Tools > Command Browser* to open the *Command Browser* window.

2. Click the *Manage* button on the *Command Browser* toolbar.

3. In the *Manage* area, click the *Import* button, and in the *Import Commands* window choose *MyCommands XML files* from the *Files of type* list.

4. Use the *Import Commands* window to browse to the *Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking9\Data\Enx\samplecommands* directory.
5. Select one of the sample .XML files (for example, \textit{sampletgv\_restaurant.xml}) and click \textit{Open}.

6. Click \textit{OK} on the \textit{Import Commands} validation dialog box and then click \textit{Import} on the \textit{Import Commands} window to import the commands contained in the file.

\textbf{Note:} The syntax of XML command files is defined by a document type definition (DTD) file that resides on the Nuance web site. When you import an XML command file, the application gives you the option of validating the syntax of the XML file against the DTD. The validation step is useful if you receive a XML command file from another person and want to check it for syntax errors prior to importing it.

7. Click \textit{OK} on the success message and return to the \textit{Manage} area of the \textit{Command Browser}.

\textbf{To examine the sample code}

1. Open the \textit{Command Browser} and click the \textit{Manage} button.

2. Expand and select the appropriate item (for example, \texttt{<restaurant\_type> Menu'})

3. Click the \textit{To Script} button and then click the \textit{Edit} button.

The \textit{MyCommands Editor} dialog box opens with the command you selected entered into it. You can examine and modify the command with the \textit{MyCommands Editor}. 
Appendix A

Summary of Administrative Settings Dialog Boxes
Summaries of Administrative Settings Dialog Boxes

The tabs in the *Administrative Settings* dialog box are:

- Roaming
- Miscellaneous
- Scheduled Tasks

For more on each tab, see the corresponding topic below:

- Administrative Settings: Roaming tab
- Administrative Settings: Miscellaneous tab
- Administrative Settings: Scheduled Tasks tab

**Administrative Settings: Roaming tab**

You use the *Roaming* tab of the *Administrative Settings* dialog box to set up the Roaming User feature. You must set up the Roaming User feature on each computer where you want users to dictate with a Roaming User.

**Enable**

Select *Enable* to activate the Roaming User feature and the Roaming User options.

**Network Directories**

To set the location of the master Roaming User(s):

1. Click the *Add* button. You use the *Roaming User Network Location* dialog box to define the network location of the master roaming users. The location you pick must be accessible to all computers on the network that you want available for dictation with *Dragon*.

2. Set the *Display Name* and the *Address* under *Network Location*. The Roaming User feature supports the following types of locations:

   - Mapped Drive—the format is: `<drive letter>:\<folder name>`. For example, `y:\roaming`.
   - UNC Path—the format is: `\servername\sharename\path\filename`.
   - HTTP (http:)—the format is: `http://myserver.com/webDAV`. For HTTP locations, click the *HTTP Settings* button to set information specific to your HTTP connection. You can also test your connection to the HTTP server from *HTTP Settings* dialog box.
Appendix A: Summary of Administrative Settings Dialog Boxes

- HTTP with SSL (https:)—the format is: https://myserver.com/WebDAV. For HTTP with SSL locations, click the SSL Settings button to set information specific to your HTTP with SSL connection. You can also test your connection to the HTTP with SSL server from SSL Settings dialog box.

Local directory (for cache)

When a user opens a Master Roaming User, Dragon transfers a copy of that user to the local machine. That local copy is called the Local Roaming User.

You can change the setting of this location, always called <Roaming Local>.

The default location of <Roaming Local> is:
Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\RoamingUsers\<display name>\<username>

The <display name> is a name you assigned as a Master Roaming User Profiles location. You can have multiple network storage locations for your Master Roaming User Profiles.

The <username> is the name of an individual Master Roaming User. There is a separate directory for each user.

Click the Browse button to find or create a new location.

Check Boxes for Roaming User Options

The check boxes and other components below the Local directory are the Roaming User Options. For when and why to set these options, refer to Selecting Roaming User options.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed Dragon. Note that the default is to have the Roaming User feature turned off.

Note: If you connected to your Roaming User Master Directory over HTTP and you find that either not all your users are listed in the Open User dialog box or after creating a roaming user you cannot open it again, be sure to:

- Add all file extensions within your Master Roaming User directories and subdirectories to the Registered MIME types list of your IIS server. You could also add a wildcard (*) MIME-type. For more information on adding a wildcard (*) MIME-type, see http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true.

- Check that no files in your user directory are locked, password protected, or otherwise access-restricted by your server permissions.

Administrative Settings: Roaming User Network Location

You use the Roaming User Network Location dialog box to define the network location of the master roaming users.

The location you pick must be accessible to all computers where users will dictate using a Roaming User.
Display Name

Sets the directory name displayed in the following locations:

- The **Roaming** tab of the **Administrative Settings** dialog box
- The **Location of user files** drop-down list in the **Open User** dialog box.

**Note:** With the Roaming User enabled, the **Open User** dialog box displays only users in the Roaming User locations. To let the users open both local (non-roaming) and Roaming users, select the **Allow non-roaming users to be opened** option on the **Administrative Settings** dialog box. Clearing this option prevents users from dictating with a non-roaming (local) user by accident. For more information, see Enabling the Roaming User on each machine where a user will dictate.

- The **Location of user files** drop-down list in the **Manage Users** dialog box.

Network Location—Address

On each computer where you plan to have users dictating as a Roaming Users, you must tell that installation of *Dragon* where the Master Roaming User Profiles are located. The Roaming User feature supports the following types of locations:

**Mapped Drives and UNC Paths**

Mapped drives connect to a shared network folder that has a drive letter assigned to it. UNC paths connect to a shared network folder using the Universal Naming Convention (UNC) to locate a user. The UNC is a way to identify a shared file on a computer or network without having to know the storage device it is on. The UNC path format is: \servername\sharename\path\filename.

To use a mapped drive or UNC path:

1. Under **Network Location**, enter the address of the mapped drive or UNC path. You can click Browse to browse for the location of the mapped drive or UNC path. This displays the Browse for Folder dialog box. You can also create a new directory on the mapped drive or UNC path by clicking the Make New Folder button.

2. Click OK when you are done.

**Intranet/Internet connections**

The Intranet/Internet connection supports both HTTP and HTTP over an encrypted Secure Sockets Layer (SSL).

To use an Intranet/Internet connection:

1. Under **Network Location**, enter the URL address of your HTTP or HTTPS server where your roaming user master files are located.

2. Click **HTTP Settings...** to display the **HTTP Settings** dialog box, where you can set information specific to your HTTP connection like Authentication, Firewall, and...
Proxy Server information. You can also test your connection to the HTTP server from this dialog box. For more information, see HTTP Settings.

- **SSL Settings**...to display the SSL Settings dialog box, where you can set information specific to your HTTPS (SSL) connection. You can also test your connection to the HTTPS server from this dialog box. For more information, see HTTPS Settings.

⚠️ Note: You cannot create a non-Roaming user on an HTTP or HTTPS connection. You can create only Roaming Users on an HTTP or HTTPS connection and only when the Roaming User feature is enabled.

### Administrative Settings: Miscellaneous tab

The **Miscellaneous** tab of the Administrative settings dialog box contains the following options:

- **Backup Location for user files**
  
  Shows the location where Dragon will save backup user files. Click the **Change** button to open a dialog box where you can specify a new location. Click the **Use Default** button to make the individual user’s folder the location. You can change the **Backup location for user files** to any directory where Windows has both read and write permissions, including portable devices such as Zip drives and CD/DVD burners. If you change the location, backups for all users will be located in the same directory.

  ⚠️ Note: On Windows XP and 2000 you must have administrator privileges to change the **Backup location for user files** and **Data Distribution location**. These fields are grayed out for restricted users. Dragon will not let restricted users create backup files in directories reserved for the operating system (for example, the \Windows directory). When specifying a backup location, make sure that directory can be accessed by all users.

- **Data Distribution location**
  
  Shows the location where Dragon should look to distribute custom words, vocabularies, and commands to multiple users. Click the **Change** button to open a dialog box where you can specify the location for this directory. Click the **Use Default** button to set the location to this default path:

  \C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\custom

  You can change the **Data Distribution location** to any directory where Windows has both read and write permissions, including portable devices such as Zip drives and CD/DVD burners.

- **Do not allow restricted users to add or modify commands**

  Select this check box to prevent restricted Windows users from adding or modifying Dragon commands. Selecting this option allows only users logged on with administrator privileges to add or modify commands. (Windows 2000 and Windows XP Professional).

- **Disable Modification of Macro Recorder Commands**

  Select this box to prevent users from modifying macro recorder commands. Users can still run the commands.
Disable Modification of Step-by-Step Commands

Select this box to prevent users from modifying step-by-step commands. Users can still run the commands.

Disable Modification of Advanced Scripting Commands

Select this box to prevent users from modifying advanced scripting commands. Users can still run the commands.

Do not allow restricted users to modify vocabularies

Select this check box to prevent restricted Windows users from modifying Dragon vocabularies. Selecting this option allows only users logged on with administrator privileges to modify vocabularies. (Windows 2000 and Windows XP Professional)

Record wave data between utterances.

Select this option to capture all dictation, including background noise, "ums" and "ahs", extraneous noises, and anything else the speaker may do like cough or laugh.

Correction Only Mode (no dictation available)

Select this option to enable Correction Only Mode, which disables dictation but lets a transcriptionist play back another user’s dictation without opening that user.

Note: You must disable Correction Only mode before running the Acoustic and Language Model Optimizer.

Disable Windows Advanced Text Services

Select this option to disable Microsoft’s Alternative User Input Text Input Processor (CTFMon)--turning off Windows speech recognition and eliminating potential conflicts with Dragon.

Drago installs an add-in to Microsoft Word that can conflict with add-ins installed by other applications. After installing Dragon on a Windows XP system, errors may start appearing when using Microsoft Word if the Microsoft Alternate User Input application (CTFMON.EXE) is also installed and running. The Microsoft Alternate User Input application supports advanced text services in Microsoft Office XP. These advanced text services include Microsoft speech, handwriting, and East Asian keyboard input services. You can disable the Microsoft Alternate User Input application during installation or later in the Administrative Settings dialog box.

Note: This option does not appear on systems running Windows Vista.

Disable automatic acoustic model selection in the Acoustic Optimizer

Running the Acoustic Optimizer updates your user files with accumulated acoustic data from any corrections and additional training you may have done. Running Acoustic Optimization increases your overall accuracy. In the process of increasing your accuracy, Acoustic Optimization might select a different acoustic model for your user files. Select this option to disable the Acoustic Optimizer from selecting a different acoustic model when run.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed Dragon. Note that the default is to have the roaming user feature turned off.
Notes:

• In some versions of Windows, such as Windows XP Pro, you must be logged on as the administrator before you can make changes to the options on this dialog box.

• In some situations, a user who does not have administrator privileges may have access to options on this dialog that they would not normally have.

• Dragon allows you to use the Universal Naming Convention (UNC) to locate a user. The UNC is a way to identify a shared file on a computer or network without having to know the storage device it is on. The format is: ```\servername\sharename\path\filename```.

Administrative Settings: Scheduled Tasks tab

The **Scheduled Tasks** tab of the **Administrative settings** dialog box is where you schedule optimization and tuning of voice (acoustic) models and language models and determine if and when the share the tuning information with Nuance:

- **Enabled Scheduled Accuracy Tuning**—Check to turn on periodic scheduled acoustic model tuning for all users.

- Click **Configure** to set the schedule. You are immediately asked to log in with your Windows Administrator password to make a schedule change. After you log in, you can set one schedule for **Acoustic model tuning** and another for **Language Model tuning** by clicking the appropriate tab and choosing **Daily**, **Weekly**, or **Monthly** and the start date and time.

- **Enable Scheduled Data Collection**—Check to allow Nuance to collect up to 500 MB of text and data about optimizations performed for **Dragon** users. Nuance uses the data to improve recognition quality. Once the data is collected, you have the option of sending it to Nuance to help improve the accuracy of future versions of **Dragon**. No personal information is ever sent to Nuance and participation in data collection is completely voluntary.

- Click **Configure** to set the schedule for data collection. You are immediately asked to log in with your Windows Administrator password to make a schedule change. After you log in, you can choose **Daily**, **Weekly**, or **Monthly** and the start date and time.

- **Let the user choose when to run Accuracy Tuning and Data Collection**—Check to give users access to this tab, effectively allowing them to change the schedules for periodic tuning and data collection.

- **Restore Defaults**—Click to return the schedules on this tab to their default frequencies and times.